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1. General Information 

1.1 Intended Use 
3M™ Littmann® StethAssist™ Heart and Lung Sound Visualization Software is intended to be used with 
the 3M™ Littmann® Electronic Stethoscope Model 3200 for the recording and display of heart sounds and 
other physiological acoustic signals. The device is intended for use in a physician office setting. It is not 
intended as a means of diagnosis. This product does not report any clinical findings or analysis. 

1.2 Safety Information 

Consult Instructions for use 

Please read, understand, and follow all safety information contained in these instructions prior to using this 
software. Retain these instructions for future reference. 

A CAUTION or NOTE used in this user manual will be boxed and will have the following significance: 

CAUTION: Indicates a situation in which the software may present inaccurate or incomplete information to 
the user. 

NOTE: Information that is considered important to emphasize. 

1.3 System Requirements and Specifications 
Computer Requirements: 

• Windows 7 32-bit, Windows 7 64-bit, Windows 8 32-bit, Windows 8 64-bit, Windows 10 32-bit, 
Windows 10 64-bit. 

• Mac  OS  10.12  
• 1024 MB of RAM or greater 
• Intel Core 2 Duo compatible or later 
• 1024 x 768 graphic display resolution or better 
• USB 1.1 port or better to support the USB Bluetooth wireless adaptor 

1.4 Patient Privacy 
The  privacy and security of  certain  individually identifiable  health  information  may be  protected by state,  
federal, international, and/or foreign laws that regulate and restrict how such information can be used, 
disclosed, stored and transmitted. In some instances, you may even be prohibited from permitting any 
third party to access such information without first obtaining prior written authorization to do so. 

You are solely and fully responsible for determining, understanding, and complying with any and all laws 
that affect how you may store and transmit any electronic individually identifiable health information 
through  use  of  the  software.  If  you  determine  that  you  are  not  able  to  comply  with  a  law  or  restriction  that  
applies to your use and disclosure (including transmission) of individually identifiable health information 
through  the  software,  then  you should  not proceed  to  save such  information.  By  proceeding  to  save any  
information, you hereby assume all risks, responsibilities and liabilities associated with using, storing, and/ 
or transmitting  such  information, including  sound files, electronically  or otherwise.  

This program does not require you to enter individually identifiable health information in order to function. 
Records can be stored and recalled through the use of a timestamp or an arbitrarily assigned identifier. If 
you choose to enter a meaningful Patient Name or Patient Identifier, then you agree to assume any and all 
risks of and liabilities incurred with transmitting and storing such individually identifiable health information 
through the software, including risks to the privacy and security of such individually identifiable 
health information. 
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2. Getting Started 

2.1 Install and Register the 3M™ Littmann® StethAssist™ Software 
Follow these steps to install 3M™ Littmann® StethAssist™ Software on your computer: 

1. Go to www.Littmann.com/StethAssist 
2. Click on the Download StethAssist link 
3. Click Run on the message box that appears 
4. Follow the installation instructions 
5. Complete online registration 

NOTE: To complete registration offline, please contact 3M™ Littmann® Customer 
Support at 1-800-228-3957 or littmannsoftwaresupport@mmm.com. 

2.2 Insert the USB Bluetooth Wireless Adaptor (Dongle) 
To install the USB Bluetooth wireless adaptor, insert the device into a USB port on the computer. The 
USB  Bluetooth  wireless  adaptor  allows  communication  between  the  computer  on  which  the  software  
is installed and the 3M™ Littmann® Electronic Stethoscope Model 3200. The USB Bluetooth wireless 
adaptor receives and transmits data via the commonly accepted Bluetooth® short range wireless  
connectivity standard. 

To connect to a stethoscope, the USB  Bluetooth  wireless  adaptor  must  be inserted  into  the computer  
prior to  launching the  3M™  Littmann®  StethAssist™ Software. If  the  USB  Bluetooth  wireless  adaptor  is  
not detected  by  the software,  the following  message will be displayed.  If  this  message is  displayed,  insert  
the USB Bluetooth wireless adaptor, and then close and re-launch the StethAssist software. 
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2.3 Pair & Connect the Stethoscope with the Software 
The following screen will help you pair and/or connect a stethoscope to the software. 

2.3.1 Pair New Stethoscope 

To connect a Littmann® Model 3200 Stethoscope to the 3M™ Littmann® StethAssist™ Software 
for the first time, you must first  pair the stethoscope to the software. To pair a new stethoscope, 
select “Add New Stethoscope” from the dropdown menu and click Pair (or, select Add New 
Stethoscope from the Tools menu on the main screen). Follow the onscreen instructions. After 
the stethoscope is paired, the software will automatically connect to it. Every time you launch the 
stethoscope thereafter, simply connect to the stethoscope. 

2.3.2 Connect Stethoscope 

To connect to a previously paired stethoscope, select the stethoscope name from the dropdown 
menu and click Connect. On the stethoscope, press the (M) button twice to select “CONNECT”. 
The screen below will appear each time you attempt to connect a stethoscope to the software. 

To review recordings without connecting a stethoscope, click Cancel. 
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Indicates the 
stethoscope to 
which  the  software  is
attempting 
to connect. 

If your stethoscope is connected, the Stethoscope Connection button will display a green check 

mark .  If  not  connected,  the  Stethoscope  Connection  button  will  display  a  red  X  .  

NOTE:  Follow these tips to optimize wireless connections 

1. Auscultate the patient as close to the USB wireless adaptor as possible
2. Avoid having objects or people between the stethoscope and USB Bluetooth

wireless adaptor
3. Avoid having your hand cover the entire chestpiece of the stethoscope (location of

the stethoscope’s Bluetooth® antenna)

NOTE:  You  can  pair  multiple  stethoscopes  to  the  3M™  Littmann® StethAssist™ 
Software,  but only  one stethoscope can  be actively  connected  at  a  time.  

The stethoscope can only be actively connected to one computer. 
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3. Create a New Recording or Import Recording(s) from the Stethoscope

Recording Set‑Up Window

Select  the  patient  posture

Select the recording length (5-60 
seconds) 

Enter patient information 
(optional) 

Select a recording  site  from  the
dropdown or click on the blue 
torso to manually designate the 
site. To switch to a different 
image, click an alternate 
thumbnail view. 

3.1 Create a New Recording 
3.1.1. To start a new recording, click on the New Encounter button. In the Recording Set-up Window, 

enter  the  Patient ID  and  Patient Name (optional,  please see Section  1.4  for  patient privacy  
information). Patient IDs may contain any combination of letters and numbers up to 20 characters 
long. The Patient ID will only allow the following characters: a-z, 0-9, -, and _ 

3.1.2. Select the recording length, recording site and patient posture. Then click OK. 

3.1.3. Obtain good sound quality at the desired patient site, and then press the (M) button on the 
stethoscope to begin recording.

3.1.4. To restart the recording, press the (M) button on the stethoscope to stop the recording, and then 
press the (M) button again to restart the recording. 

3.1.5. After the recording is completed, you may make another recording with the same patient by 
clicking the “Add Recording” button. To make a recording on a different patient, select the “New 
Encounter” button. The 3M™ Littmann® StethAssist™ Software will automatically ask if you would 
like to save the current set of recordings. 

3.1.6. Click on the Summary view to enter patient comments (optional) 

NOTE: The volume level of the stethoscope does not affect the volume level of recordings. Also, 
the recording can be played back in all three filter settings (Bell, Diaphragm, 

Extended Range), regardless of what filter setting was used during the recording. 
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3.2  Import Recording(s) from  the Stethoscope  Memory
To transfer a saved recording(s) from the on-board memory of Littmann® Model 3200 Stethoscope to the 
software,  click  on  the Import button  or  select Import  From  Stethoscope from  the File menu.  Follow  the  
steps below: 

1. Select Recorded Track(s) to Import 2. Enter Patient
Information
(optional).

5. Enter Patient Posture
(optional).3. Click on the Play icon to listen to the

track Comment (if present). Note:
Track  Comment  is played through
stethoscope eartips. 4. Enter Patient Recording Site

(optional).

Listen to 
Recorded 
Track (optional) 

Lock or Unlock the 
Recorded Track in 
the stethoscope 
memory (optional) 

Delete Recorded 
Track from the 
stethoscope 
memory 
(optional) 

6. After entering the information for all
of the recorded tracks, click Import
Selected.
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4. Review Recordings

Detailed View

4.1 Signal Pan & Zoom 
To zoom in or out within a sound display, first select the recording by clicking on it, then use either the 
Horizontal Zoom or Vertical Zoom “+” or “-“ buttons. Zooming in provides more detail. Zooming out 
provides less detail. The Vertical Zoom will also increase or decrease the volume of the recording as it 
affects both  the visual  and  the audible amplitude of  the  recording.  

If zoomed in horizontally, you can scroll through the recording using the Pan buttons. To move the 
recording to the left, click the Pan Left button. To move the recording to the right, click the Pan Right 
button. It is also possible to pan left and right through the sound displays by using the 

Drag  button located on the toolbar. Click this hand-shaped button and you have the ability to pan left 
or right through any of the recordings by placing the mouse cursor on a sound display and then dragging 

the cursor  in  the direction  you  wish  to  scroll.  Deactivate  this  feature by  clicking  the  Drag  button again. 

4.2 Spectrogram Display Option 
The  spectrogram  is a time-frequency  distribution  presented  as a two-dimensional  color  plot  of  the  sound  
energy distributed over time and frequency. Black represents minimum energy while red is maximum 
energy. The x-axis represents the time index while the y-axis is a linear frequency range from 0 – 500 Hz. 

The spectrogram provides an additional perspective on the recorded sound. To view a sound display in 

spectrogram mode, click the Spectrogram  button appearing to the left of the sound display. To return 

to the standard, default sound display view, click the Phonocardiogram button  that  appears to the  left
of the sound display. 
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4.3 Playing a Recording 
Press the Play button to begin playback. A red cursor will scroll across the sound display in synchrony with 
the recording. Click the Stop button to end the playback. 

By default, the software will play the sound track through the Littmann® Model 3200 Stethoscope (if 
connected). To play the sound track through the computer speakers, external speakers, or headphones, 
click the Play to Headphones checkbox. 

CAUTION: The audio quality of the sounds played through the computer speakers 
or computer audio jack may not be a faithful reproduction of the actual sounds due 

to the acoustical performance of the computer’s sound card, sound card drivers, and/or 
the frequency response of the headphones/speakers, potentially resulting in not 
being able to hear clinically relevant sounds. It is strongly recommended that a 

3M™ Littmann® Stethoscope Model 3200 is used to listen to the recorded sounds. 

NOTE:  The amplitude or volume of the recorded sounds may be less than what was 
heard during the initial recording. Use the “+” button on the vertical axis of the 

waveform graph or on the stethoscope keypad to increase the volume. 

4.4 ½ Speed 
The ½ Speed option allows you to play back recordings at half speed with no significant change in the 
spectral properties of the signal. Click the ½ Speed checkbox, and then click the Play button to play back 
the recording at half speed. Once clicked, the ½ Speed checkbox stays activated until it is clicked again. 

CAUTION:  The ½ Speed option is available to assist in identifying physiological events, 
but should not be solely used to  make a physiological diagnosis. 

4.5 Playing Back a Specific Portion of a Recording 
To  play  back  a  specific  portion  of  a  recording,  simply  click  with  your  mouse  on  the  area  of  the  sound  
display where you want playback to begin and drag your mouse to the right to highlight the area of 
interest. Once an area of the sound display has been highlighted in this way, click the Play button to listen 
to  the specific  section.  Note  that you  must select  a  segment of  sound  of  at least one second  in  duration  in  
order for this feature to function. Clear the highlighted area by left-clicking anywhere on the sound display. 

4.6 Looped Playback 
The Loop checkbox appearing at the top of the screen allows you to play back an entire recording, or a 
specific  portion  of  a  recording,  in  a  loop  that  will  continue  until  the  Stop  button  is  clicked.  To  play  a  full  
recording in loop mode, select the corresponding sound display by clicking on it, click the Loop checkbox, 
and then click the Play button. To play a specific portion of a recording in loop mode, use the cursor to 
highlight  the  area  of  interest  on  a  sound  display,  click  the  Loop  checkbox,  and  then  click  the  Play  button.  
Once clicked,  the Loop  checkbox stays  activated  until  it  is  clicked  again.  

4.7 Global Scaling 
The global scaling feature normalizes all of the recordings contained within a single recording set. This 
allows the user to accurately compare the amplitudes of multiple recordings. 

4.8 Printing Feature 
To print a copy of the “Patient Encounter Report” for a given recording or recording set, click the Print 
button. The resulting print-out will display the patient ID, patient name (if entered), and the ID of the 
stethoscope used for the recordings. The report will also contain a listing of the posture, auscultation 
site and time-length for the recording(s) in question, along with any corresponding user comments that 
were entered. 
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4.9 Adding Comments to a Recording 
While in the “Detailed View”, you can add comments to the sound file by by switching to the Summary 
view or by clicking on the “Comments” button located to the left of the Patient ID. A green check mark on 
the Comments button indicates that comments exist for the recording(s). 

5. Save, Open, and Export Recordings 

5.1 Save Recording 
Click  the “Save”  button  in  the upper  left-hand  corner  of  the screen  or  select Save from  the  File menu.  The  
StethAssist software will automatically prompt you to save the recording if starting a new recording or 
exiting the software program. 

5.2  Open  a Previously Recorded  Sound  File  
Click  the “Open”  button  in  the upper  left-hand  corner  of  the screen  or  select Open  from  the  File menu.  
Click on the heading to sort by that field. 

5.3 Export Recordings to .wav file 
To export a recording in a .wav file format, select Export recording as .wav from the File menu. The .wav 
file format is very common and can be played using most computer media players. Be sure to select the 
filter that is applied to the recording i.e. Bell, Diaphragm or Extended. 

6. Navigating Menus 

3M™ Littmann® StethAssist™ Software contains the following menu selections: 
File Tools View Help 

6.1 File 
File > Save 
Save the  current recording  set.  

File > Open 
Open a previous recording set. 

File > Close 
Close the current recording set. 

File  >  New  Encounter  
Begin a new patient recording. 

File > Comments 
Open the comments window. 

File  >  Import  From  Stethoscope  
Import a recording from the stethoscope’s on-board memory. 

File > Import Saved Recording(s) to Current Directory 
Transfer previously saved recording files from another location on the computer to the current recording 
directory. Moving files out of the current directory will improve program startup speed as well as reduce 
the  amount of  time it takes  to  open  a  previously  saved  file.  

File  >  Export  Saved  Recording(s)  
Transfer previously saved recording files from the current recording directory to another location on the 
computer. Moving files out of the current directory will improve program startup speed as well as reduce 
the  amount of  time it takes  to  open  a  previously  saved  file.  
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File > Import e4k File 
Import  a  file in  the .e4k  format.  The .e4k file format was  used  in  the previous  3M™  Littmann® Electronic 
Stethoscope Models 4000 and 4100. 

File > Export recording as .wav 
Open  the  File Export window  to  save the recording  in  the .wav  file  format.  

File  >  Print  Report  
Print the Patient Encounter Report for a given recording set. 

File  >  Recently  Viewed  
Open a recently viewed recording set. 

File > Exit 
Exit  the StethAssist application.  

6.2 Tools 
Tools > Add New Stethoscope 
Open the “Add New Stethoscope” window. 

Tools > Stethoscope  Settings  
Open the Stethoscope Settings window, where you can: 

• Delete  a  paired  stethoscope.  
• Change the stethoscope name. 
•  Adjust the  length  of  the “lead time”,  or  waiting  period,  before  the  StethAssist™  Software  begins  the  

recording after pressing the (M) button on the stethoscope. Lead time options: 0, 1, 2 or 4 seconds. 
•  Select the  default  patient posture.  
• Select the default recording length. 
• Select the default view (summary or detailed). 

Tools > Options 
Change the  default directory  where the recordings  are saved  and/or  change the default  language.  

6.3 View 
Select Detailed or Summary View 

6.4 Help 
Help > Online Help 
Open an internet browser and connect to the StethAssist webpage at www.littmann.com/StethAssist 

Help > User Manual 
Open the software user manual. 

Help > Learn About Littmann® Products 
Open an internet browser and connect to Littmann.com 

Help > About 
View the product version number along with phone numbers and addresses for requesting further 
information or making service inquiries. 

Help > Check for Latest Version 
Check for newer versions of StethAssist. 
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7. Improving Recording Quality 

The quality of the recordings depends on the environment, the patient, and user technique: 

The acoustic environment: 
Conduct  the auscultation  procedure in  an  environment that is  as  quiet as  possible.  Listen  carefully  for  
background sounds, such as that caused by traffic noises entering through open windows or by fans and 
air  conditioners,  and  eliminate these noises  to  the greatest extent possible.  Make sure that  there are no  
background conversations and prevent interruptions during recording. 

The patient: 
If  possible,  the patient  should  be properly  prepared  so  that the stethoscope can  make  direct contact with  
the patient’s skin. The patient should be instructed to remain as still as possible throughout the recording. 

The placement and handling of the stethoscope: 
When using the Littmann® Model 3200 stethoscope, there are several techniques that are important to 
consider that can substantially improve your auscultation experience. 

The sound sensor, where all sound acquisition occurs, is quite small and located in the very center of the 
chestpiece (for demonstration purposes, you can peel off the diaphragm and look for the indentation under 
the white sticker). The area around the sound sensor does not contribute to sound acquisition. Therefore, it 
is important to focus the point of contact with the patient on the very center of the chestpiece. 

Only  light contact is  necessary  with  the Littmann® Model 3200 stethoscope. This includes both the 
handling  of  the stethoscope and  the contact on  the patient.  Excessive pressure on  the patient may  result in  
artifact sounds. 

Contact with the patient must remain steady and consistent for optimal sound quality. Movement with the 
chestpiece will induce frictional noise. 

It is a best practice to start your auscultation exam at a lower amplification level. If you are trying to listen 
to a difficult-to-hear sound, adjust the amplification upward. Using the amplification on an as-needed basis 
will help reduce distracting noises during your exam. 

Finally, it is important to recognize the difference in technique between non-electronic and electronic 
stethoscopes. Holding the Littmann® Model 3200 stethoscope lightly, making light contact with the 
patient, focusing the point of contact on the center of the chestpiece, and remaining steady will ensure the 
highest sound quality auscultation experience. 
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8. Troubleshooting 

Problem 

Cannot connect 
to stethoscope 

Potential Cause 

No USB Bluetooth wireless adaptor 
installed/ USB Bluetooth wireless 
adaptor not properly installed 

Solution 

Insert USB Bluetooth wireless adaptor. 
Disable the internal computer Bluetooth radio. 
Update the Bluetooth driver to the Generic 
Bluetooth Adaptor 

Stethoscope not paired Pair stethoscope. Select Add New Stethoscope 
from  the Tools  menu  on  the main screen  

Each  unique  Stethoscope ID can  
only represent one stethoscope 

If your office has multiple stethoscopes, make 
sure you are trying to connect to the correct 
Stethoscope ID. 

Undetermined Turn off the stethoscope, wait a few seconds, 
and then turn the stethoscope back on and 
try again. 

Noisy recorded 
signal 

Excessive background noise Take actions to reduce the background noises 
heard in the auscultation environment. 

Signal shown in 
the display plot 
is clipped 

Noisy recording See the Section 7 of this user manual titled, 
“Improving Recording Quality”. 

Poor data 
quality reported 

Excessive background noise Take actions to reduce the background noises 
heard in the auscultation environment. 

Excessive  stethoscope  motion  Hold  the  stethoscope  with  a  steady  hand,  
lightly pressing against the patient’s skin 
while recording. 

For questions or concerns regarding to the 3M™ Littmann® StethAssist™ Software or the Littmann® Model 
3200 Stethoscope, please contact our customer service hotline at 1-800-228-3957 or find your local 
country 3M™ Littmann® Stethoscope website at www.Littmann.com for Frequently Asked Questions and 
the Contact Us  page.  

3M Health Care 
Littmann® Brand Products 
3M Center, Building 275-4E-01 
2510 Conway Ave. 
St. Paul, MN 55144 
1-800-228-3957 
www.littmann.com 

3M, Littmann, and StethAssist are registered trademarks of 3M, used under license in Canada. 
Windows is a registered trademark of Microsoft. Bluetooth is a registered trademark of the Bluetooth SIG, Inc. 
Mac is a registered trademark of Apple Inc. 

© 2017 3M. All rights reserved. 
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1. Informations générales 

1.1 Utilisation prévue 
Le  logiciel  de  visualisation  des bruits du  cœur  et  des poumons StethAssist™ de  3M™  Littmann® a 
vocation  à  être utilisé avec  le stéthoscope électronique 3200  de 3M™ Littmann®  pour l’enregistrement et 
l’affichage des sons cardiaques et autres signaux acoustiques physiologiques. Cet appareil est conçu pour 
être utilisé dans un cabinet médical. Il n’est pas destiné à être utilisé comme un moyen de diagnostic. Ce 
produit ne signale aucun résultat ni aucune analyse clinique. 

1.2 Consignes de sécurité 

Consultez le mode d’emploi. 

Veuillez lire, comprendre et suivre toutes les consignes de sécurité contenues dans ces instructions avant 
d’utiliser ce logiciel. Conservez ces instructions pour toute référence ultérieure. 

Les encadrés ATTENTION  et  REMARQUE  utilisés dans ce  manuel  ont  les  significations suivantes  :  

ATTENTION : indique une situation dans laquelle le logiciel risque de présenter des informations 
imprécises ou incomplètes à l’utilisateur. 

REMARQUE : informations suffisamment importantes pour être signalées. 

1.3 Configuration et caractéristiques du système 
Configuration de l’ordinateur : 

•  Windows  7  32  bits, Windows  7  64  bits, Windows  8 32  bits, Windows  8 64  bits, Windows  10  32  bits,  
Windows 10 64 bits. 

• Mac  OS  10.12
• 1024 Mo de RAM ou supérieure 
• Intel Core 2 Duo compatible ou ultérieur 
• Résolution d’affichage de 1 024 x 768 ou supérieure 
• Port USB 1.1 ou supérieur pour prendre en charge l’adaptateur Bluetooth USB sans fil 

1.4 Vie privée du patient 
La confidentialité et la sécurité de certaines informations de santé permettant d’identifier des personnes
peuvent  être protégées  par  le droit d’État,  fédéral,  international  et/ou  étranger  qui  réglemente et limite la  
manière dont ces informations peuvent être utilisées, divulguées, stockées et transmises. Dans certains 
cas, il peut même vous être interdit de permettre à toute tierce partie d’accéder à ces informations sans 
autorisation écrite préalable. 

Vous  assumez seul  l’entière responsabilité de déterminer,  comprendre  et  respecter  toute  loi  ayant une  
incidence  sur  la  manière  dont vous  stockez et transmettez toute information  électronique de  santé d’une  
personne que le logiciel pourrait permettre d’identifier. S’il apparaît que vous n’êtes pas en mesure de vous 
conformer à une loi ou restriction qui s’applique à votre utilisation et divulgation (y compris la transmission) 
d’informations de santé individuellement identifiables à l’aide du logiciel, vous ne devriez alors pas 
sauvegarder ces informations. En sauvegardant toute information, vous assumez alors tout risque et toute 
responsabilité associés à l’utilisation, au stockage et/ou à la transmission de ces informations, y compris les 
fichiers sonores, qu’ils soient électroniques ou autres. 

Ce programme ne nécessite  pas  la  saisie d’informations  de santé individuellement identifiables  pour  
fonctionner. Les archives peuvent être stockées et consultées grâce à leur horodatage ou tout autre 
identifiant attribué arbitrairement. Si vous choisissez de saisir un Nom de patient ou un Identifiant de 
patient  ayant une signification  réelle,  vous  acceptez d’assumer  tout risque et toute  responsabilité liés  
à  la  transmission  et au  stockage des  informations  de santé  individuellement identifiables  à  l’aide de  
ce logiciel, y compris les risques liés à la confidentialité et à la sécurité de ces informations de santé 
individuellement identifiables. 
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2. Mise en route 

2.1 Installation et enregistrement du Logiciel StethAssist™ de 3M™ Littmann® 

Suivez les  étapes  suivantes  pour  installer  le logiciel  StethAssist™  de 3M™  Littmann® sur votre ordinateur : 

1. Rendez-vous sur le site www.Littmann.com/StethAssist 
2.  Cliquez sur  le lien  «  Télécharger  StethAssist  »  
3.  Cliquez  sur «  Exécuter »  dans  la  boîte de dialogue  qui  apparaît  
4. Suivez les instructions d’installation 
5. Enregistrez-vous en ligne 

REMARQUE  :  si vous souhaitez vous enregistrer  hors connexion,  veuillez  
contacter  le service clientèle 3M™  Littmann® au +1-800-228-3957 ou à l’adresse 

littmannsoftwaresupport@mmm.com. 

2.2 Insertion de l’adaptateur Bluetooth USB sans fil (dongle) 
Pour installer l’adaptateur Bluetooth USB sans fil, insérez le dispositif dans un port USB de l’ordinateur. 
L’adaptateur Bluetooth USB sans fil permet la communication entre l’ordinateur sur lequel le logiciel 
est installé et le stéthoscope électronique 3200 de 3M™  Littmann®.  L’adaptateur  Bluetooth  USB  sans  
fil reçoit et transmet les données en utilisant la norme standard de communication sans fil à courte 
distance Bluetooth®. 

Pour connecter un  stéthoscope,  l’adaptateur Bluetooth USB sans fil doit être inséré dans l’ordinateur 
avant le lancement du logiciel StethAssist™ de 3M™ Littmann®. Si l’adaptateur Bluetooth USB sans fil 
n’est pas  détecté  par  le logiciel,  le message suivant  s’affichera.  Si  ce message apparaît  à  l’écran,  insérez  
l’adaptateur Bluetooth USB sans fil, puis fermez et relancez le logiciel StethAssist. 
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2.3 Couplage et connexion du stéthoscope au logiciel 
L’écran suivant vous aidera à coupler et/ou à connecter un stéthoscope au logiciel. 

2.3.1 Couplage d’un nouveau stéthoscope 

Pour connecter un  stéthoscope  3200  Littmann®  au  logiciel , vous  devez tout  d’abord  coupler  le  
stéthoscope StethAssist™ de 3M™ Littmann® au  logiciel.  Pour  coupler  un  nouveau  stéthoscope,  
sélectionnez « Ajout d’un nouveau stéthoscope » dans le menu déroulant et cliquez sur « Coupler » 
(ou sélectionnez « Ajout d’un nouveau stéthoscope » à partir du menu Outils sur l’écran principal). 
Suivez les instructions qui s’affichent à l’écran. Une fois que le couplage du stéthoscope a été 
effectué, le logiciel se connecte automatiquement à ce dernier. Chaque fois que vous lancerez le 
logiciel après cette procédure, il vous suffira simplement de vous connecter au stéthoscope. 

2.3.2 Connexion du stéthoscope 

Pour  se connecter  à  un  stéthoscope déjà  couplé,  sélectionnez le nom  du  stéthoscope dans  le  menu  
déroulant  et cliquez sur «  Connecter  ».  Sur  le stéthoscope,  appuyez  deux  fois  sur  le bouton  (M)  
pour sélectionner « CONNECTER ». L’écran ci-dessous s’affichera chaque fois que vous essayerez 
de connecter un stéthoscope au logiciel. 

Pour étudier des  enregistrements  sans  connecter un  stéthoscope,  cliquez  sur  «  Annuler  ».  
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Indique le 
stéthoscope 
auquel le logiciel 
tente de se 
connecter. 

Si votre stéthoscope est connecté, le bouton « Connexion du stéthoscope » affichera une 

coche verte . S ’il  n’est  pas  connecté, l e b outon «  Connexion  du s téthoscope »  affichera  une  croix r ouge

.

REMARQUE  : suivez ces consignes pour optimiser la connexion sans fil 

1. Auscultez le patient aussi  près  que possible de  l’adaptateur  USB  sans  fil
2. Évitez la  présence d’objets  ou  de personnes  entre le stéthoscope et  l’adaptateur

Bluetooth USB sans fil
3. Évitez de couvrir  la  totalité  du  pavillon  du  stéthoscope (emplacement  de l’antenne

Bluetooth® du stéthoscope) avec votre main.

REMARQUE : vous pouvez coupler plusieurs stéthoscopes au logiciel StethAssist™ de 3M™ 
Littmann®,  sachant  qu’un  seul  stéthoscope peut être activement connecté  à  tout moment.  Le

stéthoscope ne peut être  activement connecté qu’à  un  seul  ordinateur.  
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3. Création d’un nouvel enregistrement ou importation d’enregistrement(s)
depuis le stéthoscope

Fenêtre des paramétrages d’enregistrement

Sélectionnez la 
posture du patient 

Sélectionnez la durée 
de l’enregistrement 
(5-60 secondes) 

Saisissez les 
informations patient 
(facultatif) 

Sélectionnez un site 
d’enregistrement à partir du 
menu déroulant ou cliquez sur 
le torse bleu afin d’indiquer 
manuellement le site. Pour passer 
à  une  autre  image,  cliquez  sur  
une autre vignette. 

3.1 Création d’un nouvel enregistrement 
3.1.1. Pour lancer un nouvel enregistrement, cliquez sur le bouton « Nouvelle rencontre ». Dans la fenêtre 

« Paramétrages d’enregistrement », saisissez l’identifiant patient et le nom du patient (facultatif 
; veuillez vous reporter à la section 1.4 concernant les informations relatives à la vie privée du 
patient). L’identifiant du patient peut correspondre à toute combinaison de lettres et de chiffres et 
contenir jusqu’à 20 caractères. L’identifiant patient ne peut comporter que les caractères suivants : 
a-z, 0-9, - et _ 

3.1.2. Sélectionnez la durée d’enregistrement, le site d’enregistrement et la posture du patient. Cliquez 
ensuite sur « OK ». 

3.1.3.  Lorsque vous  obtenez une  bonne qualité sonore  sur  le site patient choisi,  appuyez  sur  le bouton  (M)
du stéthoscope pour commencer l’enregistrement. 

3.1.4. Pour reprendre l’enregistrement, appuyez une fois sur le bouton (M) du stéthoscope pour arrêter 
l’enregistrement, puis une deuxième fois pour reprendre l’enregistrement. 
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3.1.5.  À  la  fin  de la  procédure,  vous  pouvez effectuer  un  nouvel  enregistrement avec  le même patient
en cliquant sur le bouton « Ajouter enregistrement ». Pour effectuer un enregistrement avec 
un  patient  différent,  sélectionnez le bouton  «  Nouvelle  rencontre ».  Le logiciel  StethAssist™  
de 3M™ Littmann® vous demande automatiquement si vous souhaitez sauvegarder les 
enregistrements que vous venez d’effectuer. 

3.1.6.  Cliquez  sur la vue  «  Résumé  »  pour saisir des  commentaires  relatifs  au  patient  (facultatif).

REMARQUE : le volume sonore du stéthoscope n’affecte pas celui des 
enregistrements. L’enregistrement peut également être écouté avec les trois 

paramètres de filtre (Cloche, Diaphragme, Gamme étendue), indépendamment 
du paramètre de filtre utilisé lors de l’enregistrement. 

3.2 Importation des enregistrements à partir de la mémoire du stéthoscope 
Pour transférer un enregistrement sauvegardé de la mémoire intégrée du stéthoscope 3200 Littmann® 

vers  le logiciel,  cliquez sur  le bouton  «  Importer  »  ou  sélectionnez  «  Importer  depuis  le stéthoscope  »  à  
partir du menu Fichier. Suivez les étapes ci-dessous : 

1. Sélectionnez les pistes enregistrées
à importer.

2. Saisissez les
informations patient
(facultatif).

5. Saisissez la posture du
patient (facultatif).3.

l
 Cliquez sur  l’icône  « Lecture »  pour  écouter
a piste Commentaire (le cas échéant). 

Remarque : écoutez la piste Commentaire 
au moyen des embouts auriculaires. 4. Saisissez le site d’enregistrement

patient (facultatif).

Écoutez la piste 
enregistrée 
(facultatif) 

Verrouillez ou 
déverrouillez la 
piste enregistrée 
dans la mémoire 
du stéthoscope 
(facultatif) 

Supprimez la 
piste enregistrée 
de la mémoire 
du stéthoscope 
(facultatif) 

6. Après avoir saisi les informations pour
toutes les pistes sélectionnées, cliquez
sur « Importer sélection ».
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4. Étude des enregistrements 

4.1  Zoom  et défilement du  signal  
Pour  effectuer  un  zoom  avant ou  arrière dans  un  affichage de son, sélectionnez  d’abord  
l’enregistrement souhaité en  cliquant dessus, puis  utilisez  les  boutons  « +  » ou  «  - »  du  Zoom  
horizontal  ou  du  Zoom  vertical.  Le zoom  avant offre un  plus  grand  niveau  de détail.  Le zoom  arrière  
offre un  plus  petit niveau  de  détail.  Le Zoom  vertical  a  également pour  effet d’augmenter  ou  de  
réduire le  volume d’enregistrement, dans  la  mesure où  il  affecte l’amplitude visuelle et sonore  
de l’enregistrement. 
Le Zoom horizontal permet de faire défiler l’enregistrement à l’aide des boutons de défilement. Pour 
déplacer l’enregistrement vers la gauche, cliquez sur le bouton « Défilement gauche ». Pour déplacer 
l’enregistrement vers  la  droite,  cliquez sur  le bouton  «  Défilement  droit ».  Il  est également possible de  se  

déplacer  vers  la  gauche ou  vers  la  droite dans  l’affichage sonore en  utilisant  le bouton  «  Faire  glisser  »  
qui  se trouve dans  la  barre d’outils.  Cliquez sur  ce bouton  en  forme  de main  pour  pouvoir  vous  déplacer  
vers la  droite  ou  vers la  gauche  dans les affichages sonores en  plaçant  votre  curseur  de  souris sur  un  
affichage  sonore et en  le  faisant glisser  dans  la  direction  souhaitée.  Désactivez cette  fonction  en  cliquant à  

nouveau  sur  le  bouton  «  Faire  glisser  »  . 
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4.2 Option d’affichage de spectrogramme 
Le spectrogramme est la  représentation,  sous  la  forme d’un  tableau  en  couleur  et  en  deux  dimensions,  de  
l’énergie sonore du cœur par rapport au temps et à la fréquence. Le noir représente l’énergie minimale 
tandis que le rouge représente l’énergie maximale. L’axe des abscisses (axe des « x ») est celui du temps 
écoulé, tandis que l’axe des ordonnées (axe des « y ») correspond à une gamme de fréquence linéaire 
comprise entre  0  et 500  Hz.  Le  spectrogramme apporte  un  point de vue supplémentaire quant  au  son  
enregistré.  Pour  consulter  un  affichage  sonore sous  forme de spectrogramme,  cliquez sur  le bouton  «  

Spectrogramme » qui apparaît à gauche de l’affichage sonore. Pour revenir à un affichage sonore 

standard, cliquez sur le bouton « Phonocardiogramme »  qui apparaît à gauche de l’affichage sonore. 

4.3 Lecture d’un enregistrement 
Appuyez  sur le  bouton  «  Lecture  »  pour commencer  la lecture.  Un  curseur rouge  se  déplacera le  long  de  
l’affichage sonore en synchronisation avec l’enregistrement. Cliquez sur le bouton « Arrêt » pour mettre un 
terme à la  lecture.  

Par  défaut,  le logiciel  lit la  piste sonore par  le biais  du  stéthoscope Littmann® 3200 (si connecté). Pour lire 
la  piste  au  moyen  des haut-parleurs de  l’ordinateur,  de  haut-parleurs externes ou  d’un  casque,  cliquez  sur  la  
case à cocher « Lecture avec casque ». 

ATTENTION : la qualité audio des sons provenant des haut-parleurs ou de la 
prise casque de l’ordinateur  peut ne pas  être la  reproduction  fidèle  des  sons  
réels  en  raison  de la  performance  acoustique de la  carte son  de l’ordinateur,  
des  pilotes  de la  carte  son  et/ou  de la  fréquence  de réponse des  écouteurs/  

haut-parleurs. Par conséquent, ces dispositifs peuvent ne pas permettre 
d’entendre les sons cliniquement importants. Il est fortement recommandé d’utiliser 

un  stéthoscope 3200  de 3M™  Littmann®  pour écouter les sons enregistrés. 

REMARQUE : l’amplitude ou le volume des sons enregistrés peut être inférieur à ce que vous avez 
entendu  pendant l’enregistrement initial.  Utilisez le  bouton « + » sur  l’axe vertical  du  graphique ou  

le clavier  du  stéthoscope pour  augmenter  le volume sonore.  

4.4 ½ vitesse 
L’option  de lecture à  ½  vitesse vous  permet de lire les  enregistrements  à  une vitesse réduite  de moitié sans  
que cela  ne modifie  les  propriétés  spectrométriques  du  signal  de manière  significative.  Cliquez sur  la  case  
à  cocher  «  Lecture à  ½  vitesse  »,  puis  sur  le  bouton  de lecture pour  lire les  enregistrements  à  une vitesse  
réduite de moitié. La case à cocher « Lecture à ½ vitesse » restera cochée jusqu’à ce que vous cliquiez à 
nouveau dessus. 

ATTENTION : s’il est vrai que l’option de ½ vitesse a été conçue 
pour permettre l’identification d’évènements physiologiques, elle 

ne doit toutefois pas être le seul moyen d’établir un diagnostic. 

4.5 Lecture d’une partie spécifique d’un enregistrement 
Pour lire une partie spécifique d’un enregistrement, il suffit de cliquer sur la zone de l’affichage sonore 
où  vous  souhaitez voir  commencer  votre enregistrement  et de faire glisser  la  souris  vers  la  droite afin  
de mettre en évidence la zone qui vous intéresse. Une fois la zone d’affichage sonore mise en évidence, 
appuyez sur  le  bouton  «  Lecture  »  pour  écouter  la  section  spécifique. Notez  que  vous  devez sélectionner  
un  segment  de son  d’une durée d’au  moins  une seconde  pour  que cette fonction  fonctionne correctement.  
Supprimez  la  sélection  de  zone  en  effectuant  un  clic  gauche  n’importe  où  dans  l’affichage  de  son.  
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4.6 Lecture en boucle 
La case à cocher « Lecture en boucle » qui apparaît en haut de l’écran vous permet de lire tout un 
enregistrement ou  une portion  spécifique d’enregistrement en  une boucle continue qui  ne  s’interrompra  
que lorsque vous  cliquerez sur  le bouton  «  Arrêt  ».  Pour  écouter  un  enregistrement complet  en  boucle,  
sélectionnez le son correspondant en cliquant dessus, cliquez sur la case à cocher « Lecture en boucle », 
puis  sur  le bouton  «  Lecture  ».  Pour  lire une portion  spécifique d’un  enregistrement en  boucle,  utilisez le  
curseur  pour  mettre en  évidence  la  zone d’intérêt sur  un  affichage sonore,  cliquez ensuite dans  la  case à  
cocher « Lecture en boucle », puis sur le bouton « Lecture ». La case à cocher « Lecture en boucle » restera 
cochée jusqu’à ce que vous cliquiez à nouveau dessus. 

4.7 Maximisation de la mise à l’échelle 
La fonction « Maximiser la mise à l’échelle » normalise l’ensemble des enregistrements contenus dans un 
seul ensemble donné d’enregistrements. Cette fonction permet à l’utilisateur de comparer précisément les 
amplitudes de plusieurs enregistrements. 

4.8 Fonction impression 
Pour imprimer une copie du « Rapport de rencontre avec un patient » d’un enregistrement donné ou d’un 
ensemble d’enregistrements, cliquez sur le bouton « Imprimer ». L’impression présentera l’identité du 
patient, le nom du patient (s’il a été saisi) et l’identifiant du stéthoscope utilisé pour les enregistrements. 
Le rapport  contiendra  également la  posture,  le site d’auscultation  et la  durée du  ou  des  enregistrements  
concernés, ainsi que tout commentaire saisi par l’utilisateur. 

4.9 Ajout de commentaires à un enregistrement 
Lorsque  vous êtes en  «  Vue  détaillée  »,  vous pouvez  ajouter  des commentaires au  fichier  sonore  en  passant  
en vue « Résumé » ou en cliquant sur le bouton « Commentaires » situé à gauche de l’identifiant patient. 
Une coche  verte  placée sur  le bouton  «  Commentaires  »  indique que des  commentaires  ont été  insérés  
pour ces enregistrements. 

5. Sauvegarde, ouverture et export des enregistrements 

5.1 Sauvegarde des enregistrements 
Cliquez sur le bouton « Sauvegarder » dans le coin en haut à gauche de l’écran ou sélectionnez « 
Sauvegarder » à partir du menu « Fichier ». Le logiciel StethAssist vous invitera automatiquement à 
sauvegarder l’enregistrement si vous commencez un nouvel enregistrement ou sortez du programme. 

5.2 Ouverture d’un fichier sonore préalablement enregistré 
Cliquez sur le bouton « Ouvrir » dans le coin en haut à gauche de l’écran ou sélectionnez « Ouvrir » à partir 
du  menu  «  Fichier  ».  Cliquez  sur  l’en-tête  afin  de  trier  en  fonction  de  ce  champ.  

5.3  Export  des enregistrements en format  .wav  
Pour exporter un enregistrement en format de fichier .wav, sélectionnez « Exporter enregistrement en 
format .wav » dans le menu « Fichier ». Très courant, le format de fichier .wav peut être lu sur la plupart des 
lecteurs multimédia d’ordinateurs. Veillez à bien sélectionner le filtre appliqué à l’enregistrement, tel que 
Cloche, Diaphragme ou Étendu. 
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6. Menus de navigation 

Le logiciel  StethAssist™  de 3M™  Littmann® contient les menus de sélection suivants : 
Fichier Outils Vue Aide 

6.1 Fichier 
Fichier > Sauvegarder 
Sauvegarde l’ensemble d’enregistrements en cours. 

Fichier > Ouvrir 
Ouvre un ensemble d’enregistrements préalablement effectués. 

Fichier > Fermer 
Ferme l’ensemble d’enregistrements en cours. 

Fichier > Nouvelle rencontre 
Débute un nouvel enregistrement patient. 

Fichier > Commentaires 
Ouvre la fenêtre de commentaires. 

Fichier > Importer depuis le stéthoscope 
Importe un enregistrement depuis la mémoire intégrée du stéthoscope. 

Fichier > Importer enregistrements sauvegardés vers répertoire actuel 
Transfère les fichiers d’enregistrements précédemment sauvegardés d’un autre emplacement de 
l’ordinateur vers le répertoire d’enregistrement actuel. Le déplacement des fichiers hors du répertoire 
actuel permettra d’accélérer le démarrage du programme et de réduire la durée nécessaire à l’ouverture 
d’un fichier précédemment sauvegardé. 

Fichier > Exporter enregistrements sauvegardés 
Transfère les fichiers d’enregistrements précédemment sauvegardés du répertoire d’enregistrement 
actuel vers un autre emplacement de l’ordinateur. Le déplacement des fichiers hors du répertoire actuel 
permettra d’accélérer le démarrage du programme et de réduire la durée nécessaire à l’ouverture d’un 
fichier précédemment sauvegardé. 

Fichier > Importer fichier e4k 
Importe un fichier en format .e4k. Le format de fichier .e4k est le format qui était utilisé par les précédents 
modèles de stéthoscopes électroniques de 3M™ Littmann®, les modèles 4000 et 4100. 

Fichier > Exporter enregistrement au format .wav 
Ouvre la fenêtre « Export fichier » pour sauvegarder l’enregistrement en format de fichier .wav. 

Fichier > Imprimer rapport 
Imprime  le  Rapport de rencontre avec  un  patient pour  un  ensemble d’enregistrements  donné.  

Fichier > Derniers fichiers consultés 
Ouvre un ensemble d’enregistrements récemment consultés. 

Fichier > Quitter 
Quitte l’application StethAssist. 

6.2 Outils 
Outils > Ajout d’un nouveau stéthoscope 
Ouvre la fenêtre « Ajout d’un nouveau stéthoscope ». 

Outils > Réglages  du  stéthoscope  
Ouvre la  fenêtre  «  Réglages  du  stéthoscope »,  dans  laquelle vous  pouvez  :  

• Supprimer un stéthoscope couplé. 
• Changer le nom du stéthoscope. 
• Régler la durée du temps d’attente avant que le logiciel StethAssist™ ne commence à enregistrer 

après l’appui sur le bouton (M) du stéthoscope. Options de temps d’attente : 0, 1, 2 ou 4 secondes. 
• Sélectionner la posture par défaut du patient. 
• Sélectionner la durée par défaut d’un enregistrement. 
•  Sélectionner la vue  par défaut  (résumée  ou  détaillée).  

Outils > Options 
Modifie le répertoire par défaut dans lequel sont sauvegardés les enregistrements et/ou modifie la langue 
par défaut. 
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6.3 Affichage 
Sélectionne Vue détaillée ou  Vue  résumée.  

6.4 Aide 
Aide > Aide en ligne 
Ouvre un  navigateur  Internet et  se connecte au  site Internet StethAssist  à  l’adresse  
www.littmann.com/StethAssist. 

Aide  >  Manuel  de  l’utilisateur  
Ouvre le manuel de l’utilisateur du logiciel. 

Aide > À propos des produits Littmann® 

Ouvre un  navigateur  Internet et  se connecte au  site Internet  Littmann.com. 

Aide > À propos de 
Affiche le numéro de version du produit ainsi que les numéros de téléphone et les adresses relatives aux 
demandes d’informations supplémentaires ou de service. 

Aide > Rechercher la dernière version 
Recherche  les versions les plus  récentes de  StethAssist.  

7. Amélioration de la qualité d’enregistrement 

La qualité des enregistrements dépend de l’environnement, du patient et de la technique employée : 

L’environnement acoustique : 
Procédez  à  l’auscultation  dans  un  environnement aussi  silencieux que possible.  Soyez attentif  aux bruits  de  
fond, tels  que celui  de la  circulation  qui  peut entrer  par  une fenêtre ouverte  ou  celui  de la  climatisation  et  
des  ventilateurs,  et éliminez-les  du  mieux que vous  pouvez.  Assurez-vous  qu’aucune conversation  ne gêne  
l’enregistrement et prévenez toute interruption de l’enregistrement. 

Le patient : 
Si  possible,  le patient doit  être prêt de telle sorte  que le stéthoscope puisse être en  contact direct  
avec  sa  peau.  Demandez au  patient de rester  aussi  silencieux que possible  pendant toute  la  durée  
de l’enregistrement. 

Positionnement et manipulation du stéthoscope : 
Lors de l’utilisation d’un stéthoscope Littmann® 3200, il est important d’envisager plusieurs techniques 
susceptibles d’améliorer sensiblement la qualité de l’auscultation. 

Le micro,  responsable de  toute  acquisition  sonore,  est relativement petit et situé au  centre  du  pavillon  
du  stéthoscope (à  des  fins  de  démonstration,  il  vous  suffit de soulever  le  diaphragme pour  voir  les  
indentations  sous  l’autocollant blanc).  La  zone autour  de ce capteur  sonore ne participe  pas  à  l’obtention  
des sons. C’est pourquoi il est important de bien placer le centre du pavillon contre la peau. 

Un  léger  contact suffit avec  le stéthoscope Littmann® 3200. Cela concerne à la fois la manipulation du 
stéthoscope et le contact avec  le patient.  Une pression  excessive sur  la  peau  du  patient risque d’entraîner  
des bruits parasites. 

Pour  une  qualité  sonore optimale,  le contact avec  le  patient doit être stable et régulier.  Tout mouvement  du  
pavillon du stéthoscope risque de provoquer des bruits de frottement. 

Il  est  recommandé  de  commencer  l’auscultation  à  un  niveau  d’amplification  relativement  faible.  Ensuite,  
augmentez  le volume sonore si  vous  tentez  de percevoir  un  son  difficile  à  entendre.  Réglez le volume  
sonore  en  fonction  de  vos besoins afin  de  réduire  les bruits parasites lors de  l’auscultation.  

Enfin,  il  est important de connaître la  différence technique entre les  stéthoscopes  non  électroniques  et les  
stéthoscopes électroniques. Tenir le stéthoscope Littmann® 3200 avec légèreté, en assurant un contact 
léger  avec  le patient,  en  se  concentrant  sur  le point de contact au  centre du  pavillon  du  stéthoscope et en  
restant  immobile vous  garantit une auscultation  de qualité  optimale.  
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8. Dépannage 

Problème Cause possible Solution 

Impossible de connecter 
le stéthoscope 

Aucun adaptateur Bluetooth 
USB sans fil installé / installation 
incorrecte de l’adaptateur 
Bluetooth USB sans fil 

Insérez l’adaptateur Bluetooth USB sans fil. 
Désactivez la radio Bluetooth interne 
de l’ordinateur. 
Mettez le driver Bluetooth à jour avec 
l’adaptateur Bluetooth générique. 

Stéthoscope non couplé Couplez le stéthoscope. Sélectionnez « 
Ajout d’un  nouveau  stéthoscope  » à partir  
du  menu  Outils  sur  l’écran  principal.  

Chaque identifiant 
unique de stéthoscope ne 
peut représenter qu’un 
seul stéthoscope. 

Si votre établissement dispose de plusieurs 
stéthoscopes, assurez-vous que vous êtes 
bien  en  train  d’établir  une  connexion  avec  le  
bon identifiant de stéthoscope. 

Indéterminé Éteignez le stéthoscope, attendez plusieurs 
secondes puis rallumez le stéthoscope. 

Signal enregistré bruyant Bruits de fond excessifs Prenez les mesures nécessaires pour 
réduire les bruits de fond qui polluent 
l’environnement de l’auscultation. 

Le signal présenté dans 
les tableaux d’affichage 
est interrompu. 

Enregistrement bruyant Reportez-vous à la Section 7 de ce manuel, 
intitulée « Amélioration de la qualité 
d’enregistrement ». 

Mauvaise qualité 
des données 

Bruits de fond excessifs Prenez les mesures nécessaires pour 
réduire les bruits de fond qui polluent 
l’environnement de l’auscultation. 

Mouvements excessifs 
du stéthoscope 

Tenez fermement le stéthoscope, en 
maintenant une légère pression sur la peau 
du patient pendant l’enregistrement. 

En  cas de  questions ou  de  problèmes concernant  le  logiciel  StethAssist™ de  3M™  Littmann® ou le 
stéthoscope Littmann® 3200,  veuillez contacter  la  ligne d’assistance téléphonique de notre  service  
clientèle au +1-800-228-3957 ou chercher sur www.Littmann.com le site de 3M™ Littmann® 

correspondant à votre pays, sur lequel vous pourrez consulter la Foire aux questions et accéder à la 
page Contactez-nous. 

3M Health Care 
Produits de la marque Littmann® 

3M Center, Building 275-4E-01 
2510 Conway Ave. 
St. Paul, MN 55144 
1-800-228-3957 
www.littmann.com 

3M,  Littmann  et  StethAssist  sont  des marquées déposées de  3M,  utilisées sous licence au  Canada.  Windows  est
une marque  déposée de Microsoft.  Bluetooth  est une marque déposée de  The Bluetooth  SIG,  Inc.  Mac  est une  
marque déposée d’Apple  Inc.  

 

© 2017 3M. Tous droits réservés. 

34-8721-7685-3 

26 Français 

PDF Scaled at 100.0% 

www.littmann.com
www.Littmann.com


3M™ Littmann® StethAssist™ 

Software zur Visualisierung von Herz- und Lungentönen 

Benutzerhandbuch ‑ Version 4 

27 Deutsch 

PDF Scaled at 100.0% 



 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

INHALTSVERZEICHNIS 

1. Allgemeine Informationen 29 

2. Erste Schritte 30 

3. Erstellen einer Neuen Aufzeichnung (New Recording) oder Importieren von Aufzeichnungen 
(Import Recording(s)) vom Stethoskop 33 

4. Auswerten der Aufzeichnungen 35 

5. Speichern, Öffnen und Exportieren von Aufzeichnungen 37 

6. Navigationsmenüs 37 

7. Verbessern der Aufzeichnungsqualität  . 39 

8. Problemsuche und -behebung 40 

28 Deutsch 

PDF Scaled at 100.0% 

. . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .



1. Allgemeine Informationen 

1.1 Bestimmungsgemäße Verwendung 
Die Software 3M™  Littmann® StethAssist™ zur Visualisierung von Herz- und Lungentönen ist zur 
Verwendung mit dem elektronischen Stethoskop 3M™ Littmann® Modell 3200 für das Aufnehmen und 
Anzeigen von Herztönen und anderen physiologischen Schallsignalen bestimmt. Die Software ist für den 
Einsatz in Arztpraxen bestimmt. Sie ist nicht für die Stellung von Diagnosen bestimmt. Dieses Produkt 
berichtet keine klinischen Beobachtungen oder Analysen. 

1.2 Hinweise zur Sicherheit 

Beachten Sie die Gebrauchsanweisung 

Bitte lesen Sie vor der Verwendung der Software alle in dieser Anleitung aufgeführten Sicherheitshinweise, 
die Sie verstanden haben und stets befolgen sollten. Bewahren Sie die Anleitung für späteres 
Nachschlagen auf. 

Warnhinweise (VORSICHT) oder sonstige Hinweise (HINWEIS) sind in diesem Handbuch mit einem Kasten 
versehen. Sie haben die folgende Bedeutung: 

VORSICHT: Weist auf eine Situation hin, in der die Software möglicherweise ungenaue oder unvollständige 
Informationen liefert. 

HINWEIS: Informationen, die als besonders wichtig erachtet werden. 

1.3 Systemanforderungen und Spezifikationen 
Anforderungen an den Computer: 

• Windows 7 32-bit, Windows 7 64-bit, Windows 8 32-bit, Windows 8 64-bit, Windows 10 32-bit, 
Windows 10 64-bit. 

• Mac  OS  10.12  
• 1024 MB RAM oder größer 
• Intel Core 2 Duo kompatibel oder höher 
• Bildschirmauflösung 1024 x 768 oder besser 
• USB 1.1-Anschluss oder höher zur Unterstützung des USB Bluetooth Wireless Adapters 

1.4 Patientendatenschutz 
Der Schutz und die Sicherheit bestimmter, individuell identifizierbarer Gesundheitsinformationen werden 
möglicherweise durch Landes- oder Bundesgesetze sowie internationale und/oder ausländische Gesetze, 
die die Verwendung, Freigabe, Speicherung und Weitergabe solcher Informationen zum Inhalt haben, 
geregelt. In bestimmten Fällen ist es Ihnen möglicherweise untersagt, Dritten ohne vorherige schriftliche 
Genehmigung Zugang zu diesen Informationen zu gestatten. 

Im Rahmen der Benutzung dieser Software liegt es in Ihrer alleinigen und vollständigen Verantwortung,
alle relevanten Gesetze hinsichtlich der erlaubten Speicherung und Übertragung jeglicher individuell 
identifizierbarer Gesundheitsinformationen zu kennen, zu verstehen und zu befolgen. Wenn Sie im 
Rahmen der Verwendung dieser Software feststellen, dass Sie ein Gesetz oder eine Beschränkung in 
Bezug auf die Verwendung und Offenlegung (einschließlich Weitergabe) individuell identifizierbarer 
Gesundheitsinformationen nicht befolgen können, dann sollten Sie solche Informationen auch nicht 
speichern. Mit der Speicherung solcher Gesundheitsinformationen übernehmen Sie sämtliche Risiken 
sowie die Verantwortung  und  alle Verpflichtungen,  die mit dem  Gebrauch,  der  Speicherung  und/oder  der
Übertragung solcher Informationen, einschließlich der Tondokumente, sei es elektronisch oder auf andere 
Weise, verbunden sind. 

Für die ordnungsgemäße Funktion dieses Programms ist die Eingabe individuell identifizierbarerer 
Gesundheitsinformationen nicht erforderlich. Aufzeichnungen können mittels eines Zeitstempels 
oder einer willkürlich zugewiesenen Kennung gespeichert und abgerufen werden. Wenn Sie sich 
entscheiden, sinngebende Patientennamen oder -kennungen einzugeben, dann stimmen Sie zu, jedwede
Risiken und Verpflichtungen, die mit der Übermittlung und Speicherung individuell identifizierbarer 
Gesundheitsinformationen, einschließlich dem Schutz und der Sicherheit solcher Informationen, durch die 
Software einhergehen, einzugehen bzw. zu übernehmen. 
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2. Erste Schritte 

2.1 Installieren und Registrieren der 3M™ Littmann® StethAssist™ Software 
Gehen Sie zur Installation der Software 3M™ Littmann® StethAssist™ auf Ihrem Computer wie folgt vor: 

1. Navigieren Sie zu www.Littmann.com/StethAssist 
2. Klicken Sie auf den Link „Download StethAssist“ (StethAssist herunterladen) 
3.  Klicken  Sie in  der  eingeblendeten  Meldungsbox auf  „Run“ (Ausführen)  
4. Befolgen Sie die Anweisungen zur Installation der Software. 
5. Bitte registrieren Sie die Software anschließend online. 

HINWEIS:  Wenn Sie die Software nicht über das Internet registrieren möchten, 
dann kontaktieren Sie bitte unter 1-800-228-3957 oder 

littmannsoftwaresupport@mmm.com den Kundendienst von 3M™ Littmann®. 

2.2 Einstecken des USB Bluetooth Wireless Adapters (Dongle) 
Zur  Installation  des  USB  Bluetooth  Wireless  Adapters  stecken  Sie  diesen  bitte  in  den  USB-Anschluss  Ihres  
Computers ein. Der USB Bluetooth Wireless Adapter ermöglicht die Kommunikation zwischen Ihrem 
Computer, auf dem die Software installiert ist, und dem elektronischen Stethoskop 3M™ Littmann® 

Modell 3200. Der Adapter empfängt und übermittelt Daten mit Hilfe der allgemein anerkannten 
Bluetooth®-Technologie zur drahtlosen Geräteverbindung über kurze Distanzen. 

Bevor Sie Stethoskop und Software paaren können, müssen Sie vor dem Starten der 
3M™ Littmann® StethAssist™  Software  den USB Bluetooth Wireless  Adapter  in Ihren Computer  
einstecken. Wenn die Software den USB Bluetooth Wireless Adapter nicht erkennt, dann wird die 
nachfolgende Meldung angezeigt. Wenn diese Meldung angezeigt wird, dann stecken Sie den USB 
Bluetooth Wireless Adapter in Ihren Computer ein. Schließen Sie anschließend die Software und starten 
Sie diese erneut. 
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2.3 Paaren und Verbinden des Stethoskops mit der Software 
Der nachfolgende Bildschirm unterstützt Sie beim Paaren und/oder Verbindung eines Stethoskops mit 
der Software. 

2.3.1 Paaren eines neuen Stethoskops 

Vor dem ersten Verbinden eines Littmann® Stethoskops des Modells 3200 mit der 
3M™ Littmann® StethAssist™  Software müssen  Sie zunächst das  Stethoskop  mit der  Software  
paaren.Wählen Sie zum Paaren eines neuen Stethoskops „Add new Stethoscope“ (Neues 
Stethoskop hinzufügen) aus dem Dropdown-Menü aus und klicken Sie anschließend auf „Pair“ 
(Paaren) (oder wählen Sie auf dem Hauptbildschirm aus dem Tools-Menü „Add new Stethoscope“ 
(Neues Stethoskop hinzufügen) aus). Befolgen Sie die Anweisungen auf dem Bildschirm. Sobald das 
Stethoskop gepaart ist, verbindet sich die Software automatisch mit dem Instrument. Jedes Mal, 
wenn Sie danach die Software starten, müssen Sie sich nur noch mit dem Stethoskop verbinden. 

2.3.2 Verbinden des Stethoskops 

Wählen Sie zum Verbinden eines zuvor gepaarten Stethoskops den Namen des Stethoskops 
aus dem Dropdown-Menü aus und klicken Sie auf „Connect“ (Verbinden). Drücken Sie am 
Stethoskop zwei Mal auf die Schaltfläche „M“, um „CONNECT“ (VERBINDEN) auszuwählen. 
Jedes Mal, wenn Sie versuchen, ein Stethoskop mit der Software zu verbinden, erscheint der 
nachfolgende Bildschirm. 

Wenn Sie Aufzeichnungen ansehen und überprüfen wollen, ohne ein Stethoskop zu verbinden, 
dann  klicken  Sie  auf  „Cancel“  (Abbrechen).  
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Zeigt das Stethoskop 
an, zu dem die Software 
eine Verbindung 
aufbauen möchte. 

Wenn Ihr Stethoskop verbunden ist, zeigt die Schaltfläche „Stethoscope Connection“ (Verbindung des 

Stethoskops) ein grünes Häkchen an .  Ist das  Stethoskop  nicht verbunden,  dann  zeigt  die Schaltfläche

„Stethoscope Connection“ (Verbindung des Stethoskops) ein rotes X an . 

HINWEIS: Befolgen Sie zur Optimierung drahtloser Verbindungen diese Tipps 

1. Auskultieren  Sie  den  Patienten  so  nah  wie  möglich  am  USB  Wireless  Adapter.
2. Achten Sie darauf, dass sich zwischen dem Stethoskop und dem Wireless Adapter

weder Personen noch Gegenstände befinden.
3. Achten Sie darauf, dass Ihre Hand nicht das gesamte Bruststück des Stethoskops

(Sitz der Bluetooth®-Antenne) bedeckt.

HINWEIS: Sie können mehrere Stethoskope mit der Software 3M™ Littmann® StethAssist™ 
paaren. Allerdings kann jeweils nur ein (1) Stethoskop aktiv mit der Software verbunden sein. 

Das Stethoskop kann nur  mit einem (1) Computer  aktiv verbunden sein. 
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3. Erstellen einer Neuen Aufzeichnung  (New  Recording)  oder Importieren von
Aufzeichnungen (Import Recording(s)) vom Stethoskop

Das Fenster zur Einrichtung einer Aufzeichnung

Wählen Sie die Körperhaltung 
des Patienten 

Wählen Sie die 
Aufzeichnungslänge 
(5-60 Sekunden) 

Geben Sie die 
Patienteninformationen 
ein (optional) 

Wählen Sie aus dem 
Dropdown-Menü eine 
Aufzeichnungs-Stelle aus 
oder klicken Sie auf den blauen 
Torso, um manuell eine Stelle 
zu benennen. Klicken Sie zum 
Wechsel auf ein anderes 
Bild auf die  jeweilige  
Miniatur-Ansicht. 

3.1  Erstellen  Sie eine neue Aufzeichnung  (New  Recording)
3.1.1. Klicken Sie zum Starten einer neuen Aufzeichnung auf die Schaltfläche „New Encounter“ (Neuer 

Vorgang). Geben Sie im Fenster zur Einrichtung einer neuen Aufzeichnung die Patienten-ID und den 
Patientennamen ein (optional; siehe Abschnitt 1.4 für Informationen zum Patientendatenschutz). 
Eine Patienten-ID kann aus beliebigen Buchstaben-Zahlen-Kombinationen bestehen und bis 
zu 20 Zeichen enthalten. Folgenden Zeichen können für die Patienten-ID verwendet werden: 
a-z, 0-9, - und _ 

3.1.2.  Wählen  Sie die Aufzeichnungslänge,  die Aufzeichnungsstelle und  die Körperhaltung  des  Patienten
aus. Klicken Sie anschließend auf „OK“. 

3.1.3. Suchen Sie an der gewünschten Patientenstelle nach einer guten Klangqualität und drücken Sie 
anschließend zum Starten der Aufzeichnung auf die Schaltfläche „M“. 

3.1.4. Drücken Sie zum erneuten Starten der Aufzeichnung zuerst zum Stoppen der Aufzeichnung 
auf  die  Schaltfläche  „M“  und  dann  nochmals  zum  erneuten  Starten  der  Aufzeichnung  auf  die
Schaltfläche „M“. 
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3.1.5. Nach Fertigstellung der Aufzeichnung können Sie für denselben Patienten eine weitere 
Aufzeichnung vornehmen, indem Sie auf die Schaltfläche „Add Recording“ (Aufzeichnung 
hinzufügen) klicken. Klicken Sie für die Aufzeichnung eines neuen Patienten auf die Schaltfläche 
„New Encounter“ (Neuer Vorgang). Die Software 3M™ Littmann® StethAssist™ fragt automatisch, 
ob  Sie das  aktuelle Aufzeichnungs-Set speichern  möchten.  

3.1.6. Klicken Sie zur Eingabe von Patientenkommentaren auf die Ansicht „Überblick“ (optional). 

HINWEIS:  Die eingestellte  Lautstärke des  Stethoskops  hat keinen  Einfluss  auf  die Lautstärke der  
Aufzeichnungen. Die Aufnahme kann unabhängig davon, welche Filtereinstellung während der 

Aufnahme verwendet wurde, in allen drei Filtereinstellungen (Bell, Diaphragm, Extended Range -
?Glocke/Diaphragma/erweiterter Bereich?) abgespielt werden. 

3.2 Aufzeichnungen aus dem Stethoskop‑Speicher importieren (Import Recording(s} 
Klicken Sie für die Übertragung gespeicherter Aufzeichnungen im Speicher des Stethoskops Littmann® 

Modell 3200 in die Software auf die Schaltfläche „Import“ oder wählen Sie im Datei-Menü „Import from 
Stethoscope“ (Vom Stethoskop importieren). Gehen Sie wie folgt vor: 

1. Wählen Sie die zu importierenden
Aufzeichnungen aus

2. Geben Sie die
Patienteninformationen
ein (optional).

5. Geben Sie die
Körperhaltung des
Patienten ein (optional).

3. Klicken Sie zum Abhören des Tracks
„Comment“ (Kommentar; wenn
vorhanden) auf  das  Symbol „Play“
(Abspielen). HINWEIS: Der Track
„Kommentar“ wird über die Ohrstücke 
des Stethoskops abgespielt.

4. Geben Sie die Aufnahmestelle
des Patienten ein (optional).

6. Klicken Sie nach Eingabe der
Informationen für alle aufgezeichneten
Tracks auf „Import Selected“
(Auswahl importieren).
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Detail‑Ansicht

Ziehen. 
Ermöglicht die 

Verwendung des 
Mauszeigers zur 

Verschiebung 
der 

Schalldarstellung 
nach links 

oder rechts 

Filterauswahl 

Track-
Kommentare 

Löschen von 
Aufzeichnungen 
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aufzeichnen 

Hinzufügen von 
Kommentaren 

Abspielen 

Öffnen 
der Datei 

Speichern 
der Datei 

Starten 
eines neuen 
Vorgangs 

Wechseln 
der 
Ansicht 

Importieren von 
Aufzeichnungen 
aus dem 
Speicher des 
Stethoskops 

Abspielen des 
Tracks mit halber 
Geschwindigkeit 

Abspielen über 
die Klinkenstecker 
oder Lautsprecher 
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Skalieren 
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Verbindung 

Phonokardiogramm (PKG)-
Ansicht der Schalldarstellung 
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Verschieben 
nach links 

Verschieben 
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Vertikaler Zoom 

Horizontaler Zoom 

Vorhandenem 
Vorgang eine 
Aufzeichnung 
hinzufügen 

4. Auswerten der Aufzeichnungen

4.1 Verschieben sowie Vergrößern/Verkleinern der Schalldarstellung 
Klicken Sie zur graphischen Vergrößerung bzw. Verkleinerung der grafischen Ansicht zuerst auf eine 
Aufzeichnung und verwenden Sie anschließend die „+“- oder „-“-Schaltflächen für die horizontale oder 
vertikale Verkleinerung bzw. Vergrößerung. Wenn Sie die Ansicht vergrößern, werden mehr Details 
angezeigt. Wenn Sie die Ansicht verkleinern, werden weniger Details angezeigt. Ändern Sie die vertikale 
Vergrößerung bzw. Verkleinerung, dann erhöht bzw. verringert sich auch die Lautstärke der Aufzeichnung, 
da sich dies auf die sichtbare als auch hörbare Amplitude der Aufzeichnung auswirkt. 

Bei der horizontalen Vergrößerung können Sie mit den Schaltflächen „Pan“ (Verschieben) durch die 
Aufzeichnung blättern. Klicken Sie zum Verschieben der Aufzeichnung nach links auf die Schaltfläche 
„Pan Left“ (Verschieben nach links). Klicken Sie zum Verschieben der Aufzeichnung nach rechts auf 
die Schaltfläche „Pan  Right“ (Verschieben  nach  rechts).  Sie können  die  Schalldarstellung  auch  mit  Hilfe

der Schaltfläche „Drag“ (Ziehen) in der Tool-Leiste verschieben. Wenn Sie auf diese handförmige 
Schaltfläche klicken, können Sie jede Aufzeichnung wie folgt nach rechts bzw. links verschieben: 
Platzieren Sie den Mauszeiger auf eine Schalldarstellung und ziehen Sie diesen dann in die Richtung, in der 
Sie die Schalldarstellung verschieben wollen. Klicken Sie zum Deaktivieren dieser Funktion nochmals auf 

die Schaltfläche Drag“ (Ziehen). 

4.2 Anzeigeoptionen für das Spektrogramm 
Das Spektrogramm ist eine Zeit-Frequenz-Verteilung, die als zweidimensionales, farbiges Schaubild 
der  Schallenergie über  die Zeit und  Frequenz dargestellt wird.  Die minimale Energie wird  schwarz,  die
maximale Energie wird  rot dargestellt.  Die X-Achse zeigt den  Zeitindex an,  während  die Y-Achse den  
linearen Frequenzbereich von 0 - 500 Hz anzeigt. 

Das Spektrogramm bietet eine weitere Betrachtungsweise der aufgezeichneten Töne. Klicken Sie zur 
Anzeige der Schalldarstellung im Spektogramm-Modus auf die sich links von der Schalldarstellung 

befindliche Schaltfläche „Spectogram“  b(Spektrogramm). Klicken Sie zur Rückkehr zur 
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Standardansicht einer Schalldarstellung auf die links neben der Schalldarstellung befindliche Schaltfläche 

„Phonocardiogram“ (Phonokardiogramm). 

4.3 Abspielen einer Aufzeichnung 
Drücken Sie zum Start der Wiedergabe die Schaltfläche „Play“ (Abspielen). Synchron mit der Aufzeichnung 
wandert ein roter Cursor über die Schalldarstellung. Klicken Sie zum Beenden der Wiedergabe auf die 
Schaltfläche „Stop“ (Stopp). 

Standardmäßig  spielt die Software die Aufzeichnung  über  das  Stethoskop  Littmann® Modell 3200 ab 
(wenn es mit der Software verbunden ist). Markieren Sie zum Abspielen der Aufzeichnung über 
Computer-Lautsprecher, externe Lautsprecher oder Kopfhörer das Kontrollkästchen „Play to Headphone“
(Über Kopfhörer abspielen).box. 

VORSICHT:  Die Audioqualität der über die Tonausgabe oder den Audioanschluss des PCs 
abgespielten  Töne ist möglicherweise keine originalgetreue Wiedergabe der  tatsächlichen  Töne,  

da  die Akustikleistung von der  Soundkarte des PCs, dem Soundkartentreiber  und/oder  dem 
Frequenzbereichs der Kopfhörer oder Lautsprecher abhängt. Möglicherweise sind Sie nicht in 
der  Lage,  klinisch  relevante  Töne  zu  hören.  Es  wird  daher  nachdrücklich  empfohlen,  sich  die  

aufgezeichneten Töne über ein 3M™ Littmann® Stethoskop, Modell  3200, anzuhören.  

HINWEIS:  Die Amplitude bzw. Lautstärke der aufgezeichneten Töne ist möglicherweise niedriger 
bzw. leiser als das Gehörte während der Aufzeichnung. Sie können die Lautstärke mithilfe der 
Schaltfläche „+” auf der vertikalen Achse der wellenförmigen Darstellung oder direkt auf dem 

Tastenfeld des Stethoskops erhöhen. 

4.4 Halbe Geschwindigkeit 
Die Option „½ Speed“ (½ Geschwindigkeit) ermöglicht das Abspielen der Aufzeichnungen mit halber 
Geschwindigkeit. Die spektralen Eigenschaften des Signals werden hiervon nicht signifikant beeinträchtigt. 
Markieren Sie zur Wiedergabe der Aufzeichnung in halber Geschwindigkeit das Kontrollkästchen „½ 
Speed“ (½ Geschwindigkeit) und klicken Sie anschließend auf die Schaltfläche „Play“ (Abspielen). Das 
Kontrollkästchen „½ Speed“ (½ Geschwindigkeit) bleibt solange aktiviert, bis Sie es erneut anklicken. 

VORSICHT: Die Option „½ Speed“ (½ Geschwindigkeit) kann Sie bei der Identifizierung 
physiologischer Ereignisse unterstützen; Sie sollte nicht als alleinige Grundlage für das Stellen 

einer physiologischen Diagnose verwendet werden. 

4.5 Einen bestimmten Abschnitt der Aufzeichnung wiedergeben 
Klicken Sie zur Wiedergabe eines bestimmten Abschnitts einer Aufzeichnung einfach mit der Maus in den 
Bereich der Schalldarstellung, an dem die Wiedergabe beginnen soll. Ziehen Sie dann den Mauszeiger 
nach  rechts,  um  den  gewünschten  Bereich  zu  markieren.  Sobald  Sie  auf  diese  Weise  einen  Teil  der  
Schalldarstellung ausgewählt haben, brauchen Sie zum Abspielen des entsprechenden Abschnitts nur 
noch auf die Schaltfläche „Play“ (Abspielen) klicken. Beachten Sie bitte, dass der ausgewählte Abschnitt 
für  diese  Funktion  mindestens  eine  Sekunde  lang  sein  muss.  Mit  einem  Linksklick  in  einen  belieben  Bereich  
der Schalldarstellung heben Sie die Auswahl des Abschnitts wieder auf. 

4.6 Die Loop‑Funktion (Wiederholte Wiedergabe) 
Das Kontrollkästchen „Loop“ (Wiederholte Wiedergabe) im oberen Bereich des Bildschirms ermöglicht 
die wiederholte Wiedergabe einer gesamten Aufzeichnung oder eines bestimmten Teilabschnitts 
einer Aufzeichnung, bis Sie auf die Schaltfläche „Stop“ (Stopp) klicken. Wählen Sie zum Abspielen der 
gesamten Aufnahme im Loop-Modus (Wiederholte Wiedergabe) die entsprechende Schalldarstellung mit 
einem Klick aus, markieren Sie das Kontrollkästchen „Loop“ (Wiederholte Wiedergabe) und klicken Sie 
anschließend auf die Schaltfläche „Play“ (Abspielen). Wählen Sie zum Abspielen eines Teilabschnitt der 
Aufnahme im Loop-Modus (Wiederholte Wiedergabe) den entsprechenden Bereich mit der Maus aus, 
markieren Sie das Kontrollkästchen „Loop“ (Wiederholte Wiedergabe) und klicken Sie anschließend auf die 
Schaltfläche „Play“ (Abspielen). Das Kontrollkästchen „Loop“ (Wiederholte Wiedergabe) bleibt aktiviert, 
bis Sie es erneut anklicken. 
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4.7 Global Scaling (Globale Skalierung) 
Die Funktion  „Globale Skalierung“ normalisiert alle Aufzeichnungen  innerhalb  eines  Aufzeichnungs-Sets.  
So erhält der Benutzer die Möglichkeit, die Amplituden mehrerer Aufzeichnungen genau miteinander 
zu vergleichen. 

4.8 Die Print‑Funktion (Drucken) 
Klicken Sie zum Drucken einer Kopie des „Vorgangsbericht für einen Patienten“ einer/s gegebenen 
Aufzeichnung oder Aufzeichnungs-Sets auf die Schaltfläche „Print“ (Drucken). Der resultierende Ausdruck 
enthält die Patienten-ID, den Namen des Patienten (sofern angegeben) und die ID des für die Aufzeichnung 
verwendeten Stethoskops. Des Weiteren enthält der Ausdruck die Körperhaltung des Patienten, 
den Stelle der Auskultation und die Länge der entsprechenden Aufzeichnung(en) sowie eventuell 
eingegebene Kommentare. 

4.9 Hinzufügen von Kommentaren zu einer Aufzeichnung 
In der Detail-Ansicht können Sie einer Ton-Datei Kommentare hinzufügen. Wechseln Sie hierfür in 
die Ansicht „Überblick“ oder klicken Sie auf die links neben der Patienten-ID befindliche Schaltfläche 
„Comments“ (Kommentare). Ein grüner Haken auf dieser Schaltfläche zeigt an, dass für diese 
Aufzeichnung(en) Kommentare vorhanden sind. 

5. Speichern, Öffnen und Exportieren von Aufzeichnungen 

5.1 Speichern von Aufzeichnungen 
Klicken Sie auf die in der oberen linken Ecke des Bildschirms befindlichen Schaltfläche „Save“ (Speichern) 
oder  wählen  Sie „Save“ (Speichern)  aus  dem  Menü  „File“ (Datei)  aus.  Wenn  Sie eine neue  Aufzeichnung  
starten oder die Anwendung verlassen, fordert die StethAssist-Software Sie automatisch auf, die 
Aufzeichnung zu speichern. 

5.2 Öffnen einer zuvor gespeicherten Ton‑Datei 
Klicken Sie auf die in der oberen linken Ecke des Bildschirms befindlichen Schaltfläche „Open“ (Öffnen) 
oder wählen Sie „Open“ (Öffnen) aus dem Menü „File“ (Datei) aus. Klicken Sie auf die Überschrift, um die 
Ansicht nach diesem Feld zu sortieren. 

5.3 Exportieren von Aufzeichnungen als .wav‑Dateien 
Wählen Sie für das Exportieren einer Aufzeichnung im Dateiformat .wav aus dem Menü „File“ (Datei) die 
Option „Export recording as .wav“ (Aufzeichnung als .wav exportieren) aus. Das Dateiformat .wav ist weit 
verbreitet und lässt sich mit den meisten PC-Wiedergabeprogrammen abspielen. Achten Sie darauf, dass 
Sie den auf die Aufzeichnung angewendeten Filter (Bell, Diaphragm oder Extended) auswählen. 

6. Navigationsmenüs 

Die Software 3M™  Littmann®  StethAssist™ enthält die folgenden Menüpunkte: 
Datei Tools Ansicht Hilfe 

6.1 Datei 
Datei > Speichern 
Speichert das aktuelle Aufzeichnungs-Set. 

Datei > Öffnen 
Öffnet ein vorhandenes Aufzeichnungs-Set. 
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Datei > Schließen 
Schließt das aktuelle Aufzeichnungs-Set. 

Datei > Neuer  Vorgang  
Beginnt mit einer neuen Patienten-Aufzeichnung. 

Datei > Kommentare 
Öffnet das Fenster „Kommentare“ 

Datei > Vom Stethoskop importieren 
Importiert eine Aufzeichnung aus dem Speicher des Stethoskops. 

Datei > Gespeicherte Aufzeichnungen in das aktuelle Verzeichnis importieren 
Verschiebt zuvor gespeicherte Aufzeichnungs-Dateien von anderen Orten im Computer in das aktuelle 
Aufnahme-Verzeichnis. Das Verschieben von Dateien aus dem aktuellen Verzeichnis verbessert die 
Geschwindigkeit beim Hochfahren des Programms und verringert die Zeitdauer für das Öffnen einer zuvor 
gespeicherten Datei. 

Dateien > Gespeicherte Aufzeichnungen exportieren 
Verschiebt zuvor gespeicherte Aufzeichnungs-Dateien aus dem aktuellen Aufnahme-Verzeichnis an 
andere Orte im Computer. Das Verschieben von Dateien aus dem aktuellen Verzeichnis verbessert die 
Geschwindigkeit beim Hochfahren des Programms und verringert die Zeitdauer für das Öffnen einer zuvor 
gespeicherten Datei. 

Datei > e4k-Datei importieren 
Importiert eine Datei im .e4k Format. Die vorherigen Stethoskope 3M™ Littmann® Modell 4000 und 
Modell 4100 haben das Dateiformat .e4k verwendet. 

Datei > Aufzeichnung  als  .wav  exportieren
Öffnet das Fenster „Export von Dateien“ für das Speichern von Aufzeichnungen im Format .wav. 

Datei > Bericht drucken 
Druckt den „Vorgangsbericht für einen Patienten“ für ein gegebenes Aufzeichnungs-Set aus. 

Datei > Kürzlich  angesehen
Öffnet ein kürzlich angesehenes Aufzeichnungs-Set. 

Datei > Beenden 
Beendet die StethAssist-Anwendung. 

6.2 Tools 
Tools > Neues  Stethoskop  hinzufügen
Öffnet das Fenster „Neues Stethoskop hinzufügen“. 

Tools > Stethoskop-Einstellungen
Öffnet das Fenster „Stethoskop-Einstellungen“ - hier können Sie: 

• Ein gepaartes Stethoskop löschen. 
• Den Namen eines Stethoskops ändern. 
•  Die Länge  der  Vorlaufzeit (Wartezeitraum),  bevor  die StethAssist-Software nach  dem  Drücken  der  

Schaltfläche „M“ mit einer Aufzeichnung beginnt, einstellen. Vorlaufzeit-Optionen: 0, 1, 2 oder 
4 Sekunden. 

• Wählen Sie die Standard-Körperhaltung aus. 
• Wählen Sie die Standard-Länge einer Aufzeichnungen aus. 
• Wählen Sie die Standard-Ansicht aus (Überblicks-Ansicht oder Detail-Ansicht). 

Tools > Optionen
Ändert das Standard-Verzeichnis, in dem die Aufzeichnungen abgespeichert werden und/oder ändert 
die Standard-Sprache. 

6.3 Ansicht 
Wählt zwischen Übersicht- und Detail-Ansicht aus. 
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6.4 Hilfe 
Hilfe > Online-Hilfe 
Öffnet einen Intern-Browser mit der StethAssist-Webseite unter www.littmann.com/StethAssist. 

Hilfe > Benutzerhandbuch 
Öffnet das Benutzerhandbuch der Software. 

Hilfe  >  Informationen  zu  den  Littmann® Produkten 
Öffnet einen Internet-Browser mit der Seite Littmann.com. 

Hilfe > Über 
Zeigt die Versionsnummer des Produkts zusammen mit den Telefonnummern und Adressen für weitere 
Informationen oder Kundendientsanfragen an. 

Hilfe > Überprüfung auf neueste Version
Überprüft, ob es eine neuere Version von StethAssist gibt. 

7. Verbessern der Aufzeichnungsqualität 

Die Qualität der Aufzeichnungen ist abhängig vom Umfeld, dem Patienten und der Anwendungstechnik 
des Benutzers: 

Das akustische Umfeld: 
Führen Sie die Auskultationsuntersuchung in möglichst ruhiger Umgebung durch. Achten Sie sorgsam 
auf Hintergrundgeräusche, die zum Beispiel durch offene Fenster dringenden Straßenlärm, Ventilatoren 
oder Klimaanlagen entstehen können, und eliminieren Sie solche Geräusche so gut wie möglich. 
Auch im Hintergrund hörbare Gespräche und Unterbrechungen während der Aufzeichnung sollten 
vermieden werden. 

Der Patient: 
Sofern möglich, sollte der Patienten ordnungsgemäß für die Untersuchung vorbereitet werden, so dass 
das Stethoskop in direkten Kontakt mit der Haut kommt. Bitten Sie den Patienten, sich während der 
Aufzeichnung möglichst wenig zu bewegen. 

Platzierung und Handhabung des Stethoskops: 
Bei Verwendung  des Stethoskops  Littmann® Modell 3200 kann die Anwendung verschiedener Techniken 
zu einer entscheidenden Verbesserung der Auskultationsergebnisse führen. 

Der Schallsensor, mit dem die Töne aufgezeichnet werden, ist relativ klein und befindet sich in der Mitte 
des Bruststücks (zu Demonstrationszwecken können Sie die Membran abziehen und die Vertiefung unter 
dem weißen Aufkleber suchen). Der Bereich rund um den Tonsensor ist unempfindlich für Schallsignale. 
Daher ist es wichtig, dass der Kontakt des Bruststücks mit dem Patienten genau in der Mitte des 
Bruststücks stattfindet. 

Bei Verwendung  des Stethoskops  Littmann® Modell 3200 ist bereits leichter Kontakt ausreichend. Dies 
bezieht sich sowohl auf die Handhabung des Stethoskops als auch auf den Kontakt am Patienten. Wird zu 
viel Druck am Patienten ausgeübt, können verzerrte Klangtöne (Artefakte) erzeugt werden. 

Für eine optimale Klangqualität muss der Kontakt mit dem Patienten gleichbleibend sein. Bewegungen des 
Bruststücks führen zu Reibungsgeräuschen. 

Die besten Ergebnisse erzielen Sie, wenn Sie die Auskultation mit relativ geringer Verstärkung beginnen. 
Wenn Sie Schwierigkeiten haben, die Töne zu hören, können Sie die Stufe der Verstärkung erhöhen. 
Das Einschalten der Verstärkung je nach Bedarf ist eine zusätzliche Möglichkeit, Hintergrundgeräusche 
während der Untersuchung so weit wie möglich zu verringern. 

Abschließend ist zu beachten, dass für die Verwendung eines elektronischen Stethoskops eine andere 
Technik eingesetzt wird als bei Verwendung eines herkömmlichen Stethoskops. Halten Sie das Stethoskop 
Littmann® Modell 3200 locker in der Hand und legen Sie es sanft auf der Haut des Patienten auf. Achten 
Sie dabei darauf, dass sich der Kontaktpunkt in der Mitte des Bruststücks befindet und halten Sie das Gerät 
möglichst ruhig, um die bestmögliche Qualität der Auskultation zu gewährleisten. 
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8. Problemsuche und ‑behebung 

Problem 

Es kann keine 
Verbindung 
zum Stethoskop 
hergestellt werden. 

Mögliche Ursache 

Kein USB Bluetooth Wireless 
Adapter eingerichtet bzw. Adapter 
nicht ordnungsgemäß eingerichtet 

Lösung 

Stecken Sie den USB Bluetooth Wireless 
Adapter am Computer ein. Deaktivieren Sie das 
Bluetooth-Radio des Computers. Aktualisieren 
Sie den Bluetooth-Treiber. Ersetzen Sie ihn durch 
den Generischen Bluetooth-Treiber. 

Stethoskop nicht gepaart Paaren des Stethoskops Wählen Sie aus dem 
Tools-Menü im Hauptbildschirm „Neues 
Stethoskop hinzufügen“ aus 

Jede eindeutige Stethoskop-ID 
kann  nur  einen  einzigen  Stethoskop  
zugewiesen sein. 

Wird in Ihrer Praxis mehr als ein Stethoskop 
eingesetzt, müssen Sie darauf achten, sich mit 
der richtigen Stethoskop-ID zu verbinden. 

Unbestimmt Schalten Sie das Stethoskop aus, warten Sie 
einige Sekunden und schalten Sie das Stethoskop 
wieder ein. 

Verrauschtes 
Aufzeichnungssignal 

Übermäßige 
Hintergrundsgeräusche 

Reduzieren Sie Hintergrundgeräusche im Umfeld 
der Auskultation. 

Das in der grafischen 
Darstellung gezeigte 
Signal ist beschnitten 

Verrauschte Aufzeichnung Siehe Abschnitt 7 dieses Benutzerhandbuchs 
mit dem Titel „Verbessern 
der Aufzeichnungsqualität”. 

Meldung Schlechte 
Datenqualität 

Übermäßige 
Hintergrundsgeräusche 

Reduzieren Sie Hintergrundgeräusche im Umfeld 
der Auskultation. 

Starke Stethoskopbewegungen Halten Sie das Stethoskop während der 
Aufzeichnung mit ruhiger Hand und drücken Sie 
es  leicht auf  die Körperoberfläche des  Patienten.  

Bei weiteren Fragen zur Software 3M™ Littmann® StethAssist™ oder dem Stethoskop Littmann® 

Modell 3200 besuchen Sie bitte die 3M™ Littmann® Stethoskop Internetseite Ihres Landes unter 
www.Littmann.com, konsultieren Sie den Abschnitt Häufig gestellte Fragen (FAQ) oder klicken Sie 
auf Kontakt 3M für weitere Kontaktmöglichkeiten. 

3M Health Care 
Littmann® Markenprodukte 
3M Center, Building 275-4E-01 
2510 Conway Ave. 
St. Paul, MN 55144 
1-800-228-3957 
www.littmann.com 

3M, Littmann und StethAssist sind eingetragene Markenzeichen von 3M, die in Kanada unter Lizenz verwendet 
werden.  Windows  ist eine  eingetragene Marke der  Microsoft Corp.  Bluetooth  ist eine eingetragene Marke der  
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1. Dati generali 

1.1 Indicazioni per l’uso 
Il  software  per  la  visualizzazione  dei  rumori  cardiaci  e  polmonari  3M™  Littmann® StethAssist™ è 
progettato per essere utilizzato con lo stetoscopio elettronico 3M™ Littmann® modello 3200 per la 
registrazione  e  visualizzazione  dei rumori cardiaci e  di altri segnali acustici fisiologici.  Il  dispositivo  è  
destinato esclusivamente a essere utilizzato in ambito clinico. Non è inteso come mezzo diagnostico. Il 
prodotto non riporta alcuna analisi o esito clinico. 

1.2 Informazioni sulla sicurezza 

Consultare le istruzioni per l’uso 

Prima di utilizzare questo software, leggere attentamente e seguire tutte le informazioni sulla sicurezza 
contenute nelle presenti istruzioni. Conservare le presenti istruzioni per consultarle in futuro. 

Le indicazioni di ATTENZIONE o le NOTE utilizzate in questo manuale d’uso sono racchiuse in una cornice 
e hanno i seguenti significati. 

ATTENZIONE: indica una situazione nella quale il software può presentare all’utente informazioni 
incomplete o sbagliate. 

NOTA: informazione considerata importante ed enfatizzata. 

1.3 Specifiche e requisiti del sistema 
Requisiti del computer 

• Windows 7 32 bit, Windows 7 64 bit, Windows 8 32 bit, Windows 8 64 bit, Windows 10 32 bit, 
Windows 10 64 bit. 

• Mac  OS  10.12  
• 1024 MB di RAM o superiore 
• Processore compatibile con Intel Core 2 Duo o versioni successive 
• Display grafico con risoluzione pari a 1024 x 768 o superiore 
• Porta USB 1.1 o superiore per supportare l’adattatore wireless Bluetooth USB 

1.4 Protezione dei dati personali del paziente 
La  riservatezza  e  la  protezione  di alcune  informazioni cliniche  contenenti dati identificativi personali sono  
garantite da leggi statali e federali USA, internazionali e/o di altri Paesi, che regolano e limitano l’uso, la 
divulgazione,  la  memorizzazione e la  trasmissione di  tali  informazioni.  In  alcuni  casi, è  vietato  l’accesso  a  
tali informazioni a terzi senza una previa autorizzazione scritta. 

Spetta unicamente all’utente la responsabilità di individuare, comprendere e conformarsi a tutte le 
eventuali  leggi  che interessano  le modalità  di  memorizzazione e trasmissione di  informazioni  cliniche  
contenenti dati identificativi personali usate con il software. Qualora si determini l’impossibilità di 
rispettare una legge o limitazione riguardante l’uso e la divulgazione (compresa la trasmissione) di 
informazioni cliniche  contenenti dati identificativi personali tramite  il  software,  è  indispensabile  non  salvare  
tali informazioni. La memorizzazione delle informazioni implica l’assunzione di tutti i rischi, responsabilità e 
obblighi associati all’uso, alla memorizzazione e/o alla trasmissione di tali informazioni, compresi eventuali 
file audio, record elettronici o di altro tipo. 

Per il funzionamento di questo programma non è obbligatorio l’inserimento di informazioni cliniche 
contenenti dati identificativi personali. I vari record  possono  essere  memorizzati  e  richiamati  tramite  la  
ricerca data/ora o con un identificatore assegnato casualmente. L’utente che decide di inserire un Nome 
paziente o ID paziente significativo si assume tutti i rischi e le responsabilità derivanti dalla trasmissione 
e memorizzazione di informazioni cliniche contenenti dati identificativi personali tramite il software, 
compresi i rischi connessi alla riservatezza e alla sicurezza di tali informazioni. 
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2. Guida introduttiva 

2.1 Installazione e registrazione del software 3M™ Littmann® StethAssist™ 
Per installare il software 3M™ Littmann® StethAssist™ sul computer, seguire questa procedura. 

1. Andare all’indirizzo www.Littmann.com/StethAssist 
2. Fare clic sul collegamento Download StethAssist 
3. Fare clic su Run (Esegui) nella finestra dei messaggi visualizzata 
4. Seguire le istruzioni per l’installazione 
5. Completare la registrazione online 

NOTA:  per completare la registrazione offline, contattare l’assistenza 
tecnica 3M™ Littmann® al numero 1-800-228-3957 o all’indirizzo 

littmannsoftwaresupport@mmm.com. 

2.2 Inserimento dell’adattatore wireless Bluetooth USB (dongle) 
Per installare l’adattatore wireless Bluetooth USB, inserire il dispositivo in una porta USB del computer. 
L’adattatore wireless  Bluetooth  USB  consente la  comunicazione tra  il  computer  sul  quale è installato  il  
software e lo stetoscopio elettronico 3M™ Littmann® modello 3200. L’adattatore wireless Bluetooth 
USB  riceve  e  trasmette  dati  tramite  lo  standard  di  connettività  wireless  Bluetooth®  a corta portata 
comunemente accettato. 

Per il collegamento a uno stetoscopio, l’adattatore wireless Bluetooth USB deve essere inserito nel 
computer prima del lancio del software 3M™ Littmann® StethAssist™. Se l’adattatore wireless  Bluetooth  
USB non viene rilevato dal software, compare il messaggio mostrato di seguito. In tal caso, inserire 
l’adattatore wireless Bluetooth USB, quindi chiudere e lanciare nuovamente il software StethAssist. 
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2.3 Associazione e collegamento dello stetoscopio al software 
La schermata seguente fornisce assistenza nell’associazione e/o nel collegamento di uno stetoscopio 
al software. 

2.3.1 Associazione di un nuovo stetoscopio 

Per collegare  per la prima volta uno  stetoscopio  Littmann® modello 3200 al software 
3M™ Littmann® StethAssist™, è necessario innanzitutto associare lo stetoscopio al software. 
Per associare un nuovo stetoscopio, selezionare “Add New Stethoscope” (Aggiungi nuovo 
stetoscopio) dal menu a discesa e fare clic su Pair (Associa) [in alternativa, selezionare Add New 
Stethoscope (Aggiungi nuovo stetoscopio) dal menu Tools (Strumenti) nella schermata principale]. 
Seguire le istruzioni sullo schermo. Dopo l’associazione dello stetoscopio, il software vi si collega 
automaticamente. Ai lanci successivi del software, basterà semplicemente eseguire la connessione 
allo stetoscopio. 

2.3.2 Collegamento dello stetoscopio 

Per eseguire il collegamento a uno stetoscopio precedentemente associato, selezionarne il nome 
dal menu a discesa e fare clic su Connect (Collega). Sullo stetoscopio, premere il pulsante (M) due 
volte  per  selezionare  “CONNECT”  (COLLEGA).  La schermata sottostante  comparirà ogni  volta che  
l’utente tenterà di collegare uno stetoscopio al software. 

Per rivedere le registrazioni senza collegare uno stetoscopio, fare clic su Cancel (Annulla). 

45 Italiano 

PDF Scaled at 100.0% 



Indica lo stetoscopio 
al quale il software sta 
tentando di collegarsi. 

Se lo stetoscopio è collegato, sul pulsante di collegamento dello stetoscopio compare un segno di spunta 

verde . In caso contrario, su tale pulsante compare una X rossa . 

NOTA: seguire questi suggerimenti per ottimizzare i collegamenti wireless 

1. Auscultare il paziente il più vicino possibile all’adattatore wireless USB
2. Evitare  che oggetti o  persone si  interpongano  tra  lo  stetoscopio  e l’adattatore

wireless Bluetooth USB
3. Evitare di coprire con la mano l’intera testina dello stetoscopio (ubicazione

dell’antenna Bluetooth® dello stetoscopio)

NOTA: è possibile associare vari stetoscopi ad ogni copia del software 
3M™ Littmann® StethAssist™, ma è possibile collegare attivamente un solo stetoscopio alla volta. 

Lo stetoscopio può essere collegato attivamente a un solo computer. 
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3. Creazione di una nuova registrazione o importazione delle registrazioni
dallo stetoscopio

Finestra Recording Set‑Up (Impostazione registrazione)

3.1 Creazione di una nuova registrazione 
3.1.1. Per avviare una nuova registrazione, fare clic sul pulsante New Encounter (Nuova interazione). 

Nella finestra Recording Set-Up (Impostazione registrazione), inserire Patient ID (ID paziente) e 
Patient Name (Nome paziente) (facoltativo; per informazioni sulla riservatezza dei dati personali 
dei pazienti, consultare la Sezione 1.4). L’ID paziente può essere formato da qualsiasi combinazione 
di lettere e numeri per un massimo di 20 caratteri. L’ID paziente può contenere soltanto i seguenti 
caratteri: a-z, 0-9, - e _ 

3.1.2. Selezionare la posizione del paziente, la durata e il sito di registrazione. Quindi fare clic su OK. 

3.1.3. Dopo aver ottenuto una buona qualità sonora nel sito del paziente desiderato, premere il pulsante 
(M) sullo stetoscopio per avviare la registrazione. 

3.1.4. Per riavviare la registrazione, premere una volta il pulsante (M) sullo stetoscopio per fermare la 
registrazione, quindi premerlo di nuovo per riprendere la registrazione. 

3.1.5. Al completamento della registrazione, è possibile effettuarne un’altra con lo stesso paziente 
facendo clic sul pulsante “Add Recording” (Aggiungi registrazione). Per eseguire la registrazione 
su un altro paziente, selezionare il pulsante “New Encounter” (Nuova interazione). Il software 
3M™ Littmann® StethAssist™ chiederà automaticamente se si desidera salvare il gruppo di 
registrazioni corrente. 
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registrazione dall’elenco a 
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un’immagine diversa, fare clic su 
un’altra miniatura. 

Selezionare la durata della
registrazione (5-60 secondi)

Immettere i dati del paziente
(facoltativo)



3.1.6.  Fare  clic  sulla  visualizzazione  Summary  (Riassuntiva)  per  immettere  i  commenti  relativi  al
paziente (facoltativo) 

NOTA: il livello del volume dello stetoscopio non ha alcun effetto sul livello del volume delle 
registrazioni. Inoltre, le registrazioni possono essere riprodotte secondo tutte le tre impostazioni 

del filtro [Bell (Campana), Diaphragm (Diaframma), Extended Range (Portata estesa)], 
indipendentemente  da quella utilizzata durante  la registrazione.  

3.2 Importazione di registrazioni dalla memoria dello stetoscopio 
Per trasferire registrazioni memorizzate dalla memoria integrata dello stetoscopio Littmann® modello 
3200 al software, fare clic su pulsante Import (Importa) o selezionare Import From Stethoscope (Importa 
da stetoscopio) dal menu File. Attenersi ai passaggi descritti di seguito. 

1. Selezionare le tracce registrate da importare. 2. Immettere  i dati
del paziente
(facoltativo). 

5. Immettere la posizione
del paziente (facoltativo). 3. Fare  clic  sull’icona di  riproduzione  per

ascoltare il commento della traccia
(se presente). Nota: il commento della
traccia viene riprodotto tramite le
olivette dello stetoscopio.

4. Immettere il sito di registrazione
del paziente (facoltativo).

6. Dopo aver immesso i dati relativi a tutte
le  tracce  registrate,  fare  clic  su  Import
Selected (Importa selezionate).
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4. Revisione delle registrazioni

Visualizzazione Detailed (Dettagliata)

Trascinamento. 
Abilita l’uso 
del cursore 

del mouse per 
trascinare la 

schermata del 
suono a sinistra 

o destra

Selezione 
filtro 

Commento 
traccia 

Eliminazione 
della 

registrazione 

Ripetizione della 
registrazione 

Aggiunta di 
commenti 

Riproduzione 

Apertura 
di un file 

Salvataggio 
del file 

Avvio di 
una nuova 
interazione 

Cambio della 
visualizzazione 

Importazione 
delle 
registrazioni 
dalla memoria 
integrata 

Riproduzione 
della traccia 
a velocità
dimezzata 

Riproduzione 
mediante 
altoparlanti o presa 
audio del computer 

Ridimensionamento 
totale che 
normalizza tutte le 
registrazioni 

Riproduzione 
ciclica 
continua 
della traccia 

Indicatore di 
collegamento 
dello 
stetoscopio 

Visualizzazione del 
fonocardiogramma della 
schermata del suono 

Visualizzazione dello 
spettrogramma della 
schermata del suono 

Panoramica 
a sinistra 

Panoramica 
a destra

Zoom verticale 

Zoom orizzontale 

Aggiunta di una 
registrazione 
all’interazione 
esistente 

4.1 Panoramica e zoom del segnale 
Per ingrandire o ridurre la schermata del suono, selezionare la registrazione facendo clic su di essa, quindi 
utilizzare i pulsanti “+” o “-” relativi allo zoom orizzontale o verticale. L’ingrandimento fornisce maggiori 
dettagli. La riduzione fornisce meno dettagli. Lo zoom verticale, inoltre, aumenta o diminuisce il volume 
della registrazione  poiché  ne  modifica l’ampiezza visiva  e  uditiva.  

Se si ingrandisce con lo zoom orizzontale, è possibile scorrere l’elenco delle registrazioni utilizzando i 
pulsanti della panoramica. Per spostare la registrazione verso sinistra, fare clic sul pulsante di panoramica 
a sinistra. Per spostare la registrazione verso destra, fare clic sul pulsante di panoramica a destra. È inoltre 
possibile spostare la panoramica verso destra o sinistra nelle schermate del suono utilizzando il pulsante di 

trascinamento collocato  sulla barra degli  strumenti.  Fare  clic  su  questo  pulsante  a  forma di  mano  per
spostare  la panoramica verso sinistra o destra in qualsiasi registrazione. Posizionare  il  cursore  del  mouse 
su una schermata del suono, quindi trascinare il cursore nella direzione desiderata. Disattivare questa 

funzione facendo nuovamente clic sul pulsante di trascinamento . 

4.2 Opzione di visualizzazione dello spettrogramma 
Lo spettrogramma è una distribuzione tempo-frequenza presentata come grafico a colori bidimensionale, 
che mostra la distribuzione dell’energia del suono in relazione a tempo e frequenza. Il nero rappresenta 
l’energia minima, mentre il rosso indica l’energia massima. L’asse x rappresenta l’indice di tempo, mentre 
l’asse y rappresenta una gamma lineare di frequenze comprese tra 0 e 500 Hz. Lo spettrogramma 
fornisce un’ulteriore prospettiva sul suono registrato. Per visualizzare una schermata del suono in modalità 

spettrogramma, fare clic sul pulsante dello spettrogramma , che appare a sinistra della schermata 
del suono. Per tornare alla visualizzazione standard e predefinita della schermata del suono, fare clic sul 

pulsante del fonocardiogramma ,  che  appare  a  sinistra della schermata del  suono.
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4.3 Riproduzione di una registrazione 
Per iniziare la riproduzione, premere il pulsante di riproduzione. Un cursore rosso scorrerà lungo la 
schermata del suono in sincronia con la registrazione. Per terminare la riproduzione, fare clic sul pulsante 
di arresto. 

Per impostazione predefinita, il software riproduce la traccia attraverso lo stetoscopio Littmann® modello 
3200 (se collegato). Per riprodurla attraverso altoparlanti del computer, altoparlanti esterni o cuffie, fare 
clic sulla casella di controllo Play to Headphones (Riproduci attraverso le cuffie). 

ATTENZIONE:  la  qualità  audio  dei suoni riprodotti attraverso  gli  altoparlanti del  computer  o  
la presa audio  del  computer può  non  essere  una riproduzione  fedele  dei  suoni  reali  a  causa  

delle prestazioni acustiche della  scheda  audio del computer, dei driver  della  scheda  audio e/o 
della risposta di frequenza delle cuffie/degli altoparlanti. Di conseguenza, potrebbe non essere 

possibile udire suoni clinicamente rilevanti. Si raccomanda vivamente di utilizzare uno stetoscopio 
3M™ Littmann® modello 3200 per ascoltare i suoni registrati. 

NOTA:  l’ampiezza o il volume dei suoni registrati può essere inferiore rispetto a quanto ascoltato 
durante  la  registrazione iniziale.  Utilizzare il  pulsante “+”  sull’asse verticale del grafico  della  forma  

d’onda o sul tastierino dello stetoscopio per aumentare il volume. 

4.4 ½ Speed (Velocità dimezzata) 
L’opzione ½  Speed  (Velocità  dimezzata)  consente  di  riprodurre  le  registrazioni a velocità  dimezzata  
senza cambiamenti significativi nelle proprietà spettrali del segnale. Fare clic sulla casella di controllo ½ 
Speed (Velocità dimezzata), quindi sul pulsante di riproduzione per riprodurre la registrazione a velocità 
dimezzata. Una volta selezionata, la casella di controllo ½ Speed (Velocità dimezzata) rimane attiva fino a 
che non viene deselezionata. 

ATTENZIONE:  l’opzione ½ Speed (Velocità dimezzata) contribuisce a identificare eventi 
fisiologici, ma non deve essere utilizzata da sola per elaborare una diagnosi fisiologica. 

4.5 Riproduzione di una porzione specifica di una registrazione 
Per riprodurre  una porzione  specifica di  una registrazione,  fare  clic  con  il  mouse  sull’area della schermata  
del suono dalla quale si desidera iniziare la riproduzione e trascinare il mouse verso destra per evidenziare 
l’area di interesse. Dopo aver evidenziato in questo modo un’area della schermata del suono, fare clic sul 
pulsante di  riproduzione per  ascoltare la  sezione in  questione.  Notare che  è necessario  selezionare un  
segmento di suono di almeno un secondo per attivare questa funzione. Deselezionare l’area evidenziata 
facendo clic con il pulsante sinistro del mouse in un punto qualsiasi della schermata del suono. 

4.6 Riproduzione ciclica 
La casella di controllo Loop (Riproduzione ciclica), che appare nella parte superiore dello schermo, 
consente all’utente di riprodurre un’intera registrazione, o una porzione specifica di una registrazione, 
in modo ciclico fino a che non si fa clic sul pulsante di arresto. Per riprodurre un’intera registrazione in 
modalità ciclica, selezionare la schermata del suono corrispondente facendo clic su di essa, fare clic nella 
casella di controllo Loop (Riproduzione ciclica), quindi fare clic sul pulsante di riproduzione. Per riprodurre 
una porzione specifica di una registrazione in modalità ciclica, utilizzare il cursore per evidenziare l’area di 
interesse su una schermata del suono, fare clic sulla casella di controllo Loop (Riproduzione ciclica), quindi 
fare clic sul pulsante di riproduzione. Una volta selezionata, la casella di controllo Loop (Riproduzione 
ciclica) rimane attiva fino a che non viene deselezionata. 

4.7 Ridimensionamento totale 
La funzione di ridimensionamento totale normalizza tutte le registrazioni contenute in un unico gruppo di 
registrazioni. Questo consente all’utente di confrontare in modo accurato le ampiezze di varie registrazioni. 
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4.8 Funzionalità di stampa 
Per stampare  una copia della  Relazione  interazioni  paziente  per una  data registrazione  o  gruppo  di  
registrazioni, fare clic sul pulsante Print (Stampa). La stampata risultante contiene l’ID del paziente, il nome 
del paziente (se inserito) e l’ID dello stetoscopio utilizzato per le registrazioni. La relazione contiene anche 
la descrizione della posizione, l’indicazione del sito di auscultazione e della durata delle registrazioni in 
questione, oltre a eventuali commenti relativi all’utente, se inseriti. 

4.9 Aggiunta di commenti a una registrazione 
Mentre ci si trova nella visualizzazione “Detailed” (Dettagliata), è possibile aggiungere commenti al file 
del suono passando alla visualizzazione Summary (Riassuntiva) o facendo clic sul pulsante dei commenti a 
sinistra di Patient ID (ID paziente). Un segno di spunta verde sul pulsante dei commenti indica che esistono 
commenti relativi alle registrazioni. 

5. Salvataggio, apertura ed esportazione delle registrazioni 

52.1 Salvataggio delle registrazioni 
Fare  clic  sul  pulsante di  salvataggio nell’angolo superiore  sinistro della  schermata  o  selezionare  Save  
(Salva) dal menu File. Il software StethAssist chiederà automaticamente di memorizzare le registrazioni 
quando si avvia una nuova registrazione o si esce dal programma. 

5.2 Apertura di un file sonoro precedentemente registrato 
Fare clic  sul  pulsante di  apertura  nell’angolo  superiore sinistro  della  schermata  o  selezionare Open  (Apri)  
dal menu File. Fare clic sull’intestazione per ordinare in base al campo specifico. 

5.3 Esportazione delle registrazioni in un file .wav 
Per esportare una registrazione in un file formato .wav, selezionare Export recording as .wav (Esporta 
registrazione in formato .wav) dal menu File. Il formato .wav è piuttosto comune e può essere riprodotto 
utilizzando gran parte dei lettori multimediali su computer. Assicurarsi di selezionare il filtro applicato alla 
registrazione,  ossia  Bell  (Campana),  Diaphragm  (Diaframma)  o  Extended  (Estesa).  

6. Esplorazione dei menu 
Il software 3M™ Littmann® StethAssist™ presenta le seguenti selezioni: 
File Tools (Strumenti) View (Visualizzazione) Help (Guida) 

6.1 File 
File  >  Save  (Salva)  
Consente di  salvare il  set di  registrazioni  corrente.  

File  >  Open  (Apri)  
Consente di  aprire un  set di  registrazioni  precedente.  

File  >  Close  (Chiudi)  
Consente di  chiudere il  set di  registrazioni  corrente.  

File  >  New  Encounter  (Nuova  interazione)  
Consente di  avviare la  registrazione di  un  nuovo  paziente.  

File  >  Comments  (Commenti)  
Consente di aprire la finestra dei commenti. 

File > Import From Stethoscope (Importa da stetoscopio) 
Consente di importare una registrazione dalla memoria integrata dello stetoscopio. 

File > Import Saved Recording(s) to Current Directory (Importa nella directory corrente le 
registrazioni salvate) 
Consente  di  trasferire  i  file  delle  registrazioni  salvati  in  precedenza  da  un’altra  destinazione  sul  computer  
alla directory di registrazione corrente. Lo spostamento dei file dalla directory corrente consente di 
migliorare la velocità di avvio del programma e di ridurre il tempo necessario per l’apertura di un file 
precedentemente salvato. 
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File > Export Saved Recording(s) (Esporta registrazioni salvate) 
Consente di trasferire i file delle registrazioni salvati in precedenza dalla directory di registrazione 
corrente a un’altra destinazione sul computer. Lo spostamento dei file dalla directory corrente consente 
di migliorare la velocità di avvio del programma e di ridurre il tempo necessario per l’apertura di un file 
precedentemente salvato. 

File > Import e4k File (Importa file e4k) 
Consente di importare un file in formato .e4k. Il formato .e4k era utilizzato nelle versioni precedenti dello 
stetoscopio elettronico 3M™ Littmann®,  ossia  i  modelli 4000 e  4100.  

File > Export recording as .wav (Esporta registrazione in formato .wav) 
Consente di aprire la finestra File Export (Esportazione file) per salvare la registrazione in formato .wav. 

File  >  Print  Report  (Stampa  relazione)  
Consente di stampare la Relazione interazioni paziente per un dato gruppo di registrazioni. 

File > Recently Viewed (Visualizzato di recente) 
Consente  di aprire  un  gruppo  di registrazioni visualizzato  di  recente.  

File  >  Exit  (Esci)  
Consente di uscire dall’applicazione StethAssist. 

6.2 Tools (Strumenti) 
Tools > Add New Stethoscope (Strumenti > Aggiungi nuovo stetoscopio) 
Consente  di aprire  la  finestra  di aggiunta  di un  nuovo  stetoscopio.  

Tools > Stethoscope  Settings  (Strumenti > Impostazioni  stetoscopio)  
Consente di  aprire la  finestra  delle impostazioni  dello  stetoscopio,  dalla  quale è possibile  eseguire le  
azioni seguenti. 

• Eliminare uno stetoscopio associato. 
• Cambiare il nome dello stetoscopio. 
• Regolare la durata del “tempo di attesa” tra la pressione del pulsante (M) sullo stetoscopio e 

l’avvio della registrazione da parte del software StethAssist™. Opzioni del tempo di attesa: 0, 1, 2 o 
4 secondi. 

• Selezionare la posizione del paziente predefinita. 
•  Selezionare  la durata predefinita della  registrazione.  
• Selezionare la visualizzazione predefinita (riassuntiva o dettagliata). 

Tools > Options  (Strumenti  >  Opzioni)  
Consente di cambiare la directory predefinita per il salvataggio delle registrazioni e/o la lingua predefinita. 

6.3 View (Visualizzazione) 
Consente di selezionare la visualizzazione Detailed (Dettagliata) o Summary (Riassuntiva) 

6.4 Help (Guida) 
Help > Online Help (Guida > Guida online) 
Consente di  aprire un  browser  Internet e di  collegarsi  alla  pagina  Web  di  StethAssist all’indirizzo  
www.littmann.com/StethAssist 

Help > User Manual (Guida > Manuale d’uso) 
Consente di  aprire il  manuale d’uso  del  software.  

Help > Learn About Littmann® Products (Guida > Maggiori informazioni sui prodotti Littmann®) 
Consente di  aprire un  browser  Internet e di  collegarsi  a  Littmann.com 

Help > About (Guida > Informazioni) 
Consente  di  visualizzare  il  numero  di  versione  del  prodotto  unitamente  ai  numeri  di  telefono  e  agli  indirizzi  
per richiedere ulteriori informazioni o assistenza. 

Help > Check for Latest Version (Guida > Cerca ultima versione) 
Consente di visualizzare le versioni più recenti di StethAssist. 
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7. Miglioramento della qualità della registrazione 

La qualità delle registrazioni dipende dall’ambiente, dal paziente e dalle tecniche utilizzate. 

Ambiente acustico 
Eseguire la procedura di auscultazione in un ambiente il più silenzioso possibile. Ascoltare attentamente e 
verificare  che non  vi  siano  rumori  di  sottofondo,  come rumore di  traffico  proveniente  dalle finestre aperte  
o di ventole e condizionatori, ed eliminarli per quanto possibile. Verificare che nessuno parli ed evitare 
interruzioni durante la registrazione. 

Paziente 
Se possibile, il paziente dovrà essere adeguatamente preparato in modo che lo stetoscopio si trovi a diretto 
contatto con la pelle. Chiedere al paziente di rimanere fermo durante la registrazione. 

Posizionamento e manipolazione dello stetoscopio 
Quando si utilizza lo stetoscopio Littmann® modello  3200, è  importante  considerare varie tecniche che  
consentono di migliorare notevolmente la qualità dell’auscultazione. 

Il sensore acustico, responsabile di tutte le acquisizioni acustiche, è di dimensioni ridotte ed è situato nella 
parte centrale della testina (a scopo dimostrativo, è possibile rimuovere il diaframma e cercare la tacca 
al di sotto dell’adesivo bianco). L’area in prossimità del sensore acustico non è utile per l’acquisizione 
acustica. Pertanto, è importante concentrare il punto di contatto con il paziente sulla parte centrale 
della testina. 

Con lo stetoscopio Littmann® modello 3200 è sufficiente un contatto leggero. Ciò vale sia per la 
manipolazione dello stetoscopio sia per il contatto con il paziente. Una pressione eccessiva sul paziente 
può generare suoni artefatti. 

Per ottenere una qualità acustica ottimale, il contatto con il paziente deve essere saldo e costante. Il 
movimento della testina comporta rumori di attrito. 

La prassi migliore è iniziare l’esame auscultatorio a un livello di amplificazione ridotto. Quindi, se i suoni non 
vengono percepiti chiaramente, regolare l’amplificazione verso l’alto. Utilizzando l’amplificazione al livello 
base, è possibile ridurre i rumori di disturbo durante l’esame. 

Infine, è importante tener conto della differenza di tecniche tra gli stetoscopi elettronici e quelli non 
elettronici. Afferrando delicatamente lo stetoscopio Littmann® modello 3200, posizionandolo sulla pelle 
del paziente con un contatto leggero, concentrando il punto di contatto sulla parte centrale della testina e 
restando fermi, è possibile ottenere un’auscultazione della massima qualità acustica. 

53 Italiano 

PDF Scaled at 100.0% 



8. Risoluzione dei problemi 

Problema 

Impossibile 
collegare lo 
stetoscopio 

Possibile causa 

Adattatore wireless Bluetooth USB 
non istallato/Adattatore wireless 
Bluetooth USB non installato 
correttamente 

Soluzione 

Inserire l’adattatore wireless Bluetooth USB. 
Disabilitare il dispositivo radio Bluetooth interno 
del computer. 
Aggiornare il driver Bluetooth all’adattatore 
Bluetooth generico. 

Stetoscopio non associato Associare lo stetoscopio. Selezionare 
Add New Stethoscope (Aggiungi nuovo 
stetoscopio) dal menu Tools (Strumenti) nella 
schermata principale. 

Ciascun Stethoscope ID 
(ID stetoscopio) unico può 
rappresentare solo uno stetoscopio 

Se nell’ufficio sono presenti diversi stetoscopi, 
verificare che il collegamento avvenga con l’ID 
dello stetoscopio corretto. 

Non determinata Spegnere lo stetoscopio, attendere alcuni 
secondi, quindi riaccenderlo e riprovare. 

Segnale 
registrato 
disturbato 

Rumore di sottofondo eccessivo Ridurre il più possibile i rumori di sottofondo 
nell’ambiente in cui si esegue l’auscultazione. 

Il segnale 
visualizzato 
nel tracciato è 
tagliato 

Registrazione disturbata Consultare la Sezione 7 di questo manuale 
intitolata “Miglioramento della qualità 
della registrazione”. 

Qualità dei dati 
scadente 

Rumore di sottofondo eccessivo Ridurre il più possibile i rumori di sottofondo 
nell’ambiente in cui si esegue l’auscultazione. 

Movimento eccessivo dello 
stetoscopio 

Durante la registrazione, afferrare saldamente lo 
stetoscopio, premendo delicatamente sulla pelle 
del paziente. 

Per domande o problemi relativi al software 3M™ Littmann® StethAssist™ o allo stetoscopio Littmann® 

modello 3200, contattare l’assistenza clienti al numero 1-800-228-3957 oppure consultare le FAQ e 
la pagina dedicata ai contatti sul sito Web dello stetoscopio 3M™ Littmann® relativo al proprio Paese, 
raggiungibile dall’indirizzo www.Littmann.com. 

3M Health Care 
Prodotti a marchio Littmann® 

3M Center, Building 275-4E-01 
2510 Conway Ave. 
St. Paul, MN 55144 
1-800-228-3957 
www.littmann.com 

3M, Littmann e StethAssist sono marchi registrati di 3M, utilizzati su licenza in Canada. Windows è un marchio 
registrato di Microsoft. Bluetooth è un marchio registrato di Bluetooth SIG, Inc. Mac è un marchio registrato di 
Apple Inc. 

© 2017 3M. Tutti i diritti riservati. 

34-8721-7685-3 
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1. Información general 

1.1 Modo de empleo 
El software para la visualización de los sonidos del corazón y los pulmones 3M™ Littmann® StethAssist™ 
está diseñado para utilizarse con el estetoscopio electrónico 3M™ Littmann® modelo 3200 para la 
grabación y visualización de los sonidos del corazón y otras señales fisiológicas acústicas. El aparato está 
diseñado para ser utilizado en la consulta de un médico. No fue diseñado como medio de diagnóstico. Este 
producto no presenta resultados clínicos o análisis. 

1.2 Información de seguridad 

Consulte las instrucciones de uso 

Lea, comprenda y siga la información de seguridad que se incluye en estas instrucciones antes de utilizar 
este software. Conserve estas instrucciones para futuras referencias. 

En  este  manual  del  usuario,  se  utilizará  una  PRECAUCIÓN  o  NOTA  remarcada  con  un  cuadro,  con  los  
siguientes significados: 

PRECAUCIÓN:  Indica una situación  en  la que  el  software  puede  presentar información  inexacta o  
incompleta para el usuario. 

NOTA: Información que se considera importante enfatizar. 

1.3 Requisitos del sistema y especificaciones 

Requisitos del ordenador: 

• Windows 7 32-bit, Windows 7 64-bit, Windows 8 32-bit, Windows 8 64-bit, Windows 10 32-bit, 
Windows 10 64-bit. 

• Mac  OS  10.12  
• 1024 MB de RAM o superior 
• Compatible con Intel Core 2 Duo o posterior 
• Resolución de presentación gráfica de 1024 x 768 o mejor 
• Puerto USB 1.1 o superior que admita un Bluetooth USB 

1.4 Privacidad del paciente 

La privacidad y seguridad de cierta información relativa a la salud individualmente identificable, puede 
estar protegida por las leyes estatales, federales, internacionales y/o extranjeras, que regulen y restrinjan 
la forma en  que  dicha información  pueda ser utilizada,  revelada,  almacenada  y  transmitida.  En  algunos  
casos, se le puede incluso prohibir que permita que cualquier tercera parte acceda a dicha información sin 
obtener autorización  previa por escrito  para  ello.  

Usted es exclusiva y completamente responsable de determinar, comprender y cumplir con todas las 
leyes  que  afecten  la forma en  que  se  debe  almacenar  y  transmitir cualquier información  electrónica  
individualmente identificable relacionada con la salud mediante el uso del software. Si estima que no 
puede cumplir una ley o restricción que se aplique a su uso y divulgación (incluyendo la transmisión) de 
información relacionada individualmente identificable con la salud mediante el software, entonces no debe 
continuar con el proceso para guardar dicha información. Si procede y guarda la información, asume todos 
los riesgos y responsabilidades civiles asociadas con el uso, el almacenamiento o la transmisión de dicha 
información, incluyendo los archivos de sonido, electrónicos o de cualquier otra índole. 

Este programa  no  requiere que introduzca  información  individualmente identificable relacionada  con  la  
salud para poder funcionar. Los registros se pueden almacenar y recuperar mediante el uso de un registro 
de  hora  o  un  identificador  asignado  arbitrariamente.  Si  opta  por  introducir  el  nombre  del  paciente  o  un  
identificador significativo del paciente, entonces acepta asumir todos los riesgos y responsabilidades 
civiles en los que se incurra por la transmisión y el almacenamiento de dicha información individualmente 
identificable relacionada con la salud mediante el software, incluyendo los riesgos relativos a la privacidad 
y seguridad de dicha información individualmente identificable relacionada con la salud. 
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2. Primeros pasos 

2.1 Instalación y registro del software 3M™ Littmann® StethAssist™ 
Siga estos pasos para instalar el software 3M™ Littmann® StethAssist™ en su ordenador: 

1. Visite www.Littmann.com/StethAssist 
2. Haga clic en el enlace “Download StethAssist” (Descargar StethAssist) 
3. Haga clic en “Run” (Ejecutar) del cuadro de mensajes que aparece 
4. Siga las instrucciones de instalación 
5. Complete el registro online 

NOTA: Para completar el registro en modo desconectado, póngase 
en  contacto  con  Asistencia  al  Cliente  llamando  al  1-800-228-3957  

o visite littmannsoftwaresupport@mmm.com. 

2.2 Inserte el Bluetooth USB (transceptor) 
Para  instalar  el  Bluetooth  USB,  inserte  el  dispositivo  en  el  puerto  USB  del  ordenador.  El  Bluetooth  USB  
permite la comunicación entre el ordenador en el que se instala el software y el estetoscopio electrónico 
3M™ Littmann® modelo 3200. El transceptor inalámbrico Bluetooth para USB recibe y transmite datos a 
través del estándar de conectividad inalámbrica Bluetooth® de corto alcance, habitualmente aceptado. 

Para conectar el estetoscopio, se debe insertar el transceptor inalámbrico Bluetooth para USB en 
el ordenador antes de ejecutar el software 3M™ Littmann® StethAssist™. Si el software no puede 
detectar el Bluetooth USB, aparecerá el siguiente mensaje. Si aparece este mensaje, inserte el transceptor 
inalámbrico Bluetooth para USB, y luego cierre y vuelva a abrir el software StethAssist. 
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2.3 Vinculación y conexión del estetoscopio con el software 
La siguiente pantalla le ayudará a vincular y/o conectar su estetoscopio con el software. 

2.3.1 Vinculación de un estetoscopio nuevo 

Para conectar por primera vez  un  estetoscopio  Littmann® modelo 3200 con el software 
3M™ Littmann® StethAssist™, primero debe vincular el estetoscopio al software. Para vincular un 
estetoscopio nuevo, seleccione “Add New Stethoscope”( Añadir nuevo estetoscopio) del menú 
desplegable y haga clic en “Pair” (Vincular) (o seleccione “Add New Stethoscope” del menú Tools 
[Herramientas] en la pantalla p rincipal). Siga las instrucciones de instalación de la pantalla. Después 
de vincular el estetoscopio, el software se conectará al mismo de forma automática. Cada vez que 
abra el software de aquí en adelante, simplemente conecte el estetoscopio. 

2.3.2 Conexión del estetoscopio 

Para conectar con un estetoscopio vinculado anteriormente, seleccione el nombre del estetoscopio 
del  menú  desplegable  y  haga  clic  en  “Connect”  (Conectar).  En  el  estetoscopio,  presione  el  botón  
(M)  dos  veces  para seleccionar “CONNECT”.  La siguiente  pantalla aparecerá  cada vez  que  intente  
conectar un estetoscopio al software. 

Para revisar las grabaciones sin conectar un estetoscopio, haga clic en “Cancel” (Cancelar). 
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Indica el 
estetoscopio 
con  el cual el  
software intenta 
conectarse. 

Si su estetoscopio está conectado, el botón “Stethoscope Connection” (Conexión del estetoscopio) se 

mostrará con  una tilde  verde .Si no está conectado, el botón “Stethoscope Connection” se mostrará 

con un X roja . 

NOTA: Siga estos consejos para optimizar las conexiones inalámbricas 

1. Ausculte  al  paciente  lo  más  cerca  posible  del  Bluetooth  USB
2. Evite que haya objetos o personas entre el estetoscopio y el Bluetooth USB
3. Evite  cubrir  toda la pieza  torácica con  la mano  (ubicación  de  la antena Bluetooth®

del estetoscopio)

NOTA: Se pueden vincular múltiples estetoscopios al software 3M™ Littmann® StethAssist™, pero 
solo se puede conectar un estetoscopio en modo activo a la vez. El estetoscopio solo se puede 

conectar en modo activo a un ordenador. 
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Seleccione la 
postura del paciente 

Seleccione la longitud 
de la grabación 
(entre 5 y 60  segundos)

Introduzca la 
información 
del paciente (opcional) 

Seleccione  un sitio de  
grabación del menú 
desplegable o haga clic 
en la imagen del torso 
azul para elegir el sitio 
de forma manual. Para 
cambiar a otra imagen, 
haga clic en una vista 
miniatura alternativa. 

3. Como crear una nueva grabación o importar grabación(es) del estetoscopio.

Ventana “Recording Set‑Up” (Configuración de grabación)

3.1 Como crear una nueva grabación 
3.1.1.  Para  comenzar  una  nueva  grabación,  haga  clic  en  el  botón  “New  Encounter”  (Nueva  cita).  En  la

ventana “Recording Set-up” (Configuración de grabación), introduzca el código de identificación 
y el nombre del paciente (opcional, consulte el apartado 1.4 para información confidencial del 
paciente). Los códigos de identificación de pacientes pueden contener una combinación de letras y 
números de hasta 20 caracteres. Solo se permiten el uso de los siguientes caracteres en el código 
de identificación del paciente: a-z, 0-9, -, y _ 

3.1.2. Seleccione la longitud de la grabación, el sitio de grabación y la postura del paciente. Luego haga 
clic en “OK”. 

3.1.3. Obtenga una buena calidad de sonido del sitio deseado del paciente, y luego presione el botón (M) 
en el estetoscopio para comenzar la grabación. 

3.1.4. Para reiniciar la grabación, presione el botón (M) en el estetoscopio para detener la grabación, y 
luego el botón (M) otra vez para reiniciar la grabación. 

3.1.5. Tras completar la grabación, puede realizar otra para el mismo paciente presionando el botón “Add 
Recording” (Añadir grabación). Para realizar una grabación con otro paciente, seleccione el botón 
“New Encounter”. El software 3M™ Littmann® StethAssist™  le  preguntará de  forma automática si
desea guardar el conjunto de grabaciones actuales. 
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3.1.6. Haga clic en “Summary view” (Vista resumida) para ingresar comentarios sobre el 
paciente (opcional). 

NOTA: El nivel de volumen del estetoscopio no afecta el nivel de volumen de 
las grabaciones. Además, las grabaciones se pueden reproducir en las tres 

configuraciones de filtro (campana, diafragma o extendido), independientemente 
de la  configuración  de filtro  que  se utilizó  durante la  grabación.  

3.2 Importar grabaciones desde la memoria del estetoscopio 
Para transferir una o varias grabaciones guardadas desde la memoria incorporada del estetoscopio 
Littmann® modelo  3200  al  software,  haga  clic  en  el  botón  “Import”  (Importar)  o  seleccione  “Import  From
Stethoscope” (Importar desde el estetoscopio) en el menú File (Fichero). Siga los pasos a continuación: 

1. Seleccione la(s) pista(s) grabada(s) para importar 2.  Ingrese  la
información sobre el 
paciente (opcional). 

5. Ingrese la postura del
paciente(opcional).3.  Haga  clic en el  ícono  “Play” (Reproducir)

para escuchar los comentarios de 
la pista (si hubiera). NOTA: Los 
comentarios de la pista se reproducen 
en los auriculares del estetoscopio. 

 

4. Ingrese el sitio de grabación
de paciente (opcional).

Escuche la 
pista grabada 

Elimine la pista (opcional) 
grabada de la 
memoria del 
estetoscopio 
(opcional) 

Bloquee o desbloquee 
la pista grabada  
en la memoria del 
Estetoscopio (opcional) 

6. Después de ingresar la información para
todas las pistas grabadas, haga clic en
“Import Selected” (Importar selección).
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Escuche la
pista grabada
(opcional)

Bloquee o desbloquee
la pista grabada
en la memoria del
Estetoscopio (opcional)

Elimine la pista
grabada de la
memoria del
estetoscopio
(opcional)



4. Revisión de grabaciones

Vista detallada

4.1 Ajuste y amplificación de la señal 
Para aumentar o disminuir el tamaño en un gráfico de sonido, primero seleccione la grabación haciendo 
clic sobre la misma, después utilice los botones de ajuste horizontal o ajuste vertical, “+” o “-”. Las vistas 
ampliadas ofrecen  más detalles.  Las vistas reducidas  ofrecen  menos detalles.  El  ajuste  vertical  también  
aumentará y disminuirá el volumen de la grabación, puesto que afecta a la amplitud visual y auditiva de 
la grabación. 

Si realiza un ajuste horizontal, puede desplazarse a lo largo de la grabación con los botones de ajuste. 
Para mover  la grabación  a  la izquierda,  presione  el  botón  “Pan  Left”  (ajuste  a  la izquierda).  Para mover la
grabación a la derecha, presione el botón “Pan Right” (ajuste a la derecha). También es posible moverse 
con  una  panorámica a la  izquierda y a la  derecha  por  los  gráficos  de sonido utilizando  el  botón  “Drag”  

(Arrastrar) situado en la barra de herramientas. Pulse el botón con forma de mano y podrá desplazarse 
a la derecha  o  a  la izquierda  por las  grabaciones  colocando  el  cursor del  ratón  sobre  un  gráfico  de  sonido
y luego arrastrando el cursor en la dirección en la que desee desplazarse. Para desactivar esta función, 

vuelva a pulsar el botón “Drag” (Arrastrar). 

4.2 Opción de pantalla de espectrograma 
El  espectrograma es  una distribución  en  tiempo-frecuencia presentada  como  un  gráfico  de  color de  
dos dimensiones de la energía del sonido distribuida en tiempo y frecuencia. El color negro representa 
una e nergía m ínima, mientras que el color r ojo significa e nergía m áxima. El eje x representa e l índice de 
tiempo, mientras que el eje y es un rango de frecuencia lineal de 0 – 500 Hz. El espectrograma ofrece una 
perspectiva adicional del sonido grabado. Para ver un gráfico de sonido en modo de espectrograma, haga 

clic  en  el  botón “Spectrogram” (Espectrograma) que aparece a la izquierda del gráfico de sonido. 

Para volver  a  la vista de  gráfico  de  sonido  estándar,  la vista predeterminada,  haga clic  en  el  botón  .
“Phonocardiogram” (Fonocardiograma), que aparece a la izquierda del gráfico. 
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4.3 Como reproducir una grabación 
Presione el botón “Play” (Reproducir) para comenzar la reproducción. Un cursor rojo se desplazará a lo 
largo del gráfico de sonido en sincronía con la grabación. Pulse el botón “Stop”.(Detener) para finalizar 
la reproducción. 

Por defecto,  el  software  reproducirá la pista de  sonido  en  el  estetoscopio  Littmann® modelo 3200 (si 
está c onectado). Para r eproducir l a p ista d e sonido en los altavoces del ordenador, altavoces externos, o 
auriculares, haga clic en la casilla de verificación “Play to Headphones” (Reproducir con auriculares). 

PRECAUCIÓN: Es posible que la calidad auditiva de las grabaciones de sonidos fisiológicos 
reproducidos mediante los altavoces o la toma de audio del ordenador no sea una 

representación precisa de los sonidos reales debido al desempeño acústico de la tarjeta de 
sonido,  los  controles  de la   tarjeta   de sonido y/o  la   respuesta   de frecuencia   de los  auriculares/  

altavoces del ordenador, lo que podría resultar en la imposibilidad de escuchar sonidos que son 
de relevancia clínica. Se recomienda el uso del estetoscopio 3M™ Littmann® modelo 3200 para 

escuchar sonidos grabados. 

NOTA: La amplitud o el volumen de los sonidos grabados puede ser menor que el oído durante 
la grabación inicial. Utilice el botón “+” en el eje vertical del gráfico de onda o en el teclado del 

estetoscopio para aumentar el volumen. 

4.4 Reproducción a la mitad de la velocidad 
La opción “½ Speed” (Mitad de la velocidad) le permite reproducir grabaciones a la mitad de la velocidad 
sin ningún cambio significativo en las propiedades espectrales de la señal. Haga clic en la casilla de 
verificación “½ Speed” (Mitad de la velocidad) y luego pulse el botón “Play” para reproducir la grabación 
a la mitad de la velocidad. Una vez que lo haya pulsado, la casilla de verificación “½ Speed” permanecerá 
activada hasta que se pulse de nuevo. 

PRECAUCIÓN:  La opción  “½  Speed”  se  ofrece  como  ayuda para detectar eventos  fisiológicos,  
pero no debe utilizarse como único medio para realizar un diagnóstico fisiológico. 

4.5 Reproducción de una parte específica de una grabación 
Para reproducir una parte  específica de  una grabación,  simplemente  haga clic  con  el  ratón  en  la zona del  
gráfico  de  sonido  donde  quiera que  la reproducción  comience  y  arrastre  el  ratón  a  la derecha para resaltar  
la zona de  interés.  Una vez  que  la zona del  gráfico  de  sonido  haya  sido  resaltada de  esta forma,  haga clic  en  
el  botón  “Play”  para  escuchar  la  sección  específica.  Tenga  en  cuenta  que  debe  seleccionar  un  segmento  
de sonido de al menos un segundo de duración para que esta función sea posible. Desmarque el resaltado 
de una zona pulsando el botón izquierdo en cualquier sitio del gráfico de sonido. 

4.6 Reproducción continua 
La casilla  de  verificación  “Loop”  (Continua)  que  aparece  en  la parte  superior de  la pantalla le  permite  
reproducir  una grabación  por completo  o  una parte  específica de  una  grabación,  en  un  ciclo  que  
continuará  hasta que  se  presione  el  botón  “Stop”.  Para reproducir una grabación  completa en  modo  
continuo, seleccione el gráfico de sonido pulsando sobre él, luego haga clic en la casilla de verificación 
“Loop”  y  luego  en  el  botón  “Play”.  Para reproducir una parte  específica  de  una grabación  en  modo  
continuo,  use  el  cursor para resaltar la zona de  interés  sobre  un  gráfico  de  sonido,  haga clic  en  la casilla de  
verificación “Loop” y luego presione el botón “Play”. Una vez que lo haya pulsado, la casilla de verificación 
“Loop”  permanecerá activa hasta que  se  pulse  de  nuevo.  

4.7 Escalado uniforme 
La función de escalado uniforme normaliza todas las grabaciones incluidas dentro de un solo grupo de 
grabaciones. Esto le permite al usuario comparar con exactitud las amplitudes de las distintas grabaciones. 

4.8 Función de impresión 
Para imprimir una copia de  “Patient  Encounter Report”  (Informe  de  cita de  paciente)  para una grabación  

64 Español 

PDF Scaled at 100.0% 



dada  o  un  grupo  de  grabaciones,  pulse  el  botón  “Print”  (Imprimir).  La  impresión  resultante  mostrará  el  
código de identidad del paciente, nombre del paciente (si se ha introducido previamente) y la identidad 
del usuario del estetoscopio utilizado para las grabaciones. El informe también contiene un listado de 
la postura, sitio de auscultación y duración temporal de la(s) grabación(es) en cuestión, junto con los 
comentarios del usuario correspondientes que hayan sido introducidos previamente. 

4.9 Cómo añadir comentarios a una grabación 
Mientras  está en  la vista detallada es  posible  añadir comentarios  a  un  archivo  de  sonido  si  cambia  a  la  
vista resumida o si hace clic en el botón “Comments” (Comentarios) que se encuentra a la derecha del 
código de identidad del paciente. Una tilde verde en el botón “Comments” indica que la(s) grabación(es) 
tienen comentarios. 

5. Como guardar, abrir y exportar grabaciones 

5.1 Guardar grabaciones 
Haga clic  en  el  botón  “Save”  (Guardar)  en  la esquina superior izquierda de  la pantalla  o  seleccione  Save  del  
menú  File.  El  software StethAssist le pedirá  de forma  automática  que  guarde la  grabación  si  comienza  una  
nueva grabación o si sale del programa del software. 

5.2 Abra un archivo de sonido grabado previamente 
Haga clic  en  el  botón  “Open”  (Abrir)  en  la esquina superior izquierda de  la pantalla  o  seleccione  “Open”  del  
menú  “File”.  Haga clic  en  la  cabecera para ordenar por ese  campo.  

5.3 Como exportar grabaciones a archivo .wav 
Para exportar una grabación a un formato de archivo .wav, seleccione “Export recording as .wav ” 
(Exportar grabación como .wav) del menú “File”. El formato de archivo .wav es muy común, y se puede 
reproducir en la mayoría de los reproductores de los ordenadores. Asegúrese de seleccionar el filtro que 
se aplica para la grabación, por ej. campana, diafragma o extendido. 

6. Menús de navegación 

El software 3M™ Littmann® StethAssist™ contiene  las siguientes opciones de  menú:  
“File” (Fichero) “Tools” (Herramientas) “View” (Vista) “Help” (Ayuda) 

6.1 “File” (Fichero) 
File > Save (Fichero > Guardar) 
Guarda el conjunto de grabaciones actuales. 

File > Open (Fichero > Abrir) 
Abre un conjunto de grabaciones anteriores. 

File  >  Close  (Fichero  >  Cerrar)  
Cierra el conjunto de grabaciones actuales. 

File > New Encounter (Fichero > Nueva cita) 
Permite iniciar una grabación de un nuevo paciente. 

File > Comments (Fichero > Comentarios) 
Abre la ventana de comentarios. 

File > Import From Stethoscope (Fichero > Importar desde el estetoscopio) 
Importa una grabación desde la memoria incorporada del estetoscopio. 

File > Import Saved Recording(s) to Current Directory (Fichero > Importar grabación(es) al 
directorio actual) 
Transfiere los archivos grabados guardados previamente desde otro lugar del ordenador al directorio 
actual de la grabación. Sacar los archivos del directorio actual mejora la velocidad de inicio del programa y 
reduce el tiempo que toma abrir un archivo guardado previamente. 
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File > Export Saved Recording(s) (Fichero > Exportar grabación(es) guardadas) 
Transfiere  los  archivos  grabados  guardados  previamente  desde  el  directorio  actual  de  la  grabación  a  otro  
lugar del ordenador. Sacar los archivos del directorio actual mejora la velocidad de inicio del programa y 
reduce el tiempo que toma abrir un archivo guardado previamente. 

Fichero > Import e4k File (Fichero > Importar fichero e4k) 
Importa un fichero en formato.e4k. El formato de fichero .e4k se utilizó en los estetoscopios electrónicos 
3M™ Littmann® anteriores, modelos 4000 y 4100. 

File > Export recording as .wav (Fichero > Exportar grabación como .wav) 
Abre  la ventana “File  Export”  (Exportar fichero)  para guardar la grabación  en  formato  .wav.  

File  >  Print Report (Fichero > Imprimir  informe)  
Imprime el Informe de cita del paciente para un conjunto de grabaciones dado. 

File > Recently Viewed (Fichero > Vistas recientes) 
Abre un  conjunto  de grabaciones  visto  recientemente.  

File  >  Exit  (Fichero  >  Salir)  
Cierra la aplicación StethAssist. 

6.2 Herramientas 
Tools > Add New Stethoscope (Herramientas > Añadir nuevo estetoscopio) 
Abre la ventana “Add New Stethoscope” (Añadir nuevo estetoscopio). 

Tools > Stethoscope  Settings  (Herramientas > Configuración  del  estetoscopio)  
Abre la ventana “Stethoscope Settings” ( Configuración del estetoscopio), donde se puede: 

• Eliminar un estetoscopio vinculado. 
• Cambiar el nombre del estetoscopio. 
• Ajustar la longitud del “lead time” o período de espera, antes de que el software StethAssist™ 

comience la grabación después de pulsar el botón (M) en el estetoscopio. Opciones de tiempo de 
espera: 0, 1, 2 o 4 segundos. 

•  Seleccionar la postura del  paciente  predeterminada.  
•  Seleccionar la duración  predeterminada de  la  grabación.  
•  Seleccionar la vista predeterminada (resumida  o  detallada).  

Tools > Options  (Herramientas  >  Opciones)  
Cambia el directorio predeterminado donde se guardan las grabaciones y/o cambia el 
idioma predeterminado. 

6.3 View (Vista) 
Selecciona  la vista detallada  o  resumida  

6.4 Help (Ayuda) 
Help > Online Help (Ayuda > Ayuda en línea) 
Abre un  explorador  de internet  y se conecta  a  la  página  web  de StethAssist  en  
www.littmann.com/StethAssist 

Help  > User  Manual  (Ayuda > Manual  del  usuario)  
Abre el manual del usuario del software. 

Help > Learn About Littmann® Products (Ayuda > Más información sobre productos Littmann®) 
Abre un  explorador  de internet  y  se conecta  con  Littmann.com 

Help > About (Ayuda > Acerca de) 
Muestra el número de versión del producto, junto con los números telefónicos y direcciones para solicitar 
información adicional o realizar solicitudes de asistencia. 

Help > Check for Latest Version (Ayuda > Buscar la última versión) 
Buscar nuevas versiones de StethAssist. 
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7. Cómo mejorar la calidad de la grabación 

La calidad de las grabaciones depende del entorno, del paciente y de la técnica del usuario: 

El entorno acústico: 
Realice el procedimiento de auscultación en un entorno lo más silencioso posible. Escuche con atención 
para detectar ruidos de fondo, como los causados por los ruidos de tráfico filtrándose por ventanas 
abiertas, o de ventiladores o del aire acondicionado, y elimine esos ruidos en la medida de lo posible. 
Asegúrese de que no haya conversaciones de fondo y evite las interrupciones durante la grabación. 

El paciente: 
En  lo  posible,  se debe preparar  al  paciente de forma  adecuada  para  que el  estetoscopio  pueda  hacer  
contacto directo con la piel del paciente. Se le debe indicar al paciente que se mantenga lo más inmóvil 
posible durante la grabación. 

Colocación y manipulación del estetoscopio: 
Cuando utiliza el estetoscopio Littmann® Modelo 3200, hay varias técnicas importantes que debe tener en 
cuenta para mejorar considerablemente el procedimiento de auscultación. 

El sensor de sonido, donde se producen todas las capturas de sonidos, es bastante pequeño y está 
ubicado  en  el  centro  de  la pieza  torácica (para una demostración,  puede  abrir el  diafragma  y  buscar la  
muesca debajo de la etiqueta blanca). El área que rodea el sensor de sonido no contribuye a la captura 
de sonido. Por lo tanto, es importante centrar el punto de contacto con el paciente bien en el centro de la 
pieza torácica. 

Solo es necesario un ligero contacto con el estetoscopio Littmann® Modelo 3200. Esto incluye tanto la 
manipulación del estetoscopio como el contacto con el paciente. La presión excesiva en el paciente puede 
causar ruidos de interferencia. 

El contacto con el paciente debe ser estable y uniforme para lograr una calidad de sonido óptima. El 
movimiento con la pieza torácica puede causar ruido de fricción. 

Se recomienda comenzar el examen de auscultación a un menor nivel de amplificación. Si intenta detectar 
un sonido difícil de escuchar, aumente la amplificación. Utilizar la amplificación según la necesidad ayudará 
a  reducir  los ruidos perturbadores durante  el  examen.  

Finalmente, es importante reconocer la diferencia técnica entre los estetoscopios electrónicos y no 
electrónicos. Sostener el estetoscopio Littmann® Modelo 3200 delicadamente, hacer un leve contacto con 
el paciente, centrar el punto de  contacto con el centro de la pieza torácica y permanecer inmóvil asegurará 
una auscultación con la mejor calidad de sonido. 
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8. Resolución de problemas 

Problema 

No se puede 
conectar con el
estetoscopio 

 

Causa posible 

No hay un transceptor inalámbrico 
Bluetooth para USB instalado/ 
el transceptor inalámbrico 
Bluetooth para USB no se instaló 
correctamente 

Solución 

Inserte un Bluetooth USB. 
Deshabilite la radio Bluetooth interna 
del ordenador. 
Actualice los drivers del Bluetooth Genérico. 

Estetoscopio no vinculado Vincule el estetoscopio. Seleccione “Add 
New  Stethoscope”  del  menú  Tools  de  la  
pantalla principal 

Cada código de identificación 
único del estetoscopio puede 
representar solo un estetoscopio. 

Si su consultorio posee varios estetoscopios, 
asegúrese de que está intentando 
conectar el estetoscopio con el código de 
identificación correcto. 

Indeterminado Apague el estetoscopio, espere unos segundos y 
luego vuelva a encender el estetoscopio. 

Señal grabada 
ruidosa 

Ruido de fondo excesivo Tome medidas para reducir los ruidos de fondo 
oídos en el entorno de la auscultación. 

La señal 
mostrada en 
el gráfico está 
recortada 

Grabación ruidosa Consulte el apartado 7 de este manual titulado 
“Cómo mejorar la calidad de la grabación”. 

Escasa calidad 
de datos 
informados 

Ruido de fondo excesivo Tome medidas para reducir los ruidos de fondo 
oídos en el entorno de la auscultación. 

Excesivo movimiento del 
estetoscopio 

Sujete el estetoscopio con una mano firme, 
presionando ligeramente contra la piel del 
paciente mientras graba. 

Si desea hacer consultas o disipar dudas sobre el software 3M™ Littmann® StethAssist™ o el estetoscopio 
Littmann® modelo 3200, llame a nuestra línea de servicio técnico para clientes 1-800-228-3957 o visite el 
sitio web www.Littmann.com para ver la página de preguntas frecuentes y de contacto. 

3M Health Care 
Littmann® Brand Products 
3M Center, Building 275-4E-01 
2510 Conway Ave. 
St. Paul, MN 55144 
1-800-228-3957 
www.littmann.com 

3M,  Littmann,  y  StethAssist  son  marcas  comerciales  registradas  de  3M,  con  uso  con  licencia  en  Canadá.  
Windows  es  una marca comercial  registrada de  Microsoft.  Bluetooth  es  una marca comercial  registrada de  
Bluetooth  SIG,  Inc.  Mac  es  una marca comercial  registrada de  Apple  Inc.  

© 2017 3M. Todos los derechos reservados. 

34-8721-7685-3 

68 Español 

PDF Scaled at 100.0% 

www.littmann.com
www.Littmann.com


3M™ Littmann® StethAssist™ 

Software voor de visualisatie van hart- en longgeluiden 

Gebruikershandleiding ‑ Versie 4 

69 Nederlands 

PDF Scaled at 100.0% 



. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

INHOUDSOPGAVE 

1. Algemene informatie . 71 

2. Aan de slag 72 

3. Een nieuwe opname maken of opname(s) van de stethoscoop importeren 75 

4. Opnames herbekijken 77 

5. Opnames opslaan, openen en exporteren 79 

6. Navigatiemenu’s 79 

7. De opnamekwaliteit verbeteren 81 

8. Problemen oplossen 82 

70 Nederlands 

PDF Scaled at 100.0% 

. . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

 . . . . . . . . . . . . . . . . . . . . . . . . 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 



1. Algemene informatie 

1.1 Beoogd gebruik 
3M™ Littmann® StethAssist™-software voor de visualisatie van hart- en longgeluiden is bedoeld voor 
gebruik met de 3M™ Littmann® Elektronische stethoscoop model 3200 voor de opname en weergave 
van hartgeluiden en andere fysiologische akoestische signalen. Het instrument is bedoeld voor gebruik in 
de spreekkamer van een arts. Het is niet bedoeld om een diagnose te formuleren. Dit product geeft geen 
klinische bevindingen of analyses weer. 

1.2 Veiligheidsinformatie 

Raadpleeg de gebruiksaanwijzing 

Alvorens deze software te gebruiken, dient u kennis te nemen van de veiligheidsinformatie die deze 
instructies bevat en dienovereenkomstig te handelen. Bewaar de instructies om later te kunnen raadplegen. 

Een  WAARSCHUWING  of  OPMERKING  wordt  in  deze  handleiding  in  een  kader  weergegeven  en  heeft  de  
volgende betekenis: 

OPGELET: geeft een situatie aan waarin de software mogelijk onnauwkeurige of onvolledige informatie 
aan de gebruiker verstrekt. 

OPMERKING: informatie die belangrijk genoeg wordt geacht om te benadrukken. 

1.3 Systeemvereisten en ‑specificaties 
Computervereisten: 

• Windows 7 32-bit, Windows 7 64-bit, Windows 8 32-bit, Windows 8 64-bit, Windows 10 32-bit, 
Windows 10 64-bit. 

• Mac  OS  10.12  
• 1024 MB RAM of meer 
• Intel Core 2 Duo compatibel of recenter 
• 1024 x 768 schermresolutie of beter 
• USB 1.1-poort of beter om de draadloze USB-adapter met Bluetooth te ondersteunen 

1.4 Privacy patiënt 
De privacy  en  beveiliging  van  bepaalde individueel  identificeerbare gezondheidsinformatie wordt mogelijk  
beschermd door lokale, provinciale, nationale en/of internationale wetgeving die de wijze waarop 
dergelijke informatie kan worden gebruikt, openbaar kan worden gemaakt, kan worden opgeslagen en 
verzonden, reguleert en beperkt. In sommige gevallen kan het zelfs verboden zijn om dergelijke informatie 
aan derden te verstrekken zonder daarvoor eerst schriftelijke toestemming te verkrijgen. 

U bent uitsluitend en volledig verantwoordelijk voor het bepalen, begrijpen en naleven van alle 
wetgeving die betrekking heeft op de wijze waarop u elektronische, individueel identificeerbare 
gezondheidsinformatie door middel van de software opslaat en verstuurt. Als u van mening bent dat u 
niet kunt voldoen aan een wet of beperking die van toepassing is op uw gebruik en openbaarmaking 
(inclusief verzending) van individueel identificeerbare gezondheidsinformatie door middel van de 
software, mag u niet verdergaan met het opslaan van dergelijke informatie. Gaat u wel verder met het 
opslaan van informatie, aanvaardt u hierbij alle risico’s, verantwoordelijkheden en aansprakelijkheden 
die zijn verbonden aan het gebruiken, opslaan en/of verzenden van dergelijke informatie, waaronder 
geluidsbestanden, op elektronische wijze of anderszins. 

Voor het gebruik van dit programma hoeft u geen informatie in te voeren die de identiteit van de 
patiënt kan vrijgeven. Gegevens kunnen worden opgeslagen en teruggevonden door middel van een 
tijdsaanduiding of een willekeurig toegewezen identificatiemiddel. Als u ervoor kiest een betekenisvolle 
Patiëntnaam of Patiëntidentificatiemiddel in te voeren, aanvaardt u alle risico’s en aansprakelijkheden 
die zijn verbonden aan het verzenden en opslaan van dergelijke individueel identificeerbare 
gezondheidsinformatie met behulp van de software, waaronder ook de risico’s aangaande de privacy en 
beveiliging van dergelijke individueel identificeerbare gezondheidsinformatie. 

71 Nederlands 

PDF Scaled at 100.0% 



2. Aan de slag 

2.1 Installeer en registreer de 3M™ Littmann® StethAssist™‑software 
Volg deze stappen om de 3M™ Littmann® StethAssist™-software op uw computer te installeren: 

1. Ga naar www.Littmann.com/StethAssist 
2. Druk op de koppeling om StethAssist te downloaden 
3. Druk op ‘Uitvoeren’ in het tekstvak dat verschijnt 
4. Doorloop de installatie-instructies 
5. Voltooi de online registratie 

OPMERKING:  om de registratie offline te voltooien, moet u contact opnemen 
met de klantendienst van  3M™  Littmann® op het nr. 1-800-228-3957 of via 

littmannsoftwaresupport@mmm.com. 

2.2 De draadloze USB‑adapter met Bluetooth aansluiten (Dongle) 
Om de draadloze USB-adapter met Bluetooth aan te sluiten, moet u het toestel in een USB-poort van 
een computer steken. Dankzij de draadloze USB-adapter met Bluetooth kunnen de computer waarop de 
software werd geïnstalleerd en de 3M™ Littmann® Elektronische stethoscoop model 3200 met elkaar 
communiceren. De draadloze USB-adapter met Bluetooth ontvangt en zendt gegevens via de algemeen 
aanvaarde Bluetooth®-norm voor draadloze connectiviteit met een kort bereik. 

Om een  stethoscoop aan  te  sluiten,  moet de draadloze USB‑adapter met Bluetooth op de computer 
worden aangesloten alvorens de 3M™ Littmann® StethAssist™‑software wordt opgestart. Indien de 
draadloze USB-adapter met Bluetooth niet door de software wordt gedetecteerd, wordt de volgende 
boodschap weergegeven. Indien deze boodschap wordt weergegeven, moet u de draadloze USB-adapter 
met  Bluetooth  aansluiten  en  vervolgens  de  StethAssist-software  sluiten  en  opnieuw  opstarten.  
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2.3 De stethoscoop koppelen en met de software verbinden 
Met behulp van het volgende scherm kunt u een stethoscoop koppelen en/of met de software verbinden. 

2.3.1 Een nieuwe stethoscoop koppelen 

Om voor de eerste maal een Littmann® Stethoscoop model 3200 met de 
3M™ Littmann® StethAssist™-software te  verbinden,  moet u  de stethoscoop  eerst aan  de software  
koppelen. Om een nieuwe stethoscoop te koppelen, kiest u ‘Nieuwe stethoscoop toevoegen’ in 
het keuzemenu. Klik vervolgens op ‘Koppelen’ (of kies ‘Nieuwe stethoscoop toevoegen’ in het 
menu ‘Extra’). Doorloop de instructies op het scherm. Zodra de stethoscoop is gekoppeld, zal 
de software er  automatisch  verbinding  mee maken.  Elke keer  wanneer  u  vervolgens  de software  
opstart, hoeft u enkel maar de stethoscoop ermee te verbinden. 

2.3.2 De stethoscoop verbinden 

Om een eerder gekoppelde stethoscoop te verbinden, selecteert u de stethoscoopnaam in het 
keuzemenu en drukt u op ‘Verbinding maken’. Druk twee maal op de ‘M’-knop op de stethoscoop 
om ‘VERBINDING MAKEN’ te kiezen. Telkens als u probeert om een stethoscoop met de software 
te verbinden, krijgt u het onderstaande scherm te zien. 

Druk op ‘Annuleren’ om opnames te herbekijken zonder een stethoscoop te verbinden. 
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Dit scherm geeft 
de stethoscoop 
aan waarmee de 
software probeert 
verbinding 
te krijgen. 

Wanneer uw stethoscoop verbonden is, wordt op de verbindingsknop van de stethoscoop een groen 

vinkje afgebeeld . Wanneer uw stethoscoop niet verbonden is, wordt op de verbindingsknop een rode 

X afgebeeld .

OPMERKING: volg deze tips om draadloze verbindingen te optimaliseren 

1. Onderzoek de patiënt zo dicht mogelijk in de buurt van de draadloze USB-adapter
2. Probeer te vermijden dat er zich voorwerpen of personen tussen de stethoscoop

en  de draadloze USB-adapter  met Bluetooth  bevinden
3. Probeer te vermijden dat u met  uw hand het volledige borststuk van de

stethoscoop bedekt (positie van Bluetooth®-antenne van stethoscoop)

OPMERKING:  u  kunt meerdere stethoscopen  aan  de 3M™  Littmann® StethAssist™-software 
koppelen, maar er kan slechts een stethoscoop tegelijkertijd actief verbonden zijn. 

De  stethoscoop  kan  slechts  met  een  computer  actief  verbonden  zijn.  
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Kies de houding 
van de patiënt 

Kies de opnamelengte 
(5-60 seconden) 

Voer de 
patiëntinformatie 
in (optioneel) 

Kies een opnamezone in 
het keuzemenu of druk 
op  de  blauwe  romp  
om  de  zone  handmatig  
aan te duiden. Klik 
op een andere 
miniatuurafbeelding om 
een andere weergave 
te bekijken. 

3. Een  nieuwe opname  maken  of  opname(s) van  de stethoscoop importeren

Opname‑instellingenvenster

3.1 Een nieuwe opname maken 
3.1.1. Om met een nieuwe opname te starten, drukt u op de knop ‘Nieuw onderzoek’. Voer in het 

Opname-instellingenvenster de patiëntcode en de patiëntnaam in (optioneel, raadpleeg paragraaf 
1.4 voor informatie omtrent patiëntprivacy). Patiëntcodes kunnen alle letters en cijfers bevatten en 
mogen maximaal 20 tekens lang zijn. De patiëntcode mag uitsluitend de volgende tekens bevatten: 
a-z, 0-9, - en _ 

3.1.2. Kies de opnamelengte, opnamezone en patiënthouding. Klik vervolgens op OK. 

3.1.3.  Zorg  ervoor  dat de  geluidskwaliteit op  de gewenste patiëntzone goed  is  en  druk  vervolgens  op  de
‘M’-knop op de  stethoscoop om de  opname  te  starten.

3.1.4. Om de opname opnieuw te starten, drukt u op de ‘M’-knop op de stethoscoop om de opname te 
stoppen en drukt u nogmaals op de ‘M’-knop om opnieuw op te nemen. 

3.1.5. Nadat de opname werd voltooid, kunt u bij dezelfde patiënt een nieuwe opname maken door op de 
knop ‘Opname toevoegen’ te drukken. Druk op de knop ‘Nieuw onderzoek’ om een opname bij een 
andere patiënt te maken. De 3M™ Littmann® StethAssist™-software vraagt automatisch of u de 
huidige opnamen wilt opslaan. 
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3.1.6. Druk op de overzichtsweergave om opmerkingen voor de patiënt in te voeren (optioneel) 

OPMERKING: het volumeniveau van de stethoscoop heeft geen invloed op het 
volumeniveau  van  de  opname.  Bovendien  kan  de  opname  in  elk  van  de  drie  

filterinstellingen (Bel, Diafragma, Uitgestrekt bereik) opnieuw worden afgespeeld, 
ongeacht de filterinstelling  die tijdens  de opname werd  gehanteerd.  

3.2 Opname(s) uit het stethoscoopgeheugen importeren 
Om (een) bewaarde opname(s) van het ingebouwde geheugen van de Littmann® Stethoscoop model 
3200 naar  de software  te  verplaatsen,  drukt u op  de  knop  ‘Importeren’  of  kiest u ‘Importeren  uit  de  
stethoscoop’ in het bestandsmenu. Doorloop onderstaande stappen: 

1. Kies het/de opnamebestand(en) dat/
die u wenst te importeren 2. Voer de

patiëntinformatie
in (optioneel).3.  Klik  op  het  pictogram  ‘Afspelen’  om  de

opmerkingen bij het bestand te beluisteren
(indien aanwezig). Opmerking: de
opmerkingen bij het bestand worden via
de oortjes van de stethoscoop afgespeeld.

4.  Voer  de  opnamezone  van  de
patiënt in (optioneel).

5. Voer de patiënthouding
in (optioneel).

Beluister het 
opgenomen 
bestand 
(optioneel) 

Verwijder het 
opgenomen 
bestand uit het 
stethoscoopgeheugen 
(optioneel) 

Vergrendel of ontgrendel 
het opgenomen bestand in 
het stethoscoopgeheugen 
(optioneel) 

6. Nadat u de informatie van alle
opgenomen bestanden hebt ingevoerd,
drukt u op ‘Import geselecteerd’.

76 Nederlands 

PDF Scaled at 100.0% 



Gedetailleerde weergave

Slepen. Schakelt 
het gebruik van 

de muiscursor 
in voor het naar 

links of rechts 
slepen van de 

geluidsweergave 

Filterselectie 

Opmerkingen 
bij bestand 

Opname 
verwijderen 

Opnieuw opnemen 

Opmerkingen 
toevoegen 

Afspelen 

Bestand 
openen 

Bestand 
opslaan 

Een nieuw 
onderzoek 
starten 

Weergave 
wijzigen 

Opname(s) 
uit het 
ingebouwde 
geheugen 
importeren 

Bestand aan 
halve snelheid 
afspelen 

Afspelen via 
audio-ingang 
van computer 
of luidsprekers 

Via ‘Algemeen 
aanpassen’ 
past u alle
opnames aan 

Bestand 
doorlopend 
afspelen 

Stethoscoopverbind-
ingsindicator 

Fonocardiogramweergave 
van de geluidsopname 

Spectrogramweergave 
van de geluidsopname 

Naar links pannen Naar rechts pannen 

Een opname 
aan het huidige 
onderzoek 
toevoegen 

Verticale zoom 

Horizontale zoom 

4. Opnames herbekijken

4.1 Pan‑ en zoomsignaal 
Om binnen een geluidsweergave in of uit te zoomen, selecteert u eerst de opname door erop te klikken en 
gebruikt u dan de knoppen Horizontale zoom/Verticale zoom, “+” of “-”. Door in te zoomen, kunt u meer 
detail bekijken. Door uit te zoomen, ziet u minder detail. De knop Verticale zoom past ook het volume van 
de opname aan. Deze knop heeft zowel invloed op de visuele als de geluidsamplitude van de opname. 

Tijdens het horizontaal zoomen, kunt u door de opname schuiven d.m.v. de ‘Pan’-knoppen. Klik op de 
‘Links pannen’-knop om de opname naar links te laten meedraaien. Klik op de ‘Rechts pannen’-knop om 
de opname naar rechts te laten meedraaien. Het is ook mogelijk om naar links en rechts te pannen in 

de geluidsweergaven d.m.v. de Slepen - knop op de werkbalk. Door op deze knop in de vorm van 
een hand te klikken, kunt u naar links en rechts pannen door de opnamen door de muiscursor over een 
geluidsweergave  te  plaatsen  en  de  cursor  te  slepen  in  de  richting  waarin  u  wilt  schuiven.  Schakel  deze  

functie uit door nogmaals op de Slepen -knop te drukken. 

4.2 De optie spectrogramweergave 
Het spectrogram is een weergave van de tijdsfrequentiedistributie waarbij de energie van het geluid 
uitgezet tegen tijd in een tweedimensionale kleurenweergave wordt voorgesteld. Zwart duidt op een 
minimale energie, terwijl rood de maximale energie weergeeft. De x-as geeft de tijdsindex weer en de 
y-as geeft een lineair frequentiebereik weer van 0-500 Hz. Het spectrogram geeft een extra weergave 
van het opgenomen geluid. Om een geluidsweergave als spectrogram weer te geven, klikt u op de 

Spectrogram - knop  aan de linkerkant van  de geluidsweergave.  Om  terug  te  keren  naar  de standaard

geluidsweergave, klikt u op de Fonocardiogram - knop  links van  de  geluidsweergave.
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4.3 Een opname afspelen 
Druk  op  de  knop  Afspelen  op  de  stethoscoop  om  het  afspelen  te  starten.  Gelijktijdig  met  de  opname  
schuift er een rode cursor over de geluidsweergave. Klik op de Stop-knop om het afspelen te beëindigen. 

De software speelt het audiobestand  standaard  af  via  de Littmann® Stethoscoop model 3200 (indien 
aangesloten). Vink het vakje ‘Afspelen via koptelefoon’ aan om het audiobestand via de pc-luidsprekers, 
externe luidsprekers of een koptelefoon af te spelen. 

OPGELET:  de geluidskwaliteit van het geluid dat via de pc-luidspreker of de audio-ingang van de 
pc  wordt  afgespeeld,  biedt mogelijk  geen  getrouwe weergave van  het werkelijke geluid  in  verband  

met de akoestische prestaties  van  de geluidskaart  van  de  pc,  de drivers  van  de geluidskaart en/  
of  de frequentierespons van  de hoofdtelefoon/luidsprekers.  Dit kan  ertoe leiden  dat de  klinisch  
relevante geluiden niet hoorbaar zijn. Het gebruik van een 3M™ Littmann® Stethoscoop model 

3200 wordt ten zeerste aanbevolen om de opgenomen geluidsbestanden te beluisteren. 

OPMERKING: de amplitude of het volume van het opgenomen geluid kan lager zijn dan wat 
u  hoorde  tijdens  de oorspronkelijke opname.  Gebruik  de “+”-knop  op  de verticale as  van  de  

golfweergave of op het toetsenpaneel van de stethoscoop om het volume te verhogen. 

4.4 ½ snelheid 
Met de optie ½ snelheid kunt u de opname op halve snelheid afspelen zonder een noemenswaardig effect 
op de spectrale eigenschappen van het signaal. Klik op het keuzerondje ½ snelheid en klik dan op de knop 
Afspelen om de opname op halve snelheid af te spelen. Wanneer u het keuzerondje ½ snelheid aanklikt, 
blijft het actief totdat u het opnieuw aanklikt. 

OPGELET:  u kunt de optie  ½  snelheid  gebruiken  om  fysiologische gebeurtenissen  te  identificeren,  
maar gebruik deze optie niet uitsluitend voor het maken van een fysiologische diagnose. 

4.5 Een specifiek deel van een opname afspelen 
Om een specifiek deel van een opname af te spelen, klikt u eenvoudigweg met uw muis op het gebied 
in  de geluidsweergave waar  u  wilt beginnen  met afspelen  en  sleept  u de muis  naar  rechts  om  het gebied  
te markeren dat u wilt afspelen. Klik op de knop Afspelen nadat u een gedeelte van de geluidsweergave 
heeft gemarkeerd om dat specifiek gedeelte te beluisteren. Het segment dat u selecteert, moet minstens 
1 seconde lang zijn. Verwijder de markering door op een willekeurige plaats buiten de markering te klikken. 

4.6 Doorlopend afspelen 
Door het keuzerondje voor Doorlopend afspelen bovenaan het scherm te selecteren, kunt u een 
volledige  opname  of  een  deel  van  een  opname  op  doorlopend  afspelen  zetten,  in  een  lus  die  doorgaat  
totdat u de Stop-knop aanklikt. Om een volledige opname in de doorlopende modus af te spelen, 
selecteert u de overeenkomstige geluidsweergave door erop te klikken, vervolgens selecteert u het 
keuzerondje Doorlopend afspelen en dan drukt u op de Afspelen-knop. Om een specifiek deel van een 
opname in de doorlopende modus af te spelen, gebruikt u de cursor om het gewenste deel te markeren 
in de geluidsweergave en klikt u vervolgens op het keuzerondje Doorlopend afspelen en dan op de 
Afspelen-knop. Wanneer  u  het  keuzerondje Doorlopend afspelen  aanklikt,  blijft het  actief  totdat u  het  
opnieuw aanklikt. 

4.7 Algemeen aanpassen 
Met de functie algemeen aanpassen, kunt u alle opnames in een opnameset aanpassen. Dit maakt het 
mogelijk voor de gebruiker om de amplitudes van meerdere opnames met elkaar te vergelijken. 

4.8 Afdrukfunctie 
Klik op de knop Afdrukken om een kopie af te drukken van het “Patiëntonderzoeksrapport” voor een 
bepaalde opname of opnameset. De afdruk bevat de patiëntcode, de patiëntnaam (wanneer u deze heeft 
ingevoerd)  en  de code van  de  stethoscoop  die  u  voor  de opnames  heeft  gebruikt.  Het rapport bevat tevens  
informatie over de houding, de auscultatielocatie en de tijdsduur van de betreffende opname(s), evenals 
opmerkingen die door de gebruiker zijn ingevoerd. 
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4.9 Opmerkingen aan een opname toevoegen 
Vanuit de ‘detailweergave’ kunt u opmerkingen aan het geluidsbestand toevoegen door over te 
schakelen naar de ‘overzichtsweergave’ of door op de knop ‘Opmerkingen’ links van de patiëntcode te 
drukken. Het groene vinkje op de knop ‘Opmerkingen’ wijst erop dat er voor de opname(s) opmerkingen 
werden gegeven. 

5. Opnames opslaan, openen en exporteren 

5.1 Opname opslaan 
Druk op de knop ‘Opslaan’ in de linkerbovenhoek van het scherm of kies ‘Opslaan’ in het bestandsmenu. 
De StethAssist-software vraagt  u  automatisch  of  u  de opname wenst op  te slaan  wanneer  u  een  nieuwe  
opname start of het softwareprogramma sluit. 

5.2 Een eerder opgenomen audiobestand openen 
Druk op de knop ‘Openen’ in de linkerbovenhoek van het scherm of kies ‘Openen’ in het bestandsmenu. 
Klik in de hoofding om dit veld als rangschikcriterium te hanteren. 

5.3 Opnames als .wav‑bestand exporteren 
Om  een  opname in  .wav-bestandsformaat  te  exporteren,  kiest u  ‘Opname als  .wav-bestand exporteren’  
in  het bestandsmenu.  Het  .wav-bestandsformaat wordt erg  veel  gebruikt en  kan  via  de meeste  
pc-mediaspelers  worden  afgespeeld.  Zorg ervoor  dat u  de juiste  filter  selecteert  voor  de opname,  bijv. Bel,  
Diafragma of Uitgestrekt. 

6. Navigatiemenu’s 

3M™ Littmann® StethAssist™-software bevat de volgende menuopties: 
Bestand Extra Weergave Help 

6.1 Bestand 
Bestand > Opslaan 
Sla de huidige opnameset op. 

Bestand > Openen 
Open een voorgaande opnameset. 

Bestand > Sluiten 
Sluit de huidige opnameset. 

Bestand > Nieuw onderzoek 
Start een nieuw patiëntonderzoek. 

Bestand > Opmerkingen 
Open het venster voor opmerkingen. 

Bestand > Uit stethoscoop  importeren  
Importeer een opname uit het ingebouwde geheugen van de stethoscoop. 

Bestand > Bewaarde opname(s) naar huidige locatie importeren 
Hiermee kunt u eerder bewaarde opnamebestanden van een andere locatie op de computer naar de 
huidige opnamelocatie verplaatsen. Door bestanden van de huidige locatie te verwijderen, kunt u de 
opstarttijd van het programma verkorten en een eerder bewaard bestand sneller openen. 

Bestand > Bewaarde opname(s) exporteren 
Hiermee kunt u eerder bewaarde opnamebestanden van de huidige opnamelocatie naar een andere locatie 
op  de computer  verplaatsen.  Door  bestanden  van  de huidige locatie  te  verwijderen,  kunt  u  de opstarttijd  
van het programma verkorten en een eerder bewaard bestand sneller openen. 

Bestand > .e4k-bestand importeren 
Importeer een bestand in .e4k-bestandsformaat. Het .e4k-bestandsformaat werd gebruikt in de oudere 
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3M™ Littmann® elektronische stethoscoopmodellen 4000 en 4100. 

Bestand > Opname als .wav-bestand exporteren 
Open het exporteervenster om de opname in .wav-bestandsformaat op te slaan. 

Bestand > Rapport afdrukken 
Druk het patiëntonderzoeksrapport van de huidige opnameset af. 

Bestand > Pas bekeken  
Open een pas bekeken opnameset. 

Bestand > Afsluiten 
Sluit de StethAssist-applicatie af. 

6.2 Extra 
Extra > Nieuwe stethoscoop toevoegen 
Open het venster ‘Nieuwe stethoscoop toevoegen’. 

Extra > Stethoscoopinstellingen 
Open het venster ‘Stethoscoopinstellingen’, waar u: 

• Een gekoppelde stethoscoop kunt verwijderen. 
• De  stethoscoopnaam  kunt  wijzigen.  
•  De duur  van  de ‘lead  time’  of  wachtperiode aanpassen  alvorens  de StethAssist™-software  begint  

met de opname nadat u de ‘M’-knop op de stethoscoop hebt ingedrukt. Opties lead time: 0, 1, 2 of 
4 seconden. 

• Selecteer de standaard patiënthouding. 
• Selecteer de standaard opnamelengte. 
• Selecteer de standaardweergave (overzicht of detail). 

Extra > Opties 
Wijzig de standaardlocatie waar de opnames worden opgeslagen en/of wijzig de standaardtaal. 

6.3 Weergave 
Kies ‘detailweergave’ of ‘overzichtsweergave’ 

6.4 Help 
Help > Online Help 
Open een internetbrowser en maak verbinding met de StethAssist-webpagina op 
www.littmann.com/StethAssist 

Help > Gebruikershandleiding 
Open de gebruikershandleiding  van de software.  

Help > Ontdek meer Littmann®-producten 
Open een internetbrowser en maak verbinding met Littmann.com 

Help > Over 
Raadpleeg het productversienummer, het telefoonnummer en de adressen om bijkomende informatie aan 
te vragen of onderhoudsgerelateerde vragen te stellen. 

Help > Controleren op recentste versie 
Controleer op nieuwere versies van StethAssist. 
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7. De opnamekwaliteit verbeteren 

De kwaliteit van  de opnames  hangt af  van  de  omgeving,  de patiënt en  de opnametechniek  van  
de gebruiker: 

De akoestische omgeving: 
Voer de auscultatieprocedure uit in een zo rustig mogelijke omgeving. Luister goed of er 
achtergrondgeluiden zijn, zoals het geluid van verkeer door open ramen of van ventilators en 
airconditioning, en minimaliseer deze geluiden zoveel mogelijk. Verzeker u ervan dat er geen gesprekken 
hoorbaar zijn op de achtergrond en voorkom onderbrekingen tijdens het opnemen. 

De patiënt: 
Bereid de patiënt zo goed mogelijk voor zodat de stethoscoop direct contact kan maken met de huid van 
de patiënt. Instrueer de patiënt om zo stil mogelijk te zitten tijdens de opname. 

Plaatsing en hantering van de stethoscoop: 
Er zijn een aantal technieken bij het gebruik van de Littmann® stethoscoop model 3200 die de kwaliteit van 
de auscultatie aanzienlijk kunnen verbeteren. 

De geluidsensor waar alle geluidsontvangst plaatsvindt, is klein en bevindt zich in het midden van het 
borststuk (ter demonstratie, maak het diafragma los en zoek naar de inkeping onder de witte sticker). Het 
gebied rond de geluidsensor draagt niet bij tot de ontvangst van het geluid. Daarom is het belangrijk dat 
het contact met de patiënt wordt gemaakt met het middendeel van het borststuk. 

Met de Littmann® stethoscoop model 3200 hoeft u alleen licht contact te maken. Dit geldt zowel voor het 
hanteren  van  de stethoscoop  als  het contact met de patiënt.  Teveel  druk  tijdens  het contact met de patiënt  
kan resulteren in geluidsartefacten. 

Het contact met de patiënt moet stabiel  en  consistent zijn  voor  een  optimale geluidskwaliteit.  Beweging  
van het borststuk veroorzaakt frictiegeluid. 

Het is aanbevolen om het auscultatieonderzoek te starten op een laag amplificatieniveau. Verhoog de 
amplificatie als u probeert  te  luisteren  naar  een  moeilijk  te  horen  geluid.  Als u de amplificatie alleen  
gebruikt  wanneer  u  deze  nodig heeft,  minimaliseert u de  kans  op geluidsartefacten.  

Het is ten slotte belangrijk om het verschil te benadrukken tussen niet-elektronische en elektronische 
stethoscopen. Voor  de  beste geluidskwaliteit  houdt u  de Littmann® stethoscoop model 3200 licht vast en 
maakt u licht contact met de patiënt. Zorg ervoor dat het contact gemaakt wordt met het midden van het 
borststuk en houdt het borststuk stabiel. 
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8. Problemen oplossen 

Probleem 

Kan geen verbinding 
maken met de 
stethoscoop 

Mogelijke oorzaak 

Er werd geen draadloze 
USB-adapter met Bluetooth 
geïnstalleerd/de draadloze 
USB-adapter met Bluetooth werd 
fout geïnstalleerd 

Oplossing 

Sluit de  draadloze USB-adapter  met  
Bluetooth aan. 
Schakel de interne Bluetooth-radio van de 
computer uit. 
Stel de Bluetooth-driver in op de 
universele Bluetooth-adapter 

Stethoscoop niet gekoppeld Koppel de stethoscoop. Kies ‘Nieuwe 
stethoscoop toevoegen’ in het menu ‘Extra’ op 
het hoofdscherm 

Elk  uniek  stethoscoopnummer  
komt slechts met een stethoscoop 
overeen 

Als uw praktijk over meerdere stethoscopen 
beschikt, verzeker u er dan van dat u met de 
juiste stethoscoopcode verbinding probeert 
te maken. 

Niet bepaald Schakel de stethoscoop uit, wacht een paar 
seconden en schakel de stethoscoop dan weer in 
en probeer opnieuw. 

Ruis in de opname Teveel achtergrondgeluid Onderneem actie om de achtergrondgeluiden in 
de auscultatieomgeving te verminderen. 

Het signaal in de 
weergave is onvolledig 

Opname met ruis Zie paragraaf 7 ‘De opnamekwaliteit verbeteren’ 
in deze gebruikershandleiding. 

Apparaat geeft lage 
gegevenskwaliteit aan 

Teveel achtergrondgeluid Onderneem actie om de achtergrondgeluiden in 
de auscultatieomgeving te verminderen. 

Te veel beweging van de 
stethoscoop 

Houd  de stethoscoop  stabiel en  druk  licht tegen  
de huid van de patiënt tijdens de opname. 

Als u vragen  of  opmerkingen  heeft over  de  3M™ Littmann®  StethAssist™-software of de Littmann® 

stethoscoop  model  3200,  neem  dan  telefonisch  contact op  met onze klantendienst op  1-800-228-3957  of  
bezoek de website van de 3M™ Littmann® stethoscoop voor uw land via www.Littmann.com voor 
Veelgestelde Vragen en de Contactpagina. 

3M Health Care 
Littmann®-merkproducten 
3M Center, Building 275-4E-01 
2510 Conway Ave. 
St. Paul, MN 55144 
1-800-228-3957 
www.littmann.com 

3M, Littmann en StethAssist zijn gedeponeerde handelsmerken van 3M, die onder licentie in Canada worden 
gebruikt. Windows is een gedeponeerd handelsmerk van Microsoft. Bluetooth is een gedeponeerd handelsmerk 
van  Bluetooth  SIG,  Inc.  Mac  is  een  gedeponeerd  handelsmerk  van  Apple  Inc.  

© 2017 3M. Alle rechten voorbehouden. 

34-8721-7685-3 
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1. Informação Geral 

1.1 Uso previsto 
O Software de Visualização do Som do Coração e do Pulmão StethAssist™ Littmann® da 3M™ destina-se 
a ser utilizado com o Estetoscópio Electrónico Littmann® da 3MTM, Modelo 3200, para a gravação e 
reprodução de sons cardíacos e outros sinais acústicos fisiológicos. Este dispositivo destina-se a ser 
utilizado num ambiente de gabinete médico. Não foi concebido como um meio de diagnóstico. O produto 
não comunica qualquer descoberta ou análise clínica. 

1.2 Informações de segurança 

Consulte as instruções de utilização 

Leia,  compreenda  e  siga  todas as informações de  segurança  constante  nestas instruções antes de  utilizar  
este software. Conserve estas instruções para futura referência. 

As mensagens de ATENÇÃO ou NOTA utilizadas neste manual serão apresentadas numa caixa e terão o 
seguinte significado: 

ATENÇÃO: Indica  uma  situação  em  que  o  software pode apresentar  informações  incorrectas ou  
incompletas ao utilizador. 

NOTA: Informações consideradas importantes para destacar. 

1.3 Requisitos e especificações do sistema 
Requisitos do computador: 

• Windows 7 32-bit, Windows 7 64-bit, Windows 8 32-bit, Windows 8 64-bit, Windows 10 32-bit, 
Windows 10 64-bit. 

• Mac  OS  10.12  
• 1024 MB de RAM ou superior 
• Intel Core 2 Duo compatível ou mais recente 
• Resolução de ecrã com placa gráfica de 1024 x 768 ou superior 
• Porta USB 1.1 ou superior para suportar o adaptador Bluetooth USB 

1.4 Privacidade do Doente 
A privacidade e segurança de determinadas informações da saúde identificáveis individualmente podem 
estar  protegidas por  leis estatais,  federais,  internacionais e/ou  estrangeiras,  as quais regulam  e  limitam  
as informações que podem ser utilizadas, divulgadas, armazenadas e transmitidas. Em algumas situações 
pode mesmo ser proibido autorizar o acesso de terceiros a tais informações sem obter uma autorização 
prévia por escrito. 

Você é o único responsável por determinar, compreender e cumprir todas e quaisquer leis que afectem 
o modo como armazena e transmite quaisquer informações de saúde individualmente identificáveis 
electronicamente através do uso do software. Não deve guardar tais informações se determinar que 
não consegue cumprir com uma determinada lei ou restrição que se aplica à sua utilização e divulgação 
(incluindo a transmissão) de informações de saúde individualmente identificáveis através do software. Ao 
guardar tais informações, assume todos os riscos e responsabilidades associados ao uso, armazenamento 
e/ou transmissão de tais informações, incluindo ficheiros de som, electronicamente ou de qualquer 
outra forma. 

Não precisa de introduzir informações de saúde individualmente identificáveis neste programa para ele 
funcionar. Os registos podem ser armazenados e consultados posteriormente através de uma marca 
temporal ou um identificador atribuído aleatoriamente. Se introduzir um Nome do Doente ou Identificador 
do Doente, concorda em assumir todos e quaisquer riscos e responsabilidades incorridos na transmissão e 
armazenamento de tais informações de saúde individualmente identificáveis através do software, incluindo 
os  riscos  de privacidade  e segurança  de tais  informações  de saúde  individualmente  identificáveis.  
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2. Primeiros passos 

2.1 Instale e registe o software StethAssist™ Littmann® da 3M™ 
Siga  os seguintes passos para  instalar  o  software  StethAssist™ Littmann® da 3M™ no seu computador: 

1. Vá até a www.Littmann.com/StethAssist 
2. Clique na ligação “Descarregar StethAssist” 
3. Clique em “Executar” na caixa de diálogo que aparece 
4. Siga as instruções de instalação 
5. Conclua o registo online 

NOTA:  Para  concluir  o registo offline,  contacte  o  Apoio ao Cliente  Littmann® da 3M™ 
através do número 1-800-228-3957 ou para o e-mail littmannsoftwaresupport@mmm.com. 

2.2 Introduza o adaptador Bluetooth USB (Dongle) 
Para instalar o adaptador Bluetooth USB, introduza o dispositivo numa porta USB do computador. O 
adaptador Bluetooth USB permite a comunicação entre o computador no qual está instalado o software 
e o Estetoscópio Electrónico Littmann® da 3M™, modelo 3200. O adaptador Bluetooth USB recebe e 
transmite dados através da já comummente aceite conectividade sem fios de curto alcance Bluetooth®. 

Para ligar a um estetoscópio, o adaptador  Bluetooth  USB  deve  ser  introduzido  no computador  antes  
de iniciar o software StethAssist™ Littmann® da 3M . Se o adaptador Bluetooth USB não for detectado 
pelo software, será apresentada a seguinte mensagem. Se esta mensagem for apresentada, introduza o 
adaptador  USB  e em  seguida  encerre e volte a iniciar  o  software  StethAssist.  
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2.3 Emparelhamento e ligação do estetoscópio ao software 
O  ecrã seguinte  irá ajudá-lo  a  emparelhar e/ou  ligar um  estetoscópio  ao  software.  

2.3.1 Emparelhar novo estetoscópio 

Para fazer a ligação de um estetoscópio Littmann®, modelo 3200, ao software StethAssist™ 
Littmann® da 3M™ pela primeira vez, deve primeiro emparelhar o estetoscópio com o software. 
Para emparelhar um novo estetoscópio, seleccione “Adicionar Novo Estetoscópio” a partir do 
menu  descendente  e  clique  em  “Emparelhar”  (ou  seleccione  “Adicionar  Novo  Estetoscópio”  a  
partir do menu “Ferramentas” no ecrã principal). Siga as instruções indicadas no ecrã. Depois de 
emparelhado o estetoscópio, o software irá automaticamente conectar com o mesmo. A partir 
daqui, sempre que iniciar o software, basta ligá-lo ao estetoscópio. 

2.3.2 Ligar o estetoscópio 

Para ligar a um estetoscópio já emparelhado, seleccione o nome do estetoscópio a partir do menu 
descendente e clique em “Ligar”. No estetoscópio, faça duplo clique no botão (M) para seleccionar 
“LIGAR”.  O  ecrã abaixo  irá aparecer sempre  que  tentar ligar um  estetoscópio  ao  software.  

Para rever as gravações sem ligar um estetoscópio, clique em “Cancelar”. 
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Indica o 
estetoscópio ao 
qual o software  está
a tentar estabelecer  
uma ligação. 

Se o estetoscópio estiver ligado, o botão “Ligação do Estetoscópio” irá aparecer com um sinal de visto 

verde . Se não estiver ligado, o botão “Ligação do Estetoscópio” aparecerá com um X vermelho . 

NOTA: Siga estas dicas com vista a optimizar as ligações sem fios 

1. Ausculte  o  doente  o  mais  próximo  possível  do  adaptador  Bluetooth  USB.
2. Evite a presença de pessoas ou objectos entre o estetoscópio e o adaptador

Bluetooth USB.
3. Evite ter a mão completamente a tapar a peça de auscultação do estetoscópio

(local onde se encontra a antena Bluetooth®)

NOTA: Pode adicionar vários estetoscópios ao software StethAssist™ Littmann® da 
3M™, mas apenas um poderá estar activamente ligado. O estetoscópio só poderá 

estar activamente ligado a um computador. 
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Seleccione a 
postura do doente 

Seleccione a duração 
da gravação (5-60 
segundos) 

Introduza a 
informação 
do doente. 

Seleccione um local de 
gravação a partir do 
menu descendente ou 
clique no tronco a azul 
para indicar manualmente 
o local. Clique numa vista
em miniatura alternativa 
para passar para uma 
imagem diferente. 

3. Crie uma  “Nova Gravação”  ou  faça “Importar  Gravação(ões)”  do estetoscópio

Janela de “Configuração da Gravação”

3.1 Crie uma “Nova Gravação” 
3.1.1. Para iniciar uma nova gravação, clique no botão “Novo Encontro”. Na janela de “Configuração 

da Gravação”, introduza a ID do Doente e o Nome do Doente (opcional, ver Secção 1.4 relativa 
á informação de privacidade do doente). A ID do doente pode conter qualquer combinação 
alfanumérica até 20 caracteres. A ID do Doente só permitirá os seguintes caracteres: a-z, 0-9, - e _ 

3.1.2. Seleccione a duração da gravação, o local da gravação e a postura do doente. Depois clique 
em OK. 

3.1.3. Obtenha uma boa qualidade de som no local pretendido e então prima o botão (M) no estetoscópio 
para iniciar a gravação. 

3.1.4. Para reiniciar a gravação, prima o botão (M) do estetoscópio uma vez para parar a gravação e, em 
seguida, prima o botão (M) novamente para reiniciar a gravação. 

3.1.5. Após concluída a gravação, poderá efectuar outra gravação com o mesmo doente clicando no 
botão “Adicionar Gravação”. Para efectuar uma gravação noutro doente, seleccione o botão 
“Novo Encontro”. O software StethAssist™ Littmann® da 3M™  irá  automaticamente  perguntar se
pretende guardar o actual conjunto de gravações. 
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3.1.6. Clique na “Vista de Resumo” para introduzir comentários do doente (opcional) 

NOTA: O nível  de volume do  estetoscópio  não  afecta  o  nível do  volume das  gravações.
Da mesma forma,  a  gravação  pode  ser reproduzida em  todos  os  três  filtros  (Bell,  

Diafragma, Estendido), independentemente o filtro usado durante a gravação. 

3.2 Importar Gravação(ões) da Memória do Estetoscópio 
Para transferir uma gravação guardada da memória interna do modelo 3200 Littmann®, para o software, 
clique no botão “Importar” ou seleccione “Importar do Estetoscópio” a partir do menu “Ficheiro”. Siga os 
passos abaixo: 

1. Seleccione o(s) Registo(s) 
Gravado(s) para Importar 2. Introduza os

Dados do Doente
(opcional).

5.  Introduza a  Postura do
Doente (opcional).3. Clique no ícone “Reproduzir” para

ouvir o comentário registado (se
existir). Nota: O Comentário Registado
é  reproduzido através dos auriculares. 4. Introduza o Local de Gravação

(opcional).

Ouça o Registo 
Gravado 

Apague o (opcional) 
Registo Gravado 
da memória do  
estetoscópio 
(opcional) 

Bloqueie ou 
desbloqueie o 
Registo Gravado 
memória do 
estetoscópio 
(opcional) 

6. Depois de introduzir a informação para
todos os registos gravados, clique em
“Importar Selecção”.
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4. Revisão das Gravações 

Vista Detalhada 

4.1 Vista panorâmica e zoom do sinal 
Para aumentar ou reduzir a ampliação (zoom) de uma visualização do som, seleccione primeiro a gravação 
clicando  nela  e  depois  utilize  os  botões  “+”  ou  “-”  para  o  “Zoom  horizontal”  ou  “Zoom  Vertical”.  Pode  ver  
mais detalhes ao aumentar a ampliação. Reduzir a ampliação fornece menos detalhes. O zoom vertical 
também aumenta e diminui o volume da gravação uma vez que afecta também a amplitude visual e sonora 
da gravação. 

Se fizer a ampliação na horizontal, pode deslocar-se através da gravação utilizando os botões de Panorama 
(botões Pan). Para deslocar a gravação para a esquerda, clique no botão “Panorama à esquerda”. Para 
deslocar a gravação para a direita,  clique  no botão “Panorama à direita”.  Pode  também  ver  o  panorama  

para a esquerda  e  para a direita  nas  visualizações  do som,  usando  o  botão “Arrastar”  localizado 
na barra de ferramentas. Clique neste botão em forma de mão e poderá ver o panorama para a esquerda 
ou  direita através  de  qualquer uma das  gravações,  colocando  o  cursor do  rato  numa visualização  do  
som  e  depois  arraste o  cursor  na  direcção  para  onde se quer  deslocar.  Clique novamente  no  botão  

“Arrastar” para desactivar esta função. 

4.2 Opção de visualização em Espectrograma 
O espectrograma é uma distribuição de frequência temporal apresentada como um traçado a cores 
bidimensional da energia do som cardíaco distribuído ao longo do tempo e frequência. Preto representa 
a energia mínima e vermelho a energia máxima. O eixo x representa o índice temporal ao passo que o 
eixo y é a amplitude da frequência linear de 0 – 500 Hz. O espectrograma fornece uma perspectiva 
adicional do som gravado. Para uma visualização do som no modo espectrograma, clique no botão 

“Espectrograma” à esquerda da visualização do som. Para regressar à predefinição, vista de 

visualização do som padrão, clique no botão “Fonocardiograma” à esquerda da visualização do som. 
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4.3 Reproduzir uma Gravação 
Prima o botão “Reproduzir” para iniciar a reprodução. Um cursor vermelho irá percorrer a visualização de 
som em sincronia com a gravação. Clique no botão “Parar” para terminar a reprodução. 

Por defeito, o software irá reproduzir o registo de som através do estetoscópio Littmann®, modelo  
3200 (se ligado). Para reproduzir o registo de som nas colunas do computador, colunas externas ou 
auscultadores, clique na caixa de verificação “Reproduzir nos auscultadores”. 

ATENÇÃO: A qualidade de áudio  dos  sons  reproduzidos  através  das  colunas  ou  da  entrada  de  
áudio do computador poderá não ser uma reprodução fiel dos sons reais devido ao desempenho 

acústico da  placa  de som do computador, dos drivers da  placa  de som e/ou da  resposta 
da frequência dos auscultadores/colunas, podendo resultar na incapacidade de ouvir sons 

clinicamente relevantes. Recomendamos vivamente a utilização do estetoscópio Littmann®, 
modelo  3200  da 3M™  seja usado  para ouvir os  sons  registados.  

NOTA: A amplitude ou volume dos sons gravados pode ser inferior ao que é ouvido durante a 
gravação inicial. Use o botão "+" no eixo vertical do gráfico em forma de onda ou no teclado do 

estetoscópio para aumentar o volume. 

4.4 ½ Velocidade 
A opção ½ velocidade (velocidade lenta) permite-lhe reproduzir as gravações a metade da velocidade sem 
qualquer alteração significativa das propriedades espectrais do sinal. Clique na caixa de verificação ½ 
velocidade e depois clique no botão “Reproduzir” para reproduzir a gravação a metade da velocidade. A 
caixa de verificação ½ velocidade permanece activa até clicar novamente nela. 

ATENÇÃO: A opção ½ velocidade está disponível para ajudar a identificar os eventos fisiológicos, 
mas não deve ser usada unicamente para fazer um diagnóstico fisiológico. 

4.5 Reprodução de uma parte específica de uma gravação 
Para reproduzir uma parte específica de uma gravação, clique com o rato na área da visualização de som 
a partir da qual quer iniciar a reprodução e arraste o rato para a direita para assinalar a área de interesse. 
Prima o botão “Reproduzir” para ouvir a secção específica depois de assinalar a visualização do som. De 
salientar que, para esta função funcionar, deve seleccionar um segmento do som com uma duração mínima 
de um segundo. Assinale a área destacada clicando no botão esquerdo do rato em qualquer ponto de 
visualização do som. 

4.6 Reprodução contínua 
A caixa de verificação “Reprodução contínua” que surge no topo do ecrã, permite-lhe reproduzir uma 
gravação completa, ou uma parte específica de uma gravação, num ciclo contínuo até ser premido o botão 
de “Parar”. Seleccione a visualização de som correspondente clicando na mesma e depois na caixa de 
verificação “Reprodução contínua” e ainda no botão “Reproduzir” para reproduzir uma gravação completa 
em modo contínuo. Use o cursor para assinalar a área de interesse numa visualização do som e clique 
então na caixa de verificação “Reprodução contínua” e o botão “Reproduzir” para reproduzir uma parte 
específica de uma gravação no modo contínuo. A caixa de verificação “Reprodução contínua” permanece 
activa até clicar nela novamente. 

4.7 Escala Máxima 
A função escala máxima normaliza todas as gravações constantes num único conjunto de gravação. Tal 
permite ao utilizador comparar com exactidão, as amplitudes das gravações múltiplas. 

4.8 Função de Impressão 
Clique no botão “Imprimir” para imprimir uma cópia do “Relatório do Encontro do Doente” para uma 
determinada gravação ou conjunto de gravações. A impressão resultante irá apresentar a ID do doente, 
o nome do doente (se introduzido) e a ID do estetoscópio usado para as gravações. O relatório contém 
também uma listagem da postura, local de auscultação e duração temporal da(s) gravação(ões) em 
questão e quaisquer comentários do utilizador introduzidos. 
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4.9 Adicionar Comentários a uma Gravação 
Na “Vista Detalhada” pode adicionar comentários ao ficheiro de som, mudando para a “Vista de Resumo” 
ou clicando no botão “Comentários” localizado à esquerda da ID do doente. O sinal de visto verde no 
botão “Comentários” indica que existem comentários para a(s) gravação(ões). 

5. Guardar, Abrir e Exportar Gravações 

5.1 Guardar Gravações 
Clique no botão “Guardar” no canto superior esquerdo do ecrã ou seleccione “Guardar” a partir do menu 
“Ficheiro”. O software StethAssist irá automaticamente alertá-lo para guardar a gravação sempre que 
pretender  iniciar uma nova gravação  ou  tentar sair do  programa.  

5.2 Abrir um Ficheiro de Som previamente gravado 
Clique no botão “Abrir” no canto superior esquerdo do ecrã ou seleccione “Abrir” a partir do menu 
“Ficheiro”. Clique no título para proceder à selecção por esse campo. 

5.3 Exportar gravações para ficheiro .wav 
Para exportar uma gravação para um ficheiro de formato .wav, seleccione “Exportar Gravação como 
.wav”  a  partir  do menu  “Ficheiro”.  O  formato  de  ficheiro .wav  é muito  comum  e  pode  ser  reproduzido pela  
maioria  dos  leitores  de computador.  Certifique-se de  que seleccionou  o  filtro  que é aplicado  à  gravação,  
isto é Bell, Diafragma ou Estendido. 

6. Menus de Navegação 

O Software StethAssist™ Littmann® da  3M™ contém  as seguintes selecções de  menu:  
Ficheiro Ferramentas Vista Ajuda 

6.1 Ficheiro 
Ficheiro > Guardar 
Guarde o conjunto de gravações actual. 

Ficheiro > Abrir 
Abra um conjunto de gravações anterior. 

Ficheiro > Fechar 
Feche o  conjunto de  gravações  actual.  

Ficheiro > Novo Encontro  
Iniciar uma nova gravação  para  um  doente.  

Ficheiro > Comentários 
Abra a janela  de comentários.  

Ficheiro > Importar do Estetoscópio 
Importe uma gravação da memória interna do estetoscópio. 

Ficheiro > Importar Gravação(ões) Guardada(s) para a Directoria Actual 
Transfira ficheiros de gravações previamente guardados de outra localização no computador para a 
directoria de gravações actual. Transferir ficheiros da directoria actual irá aumentar a velocidade de 
arranque do programa, bem como reduzir a quantidade de tempo necessário para abrir um ficheiro 
previamente gravado. 

Ficheiro > Exportar Gravação(ões) Guardada(s) 
Transfira os ficheiros de gravações previamente guardados da sua directoria actual para outra 
localização no computador. Transferir ficheiros da directoria actual irá aumentar a velocidade de 
arranque do programa, bem como reduzir a quantidade de tempo necessário para abrir um ficheiro 
previamente gravado. 
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Ficheiro > Importar ficheiro e4k 
Importar um ficheiro em formato .e4k. O formato de ficheiro .e4k foi usado no estetoscópio electrónico 
Littmann® da 3M™, 4000 e 4100. 

Ficheiro > Exportar gravação como .wav 
Abra a janela “Exportar do Ficheiro” para guardar a gravação no formato .wav. 

Ficheiro > Imprimir Relatório 
Imprima o Relatório do Encontro do Doente para um determinado conjunto de gravações. 

Ficheiro > Recentemente Visualizados 
Abra um conjunto de gravações visualizado recentemente. 

Ficheiro > Sair 
Sair da aplicação  StethAssist.  

6.2 Ferramentas 
Ferramentas > Adicionar Novo Estetoscópio 
Abra a janela “Adicionar Novo Estetoscópio”. 

Ferramentas > Definições do Estetoscópio 
Abra a janela “Definições do Estetoscópio” na qual poderá : 

• Apagar um estetoscópio emparelhado. 
• Mudar o nome do estetoscópio. 
• Ajustar a duração do “tempo inicial” ou período de espera, antes de o software StethAssist™ iniciar 

a gravação depois de premido o botão (M) no estetoscópio. Opções do tempo inicial: 0, 1, 2 ou 
4 segundos. 

• Seleccione a postura pré-definida do doente. 
• Seleccione a duração pré-definida da gravação. 
• Seleccione a vista pré-definida (de resumo ou detalhada). 

Ferramentas > Opções 
Mude a directoria pré-definida onde são guardadas as gravações e/ou mude a língua pré-definida. 

6.3 Vista 
Seleccione “Vista  Detalhada”  ou  “Vista  de Resumo”  

6.4 Ajuda 
Ajuda > Ajuda Online 
Abra  o  navegador  de internet e  ligue-se  à  página  web  do  StethAssist em  www.littmann.com/StethAssist 

Ajuda > Manual do Utilizador 
Abra o manual do utilizador do software. 

Ajuda > Saiba mais sobre os Produtos Littmann® 

Abra  o  navegador  de  internet  e  ligue-se  à  página  Littmann.com 

Ajuda > Acerca 
Consulte o número da versão do produto, juntamente com os números de telefone e endereços para 
futuros pedidos de informação ou para pedidos de assistência. 

Ajuda > Consulte  a  versão  mais  recente  
Consulte  as  novas versões do  StethAssist.  
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7. Melhorar a Qualidade da Gravação 

A qualidade das gravações depende do ambiente, do doente e da técnica do utilizador: 

O ambiente acústico: 
Conduza o procedimento de auscultação num ambiente o mais silencioso possível. Ouça cuidadosamente 
para  detectar  ruídos de  fundo,  tais como  os provocados pelo  tráfego  que  entram  pelas janelas abertas,  
ventoinhas e aparelhos de ar condicionado, tentando eliminá-los o máximo possível. Certifique-se de que 
não existem quaisquer conversas em curso durante a gravação e impeça a ocorrência de interrupções 
durante a mesma. 

O doente: 
Se possível, o doente deve ser devidamente preparado para que o estetoscópio possa ter contacto directo 
com a sua pele.  Deve  informar o doente  para permanecer tão  imóvel quanto  possível ao  longo  da gravação.  

A colocação e manuseamento do estetoscópio: 
Quando utilizar o estetoscópio Littmann®, modelo 3200, existem várias técnicas que são importantes 
considerar e que podem melhorar, substancialmente, a sua experiência de auscultação. 

O sensor de som, onde ocorre toda a aquisição de som, é bastante pequeno e está localizado no centro 
da peça (para fins de demonstração, pode retirar o filme protector do diafragma e procurar a indentação 
sob  o  autocolante branco).  A  área  em  redor  do sensor  de  som  não contribui  para a aquisição  de som. Por  
conseguinte, é importante focar o ponto de contacto com o doente no centro da campânula. 

Basta um contacto ligeiro com o estetoscópio Littmann® Modelo 3200. Isto inclui o manuseamento 
do estetoscópio e o contacto com o doente. A pressão excessiva sobre o doente pode resultar em 
sons artefactos. 

O  contacto  com o doente  tem  de  permanecer  firme e consistente para  uma  qualidade de som  excelente.  O  
movimento  com  a  peça  de  peito  irá  induzir  um  ruído  friccional.  

É uma boa prática começar o seu exame de auscultação com um nível de amplificação mais baixo. Se 
estiver a tentar ouvir um som difícil, ajuste a amplificação para cima. Usando a amplificação conforme 
necessário irá ajudar a reduzir os ruídos de distracção durante o seu exame. 

Por último, é importante reconhecer a diferença na técnica entre estetoscópios não electrónicos e 
electrónicos. Segure ligeiramente o estetoscópio Littmann®, Modelo 3200, fazendo um contacto ligeiro 
com o doente, focando o ponto de contacto no centro da peça de peito e permanecendo firme irá garantir 
uma experiência de auscultação com elevada qualidade de som. 

95 Português 

PDF Scaled at 100.0% 



8. Resolução de Problemas 

Problema 

Não é possível 
estabelecer 
ligação ao 
estetoscópio 

Causa Possível 

Nenhum adaptador Bluetooth USB 
instalado/ Adaptador Bluetooth 
USB incorrectamente instalado 

Solução 

Introduza o adaptador Bluetooth USB. 
Desactive o Bluetooth interno do computador. 
Actualize a driver do Bluetooth para Adaptador 
Bluetooth Geral 

O estetoscópio não está 
emparelhado 

Emparelhe  o  estetoscópio.  Seleccione  
“Adicionar Novo Estetoscópio” a partir do menu 
“Ferramentas” no ecrã principal 

Cada ID do Estetoscópio só pode 
representar um estetoscópio 

Se o seu consultório tiver vários estetoscópios, 
certifique-se de que está a fazer a ligação à “ID 
do Estetoscópio” correcta. 

Não determinado Desligue o estetoscópio, aguarde uns segundos e 
depois  volte a ligá-lo  e  tente de  novo.  

Sinal gravado 
com ruído 

Ruído de fundo excessivo Tome medidas para reduzir os ruídos de fundo 
presentes no ambiente de auscultação. 

Sinal 
apresentado 
nos traçados da 
visualização está 
cortado 

Gravação  com  ruído  Consulte a Secção  7  deste manual  do  utilizador  -
“Melhorar Qualidade de Gravação”. 

Dados de baixa 
qualidade 
comunicados 

Ruído de fundo excessivo Tome medidas para reduzir os ruídos de fundo 
presentes no ambiente de auscultação. 

Movimentação excessiva do 
estetoscópio 

Segure o estetoscópio com uma mão firme, 
pressionando ligeiramente de encontro à pele do 
doente enquanto efectua a gravação. 

Para questões ou dúvidas relativamente ao software StethAssist™ Littmann® da 3M™ ou ao estetoscópio 
Littmann® Modelo 3200, entre em contacto com a nossa linha de atendimento ao cliente através do 
número 1-800-228-3957 ou consulte o website do Estetoscópio Littmann® da 3M™para o seu país em 
www.Littmann.com na página “Perguntas Mais Frequentes” e “Contacte-nos”. 

3M Health Care 
Produtos Littmann® 

3M Center, Building 275-4E-01 
2510 Conway Ave. 
St. Paul, MN 55144 
1-800-228-3957 
www.littmann.com 

3M, Littmann StethAssist são marcas registadas da 3M, sob licença no Canadá. Windows é uma marca registada 
da Microsoft.  Bluetooth  é  uma  marca registada da  Bluetooth  SIG,  Inc.  Mac  é  uma marca registada da Apple  Inc.  

© 2017 3M. Todos os direitos reservados. 

34-8721-7685-3 
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1. 一般情報 

1.1 用途 
3M™リットマン ® StethAssist™聴診音表示ソフトウェアは、3M ™リットマン ®エレクトロニックステソスコープ（電子聴診器）モデル 3200専用ソフトウェアで、心音およびその他の生理的な音響信号を録音、表示することを目的としています。本製品は医師が診察室で使用することを目的としています。診断用ではありません。本製品では臨床的所見や解析は得られません。 

1.2 安全に関する情報
使用説明書をお読みください。

このソフトウェアをご使用になる前に、これらの使用説明書に含まれるすべての安全に関する情報をお読みになり、理解した上で、これらを遵守してください。また、これらの情報は大切に保管してください。
本ユーザーマニュアルで使用されている「注意」または「注」は囲み文字で表示され、以下の意味を持ちます。
注意：ソフトウェアがユーザーに対して不正確または不完全な情報を提示する可能性がある状況であることを示します。
注記：強調すべき重要性があると考えられる情報を示します。 

1.3 システム要件および仕様 
PCの動作要件： 

• Windows  7  32ビット版、Wi ndows 7 64ビット版、W indows 8 32ビット版、W indows 8 64ビット版、Windows 10 32ビット版、Wi ndows 10 64ビット版 
• Mac  OS  10.12  
• RAM：1024 MB以上 
• Intel Core 2 Duo互換機以降 
• ディスプレイの解像度 1024  x  768以上 
• USB  1.1ポート以降（ USB Bluetoothワイヤレスアダプターに対応） 

1.4 患者のプライバシー
特定の個人を識別可能な健康に関する情報のプライバシーおよびセキュリティは、個人情報の使用、公開、保存、転送方法に対する規制の目的で、州、連邦、国際、外国法、またはそれらのすべてにより保護されることがあります。例えば、事前の書面による承諾なく、かかる情報への第三者のアクセスを許可することも禁じられる場合があります。
お客様には、このソフトウェアを使用した個人を識別可能な健康に関する電子的情報をどのように保存、転送するかに影響する、あらゆる法律を検討、理解、遵守することについての単独かつ完全な責任が発生します。ソフトウェアの使用による個人を識別可能な健康情報の使用および公開（転送を含む）に適用される法律または規制を遵守することができないと判断される場合は、そのような情報の保存処理を行うべきではありません。いかなる情報でも保存処理を行うことで、お客様には、電子的または他の形式でも、音声ファイルを含むそのような情報の使用、保存、転送、またはそのすべてに関連するすべてのリスク、責任、義務が発生します。
このプログラムを機能させるために、個人を識別可能な健康情報の入力が求められることはありません。録音データは、タイムスタンプまたは任意で割り付けた識別子を使用して保存、呼び出しができます。もし、何らかの意味を持つ患者名または患者 IDの入力を選択した場合には、その個人を識別可能な健康情報のプライバシーおよびセキュリティに関連するリスクを含む、ソフトウェアを介した個人を識別可能な健康情報の転送および保存に伴うすべてのリスクおよび義務を負うことに同意したものとみなされます。 
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2. スタートガイド
2.1 3M™ リットマン® StethAssist™ ソフトウェアのインストールおよび登録

3M™リットマン® StethAssist™ソフトウェアをコンピュータにインストールするには、以下の3つのステップに従ってください。
1. www.Littmann.com/StethAssistにアクセスします
2. ［StethAssistをダウンロードする（Download StethAssist）］リンクをクリックします
3. 表示されたメッセージボックスの［Run（実行）］をクリックします
4. インストール手順に従います
5. オンライン登録を行います

注記： オフラインで製品登録を行う場合は、3M™リットマン®カスタマーサポート（1‑
800‑228‑3957またはlittmannsoftwaresupport@mmm.com）までご連絡ください。

2.2 USB Bluetoothワイヤレスアダプタ（ドングル）の取り付け
USB Bluetoothワイヤレスアダプタを取り付けるには、アダプタをPCのUSBポートに挿入します。 USB Bluetoothワイヤレスアダプタにより、このソフトウェアがインストールされたPCと3M™リットマン®エレクトロニックステソスコープモデル3200との間で通信が可能になります。USB Bluetoothワイヤレスアダプタは、一般的な
Bluetooth®短距離ワイヤレス接続基準に準拠してデータの送受信を行います。
聴診器に接続するには、USB BluetoothワイヤレスアダプタをPCに挿入してから3M™ リットマン®
StethAssist™ ソフトウェアを起動します。 USB Bluetoothワイヤレスアダプタがソフトウェアに検出されない場合は、以下のメッセージが表示されます。このメッセージが表示された場合は、USB Bluetoothワイヤレスアダプタを挿入して、StethAssistソフトウェアをいったん終了してから再起動してください。

http://www.Littmann.com/StethAssis
mailto:littmannsoftwaresupport@mmm.com


2.3 聴診器とソフトウェアのペアリング( 認証）および接続
次の画面に従って、聴診器とソフトウェアをペアリングおよび接続できます。

2.3.1 新しい聴診器のペアリング
リットマン ®モデル 3200聴診器を3M ™リットマン ® StethAssist™ソフトウェアに初めて接続する際は、最初に聴診器とソフトウェアをペアリング( 認証）する必要があります。新しい聴診器をペアリングするには、ドロップダウンメニューから［新しい聴診器を追加（ Add New Stethoscope）］を選択して、［ペアリング（P air）］をクリックします（あるいは、メイン画面の［ツール（ Tools）］メニューから［新しい聴診器を追加（Ad d New Stethoscope）］を選択します）。画面に表示される指示に従います。聴診器がペアリングされたら、聴診器とソフトウェアは自動的に接続されます。以降はソフトウェアを起動するたびに、簡単に接続されます。

2.3.2 聴診器の接続
前回ペアリングした聴診器に接続するには、ドロップダウンメニューから聴診器の名前を選択して、［接続（Connect）］をクリックします。聴診器の（ M）ボタンを 2回押し、［接続（C ONNECT）］を選択します。聴診器とソフトウェアを接続しようとすると、以下の画面が表示されます。
聴診器を接続せずに録音を確認する場合は、［キャンセル（Ca ncel）］をクリックしてください。 
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ソフトウェアが接続しようとしている聴診器が表示されます。

聴診器が接続されると、［聴診器の接続状態（S tethoscope Connection）］ボタンに緑色のチェックマークが表
示されます 。接続されていない場合は、［聴診器の接続状態（S tethoscope Connection）］ボタンに赤
色の「X 」が表示されます 。

注記： 次のヒントに従って、ワイヤレス接続を最適化してください 
1. できるだけ USBワイヤレスアダプタの近くで患者を聴診する 
2. 聴診器とUS B Bluetoothワイヤレスアダプタとの間に物や人が入らないようにする 
3. 手で聴診器のチェストピース全体（聴診器のB luetooth®アンテナの位置）を覆わないようにする

注記： 3M™リットマン ® StethAssist™ソフトウェアには複数の聴診器をペアリングすることができますが、1 度に接続できる聴診器は1 台です。 聴診器は 1台のPCにのみ接続できます。
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3. 新しい録音の作成／聴診器から録音をインポート
録音設定ウィンドウ

患者の姿勢を選択します

ドロップダウンメニューから録音部位を選択するか、青色の人体イメージをクリックして手動で部位を指定します。 別の画像に変更する場合は、別のサムネイル表示をクリックします。

録音時間を選択します（ 5～60秒）

患者情報を入力します（任意） 

3.1 新しい録音の作成 
3.1.1. 新しい録音を開始するには、［新しい診断（ New Encounter）］ボタンをクリックします。［録音設定（Recording Set-up）］ウィンドウで、［患者 ID（Patient ID）］と［患者名（ Patient Name）］を入力します（入力は任意です。患者のプライバシーに関しては、セクション 1.4を参照してください）。患者 

ID（Patient ID）は最大 20文字で、文字と数字を組み合わせて入力してください。患者ID （Patient ID）に使用できる文字は、 a～z、0～9、「-」、および「 _ 」のみです。
3.1.2. 録音時間、録音部位、患者の姿勢を選択します。次にOK をクリックします。 

3.1.3. 所定の録音部位で適切な音質が確認できたら、聴診器の（M ）ボタンを押して録音を開始します。 

3.1.4. 録音をやり直したい場合は、聴診器の（ M）ボタンを 1回押して録音を停止し、再度（M ）ボタンを押して録音を再開します。 

3.1.5. 録音が完了した後、［レコードの追加（Ad d Recording）］ボタンをクリックすると同じ患者で別な部位での録音を行うことができます。別な患者で録音を行う場合は、［新しい診断（Ne w Encounter）］ボタンを選択してください。 3M™リットマン ® StethAssist™ソフトウェアが、現在の録音データセットを保存するかどうかを尋ねるメッセージを自動的に表示します。 

3.1.6. ［サマリー（ Summary）］表示をクリックして、患者のコメントを入力します（任意）
注記：聴診器の音量レベルは、録音音量レベルには影響しません。 また、録音中に使用した周波数モードに関わらず、録音は3 種類の周波数モードの設定（ベル、ダイアフラム、レンジ拡張）ですべてで再生できます。
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3.2 聴診器のメモリーから録音データをインポートする
リットマン ®モデル 3200聴診器の内蔵メモリーからソフトウェアに保存された録音データを転送するには、［インポート（Im port）］ボタンをクリックして［ファイル（ File）］メニューから［聴診器からインポート（ Import From 
Stethoscope）］を選択します。以降の下手順は図のとおりです。 

1.インポートする録音トラックを選択します 
2.患者情報を入力します（任意）。 5.患者の姿勢を入力し ます（任意）。3.［再生（Pl ay）］アイコンをクリックして、トラックのコメント（入力されている場合）を再生します。 注記：トラックのコメントは、聴診器から再生されます。 4.患者の録音部位を入力します（任意）。 

6.すべての録音トラックの情報を入力したら、［選択した録音データをインポート（Import Selected）］をクリックします。

録音トラックを再生します（任意）

聴診器のメモリーの録音トラックをロックするかまたはロックを解除します（任意）

録音トラックを聴診器のメモリーから削除します（任意）
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4. 録音データの確認
詳細表示

を使ってサウンドディスプレイを左右にドラッグすることができます
周波数モードの選択

トラックのコメント

録音データを削除します

再録音

コメントを追加します
再生

トラックを 1/2速度で再生します 

PCのヘッドフォンジャックまたはスピーカーから再生します
スケールの統一機能で、すべての録音データの縦軸を統一します

トラックを連続再生します

サウンドディスプレイ サウンドディスプレ 左へ移動 右へ移動

垂直方向のズーム
水平方向へのズーム

ドラッグ。 マウスカーソル

ファイルを開きます
ファイルの保存

新しい患者の診断を開始します 表示切替
内蔵メモリーから録音データをインポートします聴診器の接続状態表示

の心音図（ PCG）表示 イのスペクトログラム表示

既存の診断に録音データを追加します 

4.1 信号データの移動およびズーム
サウンドディスプレイ内でズームイン、ズームアウトするには、初めに目的の録音データをクリックして選択し、次に水平方向または垂直方向ズームの［＋］または［－］ボタンでズームイン、ズームアウトします。ズームインでは細部の確認ができます。ズームアウトでは全体の確認ができます。垂直方向ズームは、録音の視覚的振幅および可聴振幅に影響するため、録音データの音量が大きくなったり、小さくなったりします。
水平方向にズームする場合、［移動（ Pan）］ボタンで録音データをスクロールすることができます。録音データを左方向に移動する時は、［左移動（Pa n Left）］ボタンをクリックします。録音データを右方向に移動する時は、［
右移動（P an Right）］ボタンをクリックします。また、ツールバーにある［ドラッグ（ Drag）］ ボタンを使って、サウンドディスプレイ内で左に移動させたり、右に移動させたりすることもできます。この手のひら形状のボタンをクリックして、マウスカーソルをサウンドディスプレイ上に合わせた後、スクロールしたい方向にカーソルをドラッグすると、録音データを左方向または右方向に移動させることができます。この機能を終了する場合は、［ド
ラッグ（ Drag）］ ボタンを再度クリックします。 

4.2 スペクトログラムの表示オプション
スペクトログラムとは、サウンドエネルギーを時間と周波数で分布させた2次元のカラープロットとして表示される時間－周波数分布図です。黒色は最小エネルギーを表し、赤色は最大エネルギーを表します。 X軸は時間指数、Y軸は0～500Hzの直線的な周波数領域を表します。スペクトログラムにより、録音されたサウンドを別の視点で見ることができます。スペクトログラムモードでサウンドディスプレイを見るには、サウンドディスプレイ左側
にある［スペクトログラム（S pectrogram）］ ボタンをクリックします。標準的な初期設定のサウンドディス
プレイ表示に戻すには、サウンドディスプレイ左側にある［心音図（ Phonocardiogram）］ ボタンをクリックします。 
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4.3 録音データの再生
［再生（Pl ay）］ボタンを押して、再生を開始します。赤色のカーソルは、録音データに同期してサウンドディスプレイをスクロールします。再生を終了するには、［停止（St op）］ボタンをクリックします。
初期設定では、このソフトウェアがリットマン® モデル 3200聴診器を通して音声データを再生します（接続されている場合）。音声データをPC のスピーカー、外部スピーカー、またはヘッドフォンから再生するには、［ヘッドフォンから再生（Pl ay to Headphones）］チェックボックスをクリックしてください。

注意：  PCのスピーカーまたは PCのオーディオジャックを通して再生される音声の品質は、PCのサウンドカード、サウンドカードドライバーの音響特性、ヘッドフォン／スピーカーの周波数特性により、実際の生体音を正確に再現しない場合があり、結果的に、臨床的に正確な生体音の聴診ができない可能性があります。 録音データを再生する場合は、3M™リットマン ®聴診器モデル32 00のご利用を強く推奨します。
注記： 録音された聴診音の振幅または音量は、当初録音した際に聴こえたものよりも小さくなることがあります。 音量を大きくするには、波形グラフの垂直軸、または聴診器のキーパッドにある［＋］ボタンを使用してください。

4.4 1/2速度で再生
［1/2速度再生（ ½ Speed）］オプションを使用すると、信号のスペクトル特性に大きな影響を与えることなく、録音データを通常の半分の速度で再生することができます。［ 1/2速度再生再生（ ½ Speed）］チェックボックスにチェックを付けてから［再生（ Play）］ボタンをクリックすると、通常の半分の速度で再生されます。一度チェックを付けると、チェックを外すまで低速再生が継続されます。

注意：  1/2速度再生（ ½ Speed）オプションは、生理学的イベントの特定を補助するための機能ですが、生理学的診断を目的として単独で使うべきものではありません。
4.5 録音データの一部を再生する

録音データの一部を再生するには、サウンドディスプレイ内の再生したい箇所でマウスをクリックし、右側へドラッグして目的の領域を強調表示します。サウンドディスプレイ領域が強調表示されたら、［再生（ Play）］ボタンをクリックして特定箇所の録音データを再生します。この機能を使用するためには、少なくとも 1秒以上の長さを選択する必要があります。強調表示を解除するには、サウンドディスプレイ上の任意の場所で左クリックします。 

4.6 連続再生
画面上部の［連続（ Loop）］チェックボックスにチェックを付けると、録音データの全体または一部が連続で再生され、［停止（ Stop）ボタン］をクリックするまで継続します。全録音データを連続モードで再生するには、再生したいサウンドディスプレイをクリックして選択し、［連続（ Loop）］チェックボックスにチェックを付けてから［再生（ Play）］ボタンをクリックします。録音データの一部を連続モードで再生するには、カーソルを使ってサウンドディスプレイの目的の範囲を強調表示し、［連続（ Loop）］チェックボックスにチェックを付けてから［再生（Play）］ボタンをクリックします。一度チェックを付けると、チェックを外すまで連続再生が継続されます。 

4.7 複数の縦軸スケールを統一する
複数の縦軸のスケールの統一（ Global Scaling）機能は、一つの録音データセットに含まれる録音データの縦軸を同じにします。この機能により、複数の録音データの振幅を正確に比較することができます。 
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4.8 印刷機能
任意の録音データまたはデータセットの「患者レポート（ Patient Encounter Report）」のコピーを印刷するには、［印刷（ Print）］ボタンをクリックします。印刷されるレポートには患者の ID（Patient ID）、患者名（ Patient 
Name）（入力されている場合）、録音に使用した聴診器の IDが表示されます。また、患者の姿勢、聴診部位、録音時間のリストに加え、入力されたユーザーコメントも表示されます。 

4.9 録音データへのコメントの追加
［詳細表示（ Detailed View）］で、［サマリー表示（ Summary View）］に切り替えるか、［患者 ID（Patient ID）］の左にある［コメント（ Comments）］ボタンをクリックすると、音声ファイルにコメントを追加できます。［コメント（Comments）］ボタンに緑色のチェックマークが表示されている場合は、該当する録音データにコメントが追加されていることを示します。 

5. 録音データを保存、開く、エクスポート
5.1 録音データの保存

画面左上隅の［保存（Sa ve）］ボタンをクリックするか、［ファイル（ File）］メニューから［保存（ Save）］を選択します。新しい録音を開始したり、ソフトウェアプログラムを終了する場合には、録音データを保存するよう促すメッセージが自動的に表示されます。 

5.2 以前に録音した音声ファイルを開く
画面左上隅の［開く（Op en）］ボタンをクリックするか、［ファイル（ File）］メニューから［開く（ Open）］を選択します。見出しをクリックすると、このフィールドで並べ替えできます。 

5.3 録音データを.wavファイルにエクスポート
録音データを .wavファイル形式でエクスポートするには、［ファイル（ File）］メニューから［ .wavファイルとして録音データをエクスポート（ Export recording as .wav）］を選択します。 .wavファイル形式は一般的なファイル形式で、ほとんどの PCのメディアプレイヤーで再生することができます。必ず、目的の録音データに適用される周波数モードを選択してください（例：ベル、ダイアフラム、レンジ拡張）。 

6. ナビゲーションメニュー
3M™リットマン ® StethAssist™ソフトウェアには以下のメニューがあります。ファイル（ File） ツール（Tool s） 表示（Vie w） ヘルプ（He lp）

6.1 ファイル（ File）
ファイル（ File） >保存（ Save）現在の録音データセットを保存します。
ファイル（ File） >開く（ Open）以前の録音データセットを開きます。
ファイル（ File） >閉じる（ Close）現在の録音データセットを閉じます。
ファイル（ File） >新しい診断（ New Encounter）新しい患者の録音を開始します。
ファイル（ File） >コメント（ Comment）コメントウィンドウを開きます。
ファイル（ File） >聴診器からインポート（I mport From Stethoscope）聴診器の内蔵メモリーから録音データをインポートします。 
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ファイル（ File） >保存した録音データを現在のディレクトリにインポート（ Import Saved Recording(s) to 
Current Directory）以前に保存した録音データファイルを PCの別の場所から現在の録音データ用ディレクトリに移動します。現在のディレクトリからファイルを移動すると、プログラムのスタートアップ速度が改善されるほか、以前の保存ファイルを開く時間も短縮されます。
ファイル（ File） >保存された録音データのエクスポート（ Export Saved Recording(s)）以前に保存した録音データファイルを現在の録音データ用ディレクトリから PCの別の場所に移動します。現在のディレクトリからファイルを移動すると、プログラムのスタートアップ速度が改善されるほか、以前の保存ファイルを開く時間も短縮されます。
ファイル（ File） > e4kファイルをインポート（ Import e4k File）ファイルを .e4k形式でインポートします。 .e4kファイル形式は、以前の3M ™リットマン ®電子聴診器モデル 4000および 4100で使用されていたファイル形式です。
ファイル（ File） > .wav形式で録音データをエクスポート（ Export recording as .wav）［ファイルのエクスポート］ウィンドウを開いて、録音データを .wavファイル形式で保存します。
ファイル（ File） >レポートを印刷（ Print Report）任意の録音データセットの患者レポートを印刷します。
ファイル（ File） >最近使った録音データ（ Recently Viewed）最近使った録音データセットを開きます。
ファイル（ File） >終了（ Exit）
StethAssistアプリケーションを終了します。 

6.2 ツール（To ols）
ツール（ Tools）>新しい聴診器の追加（ Add New Stethoscope（新しい聴診器を追加））［Add New Stethoscope（新しい聴診器を追加）］ウィンドウを開きます。
ツール（ Tools）>聴診器の設定（S tethoscope Settings）［聴診器の設定（S tethoscope Settings）］ウィンドウが開き、次の操作が行えます。 

• ペアリングされた聴診器を削除します。 
• 聴診器の名前を変更します。 
• 聴診器の（M ）ボタンを押してから StethAssist™ソフトウェアが録音を開始するまでの「リードタイム」または待機時間の長さを調節する。リードタイムのオプション： 0、1、2、4秒。 
• 初期設定の患者の姿勢を選択します。 
• 初期設定の録音時間を選択します。 
• 初期設定の表示（サマリーまたは詳細）を選択します。

ツール（ Tools） >オプション（ Options）
録音データが保存される初期設定のディレクトリを変更したり、初期設定の言語を変更します。 

6.3 表示
［詳細表示（ Detailed View）］または［サマリー表示（ Summary View）］を選択します。 

6.4 ヘルプ（ Help）
ヘルプ（He lp） >オンラインヘルプ（ Online Help）インターネットブラウザーを開き、S tethAssistのウェブページ（ at www.littmann.com/StethAssist）に接続します。
ヘルプ（ Help） >ユーザーマニュアル（ユーザーマニュアル） 
Open theソフトウェアユーザーマニュアル .
ヘルプ（He lp） >リットマン ®製品について（Lea rn About Littmann® Products）インターネットブラウザーを開き、 Littmann.comに接続します。
ヘルプ（ Help） >バージョン情報（ About）製品のバージョン番号のほか、詳細の請求やサービスの依頼先の電話番号と所在地を表示します。
ヘルプ（ Help） >最新バージョンを確認する（ Check for Latest Version）
StethAssistの最新バージョンを確認します。 
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7. 録音品質の改善
録音品質は、録音環境、患者の状態、ユーザーの技術に影響します。
音響環境：
聴診は、可能な限り静かな環境下で行ってください。外部からの交通による騒音や、扇風機やエアコン等による環境音を確認し、これらの音を最大限排除してください。録音中は周りの会話などの雑音に干渉されないよう注意してください。
患者：
可能であれば、患者の状態を適切に準備し、患者の皮膚に直接聴診器をあてるようにしてください。録音中はできるだけ動かないように、患者に指示してください。
聴診器の取扱い
リットマン ®モデル 3200聴診器を使用する際には、良好な聴診音に改善させる重要な技術がいくつかあります。
すべての音を収集するサウンドセンサーは非常に小さく、チェストピースの中心に付いています（ダイアフラムを剥がして白色ステッカーの下を見ると、窪んでいる場所がセンサーになります）。サウンドセンサー周囲の領域は集音機能はありません。チェストピースの中心部が患者への接触点になることが重要です。
リットマン ®モデル 3200聴診器は強く押し付ける必要はありません。このことは、聴診器の取扱いや患者への使用時にも当てはまります。強く押し当てると、アーチファクト音の原因となります。
患者に聴診器をあてる際は、最適な音質を得るため、安定性を維持してください。チェストピースを動かすと、摩擦音が発生します。
聴診を始める場合は、最初は音量を小さくしたレベルから聴診すると最適です。聴診音が聴きづらい音を聴診する場合は、音量を上げてください。必要に応じて音量を調節することで、聴診中の雑音を減らすことができます。
最後に、従来の聴診器と電子聴診器の聴診技術の違いを認識することが重要です。リットマン® モデル 3200聴診器を軽く手に持ち、患者の身体に軽くあて、チェストピースの中心部が接触点となるように集中しながら安定させることで、高品質の聴診検査が可能になります。 
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8. トラブルシューティング
問題

聴診器に接続できない 

考えられる原因
USB Bluetoothワイヤレスアダプタが取り付けられていない／ USB 
Bluetoothワイヤレスアダプタが正しく取り付けられていない 

解決策
USB Bluetoothワイヤレスアダプタを USB端子に挿入してください。 
PCの内蔵 Bluetooth無線機能を無効にしてください。 
Bluetoothのドライバーを一般的な Bluetoothアダプタにアップデートしてください。

聴診器がペアリングされていない 聴診器のペアリングを行ってください。メイン画面の［ツール（ Tools）］メニューから［新しい聴診器を追加（ Add New Stethoscope）］を選択してください。
各聴診器 IDに1台の聴診器しか表示されない 複数の聴診器をお使いの場合は、正しい聴診器 IDへの接続を試みているかを確認してください。
不明 聴診器の電源を切り、数秒待ってから、再度電源を入れてください。

録音データの信号に雑音が入っている
周囲の雑音が多い 聴診を行う環境下で聞こえる周囲の雑音を減らす方策をとってください。

ディスプレイ領域に表示された信号が欠けている
雑音が多い 本ユーザーマニュアルのセクション 9.0「録音品質の改善」をお読みください。

データ品質が悪い 周囲の雑音が多い 聴診を行う環境下で聞こえる周囲の雑音を減らす方策をとってください。
聴診器を動かし過ぎる 聴診器をしっかりと持ち、録音中は患者の体に動かないように軽く当ててください。 

3M™リットマン ® StethAssist™ソフトウェアまたはリットマン ®モデル 3200聴診器に関する質問等は、カスタマーコールセンター（ 0570-011-321）にご連絡いただくか、 3M™リットマン ®聴診器ウェブサイトにお問い合わせください。 

3M Health Care 
Littmann® Brand Products 
3M Center, Building 275-4E-01 
2510 Conway Ave. 
St. Paul, MN 55144 
1-800-228-3957 
www.littmann.com 

3M、リットマン、 StethAssistは3Mの登録商標です。カナダでのライセンスの下に使用されています。 Windowsは 
Microsoft社の登録商標です。 BluetoothはBluetooth SIG, Inc.の登録商標です。Ma cはApple Inc.の登録商標です。 
© 2017 3M.無断複写･複製･転載を禁じます。 
34-8721-7685-3 
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1. 简介 

1.1 特定用途 
3M™ Littmann® StethAssist™心肺音可视化软件旨在与 3M™ Littmann®电子听诊器 3200型配合使用，以记录和显示心音与其它生理声音信号。该设备仅限用于医师办公室环境。不能用作诊断工具。该产品不报告任何临床发现或分析。 

1.2 安全信息
查阅使用说明

在使用该软件之前，请阅读、理解并遵循包含于这些说明之中的所有安全信息。保存好这些说明书，以备日后查阅。
本用户手册中用到的 “小心”或“注意”会标有方框，并表示以下意义：
小心：表示软件可能向用户显示不正确或不完整信息的情况。
注意：很重要因此需要强调的信息。 

1.3 系统要求和规格
电脑要求： 

• Windows  7  32位，Windows 7 64位，Windows 8 32位，Windows 8 64位 Windows 10 32位，Windows 10 64位。 
• Mac  OS  10.12  
• 1024 MB或更大 RAM 
• 兼容 Intel Core 2 Duo或更高版本 
• 1024 x 768或更佳图形显示分辨率 
• USB  1.1或更佳端口以支持 USB蓝牙无线适配器 

1.4 患者隐私
某些可识别个人身份的健康信息的隐私性和安全性受管理和限制此类信息使用、披露、存储和传输的州、联邦、国际和 /或外国法律的保护。在这些情况下，您可能会在为事先获得相应书面授权的情况下被禁止使用任何第三方访问这类信息。
您应全权负责确定、了解和遵守影响您如何通过使用软件来保存和传输任何可识别个人身份的电子健康信息的任何和全部法律并自行承担全部责任。如果您确定自己无法遵守适用于您通过使用本软件使用和披露（包括传输）可识别个人身份的健康信息的法律或限制，您就不得继续保存此类信息。如果继续保存任何信息，您须承担通过电子方式或任何其他方式使用、保存和 /或传输此类信息（包括声音文件）相关的所有风险、责任和义务。
此程序无需输入可识别个人身份的健康信息即可运行。可通过使用时间戳或任意指派的标识符保存和召回记录。如果选择输入有意义的患者姓名或患者识别符，即表示您同意承担通过本软件传输和存储此类可识别个人身份的健康信息所产生的所有风险与责任，包括此类可识别个人健康信息的隐私和安全性风险。 
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2. 开始 

2.1 安装和注册 3M™ Littmann® StethAssist™软件
请按照以下步骤在您的电脑上安装 3M™ Littmann® StethAssist™软件： 

1. 转至 www.Littmann.com/StethAssist 
2. 在“Download StethAssist”（下载 StethAssist）链接上单击 
3. 在所示消息框上的 “Run”（运行）按钮上单击 
4. 遵循安装说明进行操作 
5. 完成在线注册

注意： 若要离线完成注册，请致电 1-800-228-3957或发送电子邮件至 
littmannsoftwaresupport@mmm.com与 3M™ Littmann®客户支持联系。 

2.2 插入 USB蓝牙无线适配器（硬件保护装置）
若要安装 USB蓝牙无线适配器，请将设备插入电脑上的 USB端口。US B蓝牙无线适配器允许安装此软件的电脑与 3M™ Littmann®电子听诊器 3200型进行通信。US B蓝牙无线适配器通过普遍接受的 Bluetooth®短程无线连接标准接收和传输数据。
若要连接到听诊器，启动 3M™ Littmann® StethAssist™之前，必须将 USB蓝牙无线适配器插入电脑。如果软件未检测到 USB蓝牙无线适配器，将显示以下消息。如果显示此消息，请插入 USB蓝牙无线适配器，然后关闭并重新启动 StethAssist软件。
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2.3 将听诊器与软件配对和连接
以下屏幕将帮助您将听诊器与软件配对和 /或连接起来。

2.3.1 配对新听诊器
为了将 Littmann® 3200型听诊器首次连接到 3M™ Littmann® StethAssist™软件，您必须首先将听诊器与软件配对。若要配对新听诊器，请从下拉菜单中选择“ Add New Stethoscope”（添加新听诊器），然后单击 “Pair”（配对）（或者从主屏幕上的“T ools”（工具）菜单中选择“ Add New Stethoscope”（添加新听诊器））。遵循屏幕上的指示操作。配对听诊器之后，软件将自动与之连接。此后每次启动软件时，只需连接到听诊器即可。

2.3.2 连接听诊器
若要连接到以前配对的听诊器，请从下拉菜单中选择听诊器名称，然后单击 “Connect”（连接）。在听诊器上按两次 (M)按钮，以选择 “CONNECT”（连接）。每次尝试将听诊器连接到软件时，都将显示下面的屏幕。
若要查看记录，但不连接听诊器，请单击 “Cancel”（取消）。 
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指示软件要尝试连接的听诊器。

如果听诊器已连接，则“ Stethoscope Connection”（听诊器连接）按钮将显示一个绿色复选标记 。如果未
连接，则“ Stethoscope Connection”（听诊器连接）按钮将显示一个红色 X 。

注意： 请遵循以下提示优化无线连接 
1. 在尽可能靠近 USB无线适配器的位置为患者听诊
2. 避免听诊器和 USB蓝牙无线适配器之间存在任何物体或人员
3. 避免将您的手盖住听诊器的整个听胸器（听诊器 Bluetooth®天线的位置）

注意：您可以将多个听诊器配对到 3M™ Littmann® StethAssist™软件，但一次只能有效连接一个听诊器。听诊器只能有效连接到一台电脑。
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3. 创建新记录或从听诊器导入记录
记录设置窗口

从下拉列表选择一个记录位置，或者在蓝色躯干上单击，以手动指定位置。若要切换到不同的图像，请单击一个备用缩略视图。

选择患者姿势

选择记录长度（ 5-60秒）

输入患者信息（可选） 

3.1 创建新记录
3.1.1. 若要启动新记录，请在“N ew Encounter”（新会话）按钮上单击。在记录设置窗口中，输入患者 ID和患者姓名（可选，请参阅第 1.4部分了解患者隐私信息）。患者 ID可包含任何多达 20个字符长度的字母和数字组合。患者 ID仅允许使用以下字符： a-z，0-9，-和 _ 

3.1.2. 选择记录长度、记录位置和患者姿势。然后单击“O K”（确定）。 

3.1.3. 在期望的患者位置获得良好的音质，然后在听诊器上按 (M)按钮以开始记录。 

3.1.4. 若要重新开始记录，在听诊器上按 (M)按钮停止记录，然后再按一次 (M)按钮重新开始记录。 

3.1.5. 记录结束之后，您可以单击“A dd Recording”（添加记录）按钮来为相同的患者进行另一次记录。若要对不同的患者进行记录，请选择“N ew Encounter”（新会话）按钮。3 M™ Littmann® StethAssist™软件将自动询问是否要保存当前记录集。 

3.1.6. 在摘要视图上单击，输入患者评论（可选）
注意：听诊器的音量水平不会影响记录的音量水平。此外，记录可以采用所有三种过滤器设置（钟型、膜型、扩展模式）进行播放，而无需考虑记录期间使用的是哪种过滤器设置。
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从下拉列表选择一个记录位置，或者在蓝色躯干上单击，以手动指定位置。若要切换到不同的图像，请单击一个备用缩略视图。

选择记录长度（5-60秒）

输入患者信息（可选）



3.2 从听诊器存储器导入记录
若要将保存的记录从 Littmann® 3200型听诊器的单板存储器转移到软件，请在“I mport”（导入）按钮上单击，或者从“File”（文件）菜单选择“ Import From Stethoscope”（从听诊器导入）。遵循以下步骤进行操作：

1.选择要导入的录音 
2.输入患者信 息（可选）。 

3.在“Play”（播放）图标上单击，收听录音评论（如果存在）。注意：录音评论通过听诊器的耳塞进行播放。 

5.输入患者姿势（可选）。
4.输入患者记录位置（可选）。 

6.为所有录音输入信息之后，单击 
“Import Selected”（导入所选）。

收听录音（可选）

在听诊器存储器中锁定或解锁录音（可选）

从听诊器存储器删除录音（可选）
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4. R查看记录
详情视图

拖动 启用使用鼠标光标向左或向右拖动声音显示

过滤器选择

录音评论

删除记录

再次记录

添加评论

播放

打开文件
保存 启动一个新会话 切换视图

从单板存储器导入记录

以 ½速度播放录音

通过电脑音频插孔或扬声器进行播放
全局缩放使所有记录正常化

循环播放录音

听诊器连接指示灯

声音显示的声谱图视图 声音显示的声谱图视图 摇左 摇右

垂直缩放
水平缩放

添加记录到现有会话 

4.1 信号摇摄与缩放
若要在声音显示区域中缩小或放大，请首先单击并选择记录，然后使用 “Horizontal Zoom”（水平缩放）或“Vertical Zoom”（垂直缩放） “+”或“-”按钮。缩小提供更多详情。放大提供更少详情。垂直缩放还可以提高或降低记录音量，因为它可以影响记录的图像和声音振幅。
如果水平缩小，您可以使用 “Pan”（摇摄）按钮浏览记录。若要向左移动记录，单击 “Pan Left”（摇左）按钮即可。
若要向右移动记录，单击“ Pan Right”（摇右）按钮即可。也可以使用工具栏上的 “Drag”（拖动） 按钮摇左或摇右声音显示。单击此手形按钮，将鼠标光标放置在声音显示上，向希望滚动的方向拖动光标，即可摇左或摇右
记录所有部分。再次单击“Dr ag”（拖动） 按钮即可停用此功能。 

4.2 声谱图显示选项
声谱图是一种显示为声音能量时间和频率分布二维彩色图的时频分布。黑色代表最低能量，红色代表最高能量。X轴代表时间指数，Y轴代表 0 - 500 Hz的线性频率。声谱图提供所录声音的其它视图。若要以声谱图模式
查看声音显示，请单击声音显示左侧的“Spectrogram”（声谱图） 按钮。若要返回标准默认声音显示视图，
请单击声音显示左侧的 “Phonocardiogram”（心音图） 按钮。
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4.3 播放记录
按“Play”（播放）按钮开始播放。一个红色光标将随记录同步滚动跨越声音显示。单击“S top”（停止）按钮可结束播放。
默认情况下，软件将通过 Littmann® 3200型听诊器（如果已连接）播放录音。若要通过电脑扬声器、外接扬声器或耳机播放录音，请单击“P lay to Headphones”（播放到耳机）复选框。
小心：考虑到计算机声卡、声卡驱动器的吸声特性和 /或耳机/ 扬声器的频率响应，通过计算机扬声器或计算机耳机插孔播放的音质可能无法如实再现实际声音，有可能导致无法听到临床相关的声音。强烈建议将 3M™ Littmann®听诊器 3200型用于收听记录的声音。
注意：初次记录时，录音的振幅或音量可能会小于听到的声音。可以使用波形图纵轴或听诊器键盘上的“+”按钮来提高音量。

4.4 “½ Speed”（½ 速度） 
“½ Speed”（½速度）选项使您能够半速播放记录，并且信号的频谱特性不会发生明显变化。单击 “½ Speed”（½速度）复选框，然后单击 “Play”（播放）按钮，可半速播放记录。一旦单击， “½ Speed”（½速度）复选框将保持激活，直到再次单击为止。

小心： “½ Speed”（½速度）选项可用于协助识别生理活动，但不应单独用来做出生理诊断。
4.5 播放记录的特定部分

若要播放记录的特定部分，只需用鼠标在要开始播放的声音显示区域上单击，然后将鼠标拖动到右侧，以突出显示感兴趣的区域。一旦以这种方式突出显示某个声音显示区域，单击 “Play”（播放）按钮即可收听特定部分。请注意，您必须选择一个至少一秒时长的声音片段，才能使此功能发挥作用。在声音显示上的任何地方左键单击可清除突出显示的区域。 

4.6 循环播放 
“Loop”（循环）复选框显示在屏幕顶部，使您能够以循环（将持续到单击 “Stop ”（停止）按钮时为止）的方式播放整段记录或者记录的特定部分。若要以循环模式播放完整的记录，请单击并选择对应的声音显示，单击 “Loop”（循环）复选框，然后单击 “Play”（播放）按钮。若要以循环模式播放记录的特定部分，请使用光标在声音显示上突出显示感兴趣的区域，单击 “Loop”（循环）复选框，然后单击 “Play”（播放）按钮。一旦单击， “Loop”（循环）复选框将保持激活，直到再次单击为止。 

4.7全局缩放
全局缩放功能能够将保存在单个记录集中的所有记录正常化。用户因此能够准确地对比多个记录的振幅。 

4.8打印功能
若要为指定记录或记录集打印 “患者会话报告 ”副本，请单击 “Print”（打印）按钮。打印出的结果将显示患者 ID、患者姓名（如果已输入）以及用于记录的听诊器 ID。报告还会包含一份姿势、听诊位置和指定记录时长列表，以及输入的所有对应用户评论。 

4.9为记录添加评论
当处于 “Detailed View”（详情视图）中时，通过切换到 “Summary View”（摘要视图）或者在患者 ID左侧的“Comments”（评论）按钮上单击，您可以为声音文件添加评论。评论按钮上的绿色复选标记表示记录存在评论。 

5. 保存、打开以及导出记录
5.1 保存记录

在屏幕左上角单击“S ave”（保存）按钮，或者从“F ile”（文件）菜单选择“S ave”（保存）。如果启动新记录或者现有软件程序，St ethAssist软件将自动提示您是否保存记录。 
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5.2 打开以前记录的声音文件
在屏幕左上角单击“O pen”（打开）按钮，或者从“F ile”（文件）菜单选择“O pen”（打开）。在标题上单击以按此栏归类。 

5.3 将记录导出为 .wav 文件
若要以 .wav文件格式导出记录，请从 “File”（文件）菜单选择 “Export recording as .wav”（将记录导出为 .wav）。.wav文件格式非常普遍，可以使用大多数电脑媒体播放器进行播放。请确保选择了应用于记录的过滤器，例如钟型、膜型或扩展模式。 

6. 导航菜单 
3M™ Littmann® StethAssist™软件包含以下菜单选项：文件 工具 视图 帮助 

6.1 文件
文件 >保存保存当前记录集。
文件 >打开打开一个以前的记录集。
文件 >关闭关闭当前记录集。
文件 >新会话开始一条新患者记录。
文件 >评论打开评论窗口。
文件 >从听诊器导入从听诊器的单板存储器导入一条记录。
文件 >将保存的记录导入到当前目录将以前保存的记录文件从电脑上的其它位置转移到当前记录目录。将文件移出当前目录将提高程序启动速度，减少打开以前保存文件的时间。
文件 >导出保存的记录将以前保存的记录文件从当前记录目录转移到电脑上的其它位置。将文件移出当前目录将提高程序启动速度，减少打开以前保存文件的时间。
文件 >导入 e4k文件以 .e4k格式导入文件。.e 4k文件格式用于以前的 3M™ Littmann®电子听诊器 4000型和 4100型。
文件 >将记录导出为 .wav打开“File Export”（文件导出）窗口，以 .wav文件格式保存记录。
文件 >打印报告为指定记录集打印患者会话报告。
文件 >最近查看过的打开一个最近查看过的记录集。
文件 >退出退出 StethAssist应用程序。
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6.2 工具
工具 >添加新听诊器 打开“Add New Stethoscope”（添加新听诊器）窗口。 
工具 >听诊器设置 打开“Stethoscope Settings”（听诊器设置）窗口，您可以在该窗口中执行以下操作：  

•	 删除一个已配对的听诊器。 
•	 更改听诊器名称。 
•	 调整“提前期 ”长度或在听诊器上按 (M)按钮后 StethAssist™开始记录之前的等待时间。提前期选项： 0、1、2或 4秒。 
•	 选择默认患者姿势。 
•	 选择默认记录长度。 
•	 选择默认视图（摘要或者详情）。

工具 >选项 更改保存记录的默认目录和 /或更改默认语言。  

6.3 视图
选择详情或摘要视图 

6.4 帮助
帮助 >联机帮助 打开一个 Internet浏览器并连接到 StethAssist网页 www.littmann.com/StethAssist


帮助 >用户手册 打开软件用户手册。 
帮助 >了解 Littmann®产品 打开一个 Internet浏览器并连接到 Littmann.com


帮助 >关于 查看产品版本号以及请求获得更多信息或进行服务查询的电话号码和地址。 
帮助 >查看最新版本 查看 StethAssist的新版本。 
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7. 改善记录音质
记录的音质取决于环境、患者和用户技术：
声音环境： 
在尽可能安静的环境中执行听诊程序。仔细倾听，找出背景声音，例如通过打开的窗户传入的交通噪音或者风扇与空调的噪音，尽可能消除这些噪音。确保没有背景谈话并且在记录时防止打断。
患者：
如果可能，应对患者进行正确的听诊前准备，以便让听诊器直接接触患者的皮肤。应该指导患者在整个记录过程中尽可能保持安静。
听诊器的安放与处理：
使用 Littmann® 3200型听诊器时，务必掌握几项可以大幅提高您的听诊经验的重要技巧。
进行所有声音采集的声音传感器十分小巧，并且位于听胸器的正中央（为了达成展示目的，您可以剥离隔膜并在白色标签下找到压痕）。声音传感器周围的区域对声音采集没有影响。因此，务必将与患者的接触点对准听胸器的正中央。
使用 Littmann® 3200型听诊器只需轻轻接触。这同时包括听诊器处理和患者接触。对患者施加过大压力可能导致伪音。
接触患者必须保持稳定和一致，以确保最佳音质。移动听胸器会引起摩擦噪音。
最好从较低放大率开始您的听诊检查。如果您试图收听难以听到的声音，请增大放大率。视需要使用放大率将有助于降低检查中的干扰性噪音。
最后，务必了解非电子和电子听诊器之间的技术差异。轻轻握住 Littmann® 3200型听诊器，从而轻轻接触患者，对准听胸器中间的接触点，再保持稳定，从而确保最佳音质的听诊体验。 
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8. 故障排除
问题
无法连接到听诊器

可能原因
未安装 USB蓝牙无线适配器 /USB蓝牙无线适配器安装不正确

解决方法
插入 USB蓝牙无线适配器。禁用内部电脑蓝牙无线电收发器。将蓝牙驱动程序更新为 Generic Bluetooth Adaptor

听诊器未配对 配对听诊器。从主屏幕上的 “Tools”（工具）菜单中选择“Add New Stethoscope”（添加新听诊器）
每个独一无二的听诊器 ID只能代表一个听诊器 如果您的办事处拥有多个听诊器，确保您连接到正确的听诊器 ID。
待定 关闭听诊器，等待几秒钟，然后重新打开听诊器并再次尝试。

嘈杂的记录信号 过大的背景噪音 采取措施降低听诊环境中能够听到的背景噪音。
显示图中显示的信号已固定 嘈杂的记录 请参阅本用户手册第 7节，标题为 “改善记录音质 ”。
不良报告数据质量 过大的背景噪音 采取措施降低听诊环境中能够听到的背景噪音。

听诊器过度移动 用手握稳听诊器，并在听诊时轻轻压在患者皮肤上。
如果您有关于 3M™ Littmann® StethAssist™软件或 Littmann® 3200型听诊器的问题或疑问，请联系我们的客户服务热线 1-800-228-3957，或者查找所在国家 /地区 3M™ Littmann® Stethoscope网站 
www.Littmann.com中的“Frequently Asked Questions”（常见问题）和 “Contact Us”（联系我们）页。 

3M Health Care 
Littmann®品牌产品 
3M Center, Building 275-4E-01 
2510 Conway Ave. 
St. Paul, MN 55144 
1-800-228-3957 
www.littmann.com 

3M、Littmann和 StethAssist均为 3M公司的注册商标，在加拿大许可证的授权下使用。 Windows为 Microsoft的注册商标。 Bluetooth为 Bluetooth SIG, Inc.的注册商标。 Mac为 Apple Inc.的注册商标。 
© 2017 3M.保留所有权利。 
34-8721-7685-3 

124 简体中文 

PDF Scaled at 100.0% 

http://www.littmann.com
http://www.littmann.com


3M™ Littmann® StethAssist™

心肺音視覺軟體
軟體使用者操作手冊 ‑ 第 4 版

125 正體字

PDF Scaled at 100.0% 



 . . . . . . . . . . . . .

目錄 

1. 概論 127 

2. 開始 128 

3. 建立新記錄或從聽診器匯入記錄 131 

4. 檢閱記錄 133 

5. 儲存、開啟以及匯出記錄 135 

6. 瀏覽功能選項 135 

7. 改善記錄音質 137 

8. 疑難排解 138 

126 正體字

PDF Scaled at 100.0% 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 



1. 概論 

1.1 特定用途 
3M™ Littmann® StethAssist™心肺音視覺軟體旨在與 3M™ Littmann®電子聽診器 3200型配合使用，以記錄和顯示心音與其它生理聲音信號。該設備僅限用於醫療場所。不能用作診斷工具。該產品不報告任何臨床發現或分析。 

1.2 安全資訊
查閱使用說明

請在使用本軟體之前要先閱讀、瞭解並遵守包含在這些操作手冊中的安全資訊。請保留本操作手冊以供將來參考之用。
本使用者手冊中用到的「小心」或「注意」會標有方框，並表示以下意義：
小心：表示軟體可能存在不準確或不完整資訊的狀況。
注意：被認為是重要且強調的資訊。 

1.3 系統要求和規格
電腦要求： 

• Windows  7  32位元、Wi ndows 7 64位元、W indows 8 32位元、W indows 8 64位元、Wi ndows 10 32位元、Wi ndows 10 64位元。 
• Mac  OS  10.12  
• 1024 MB或更大 RAM 
• 相容 Intel Core 2 Duo或更高版本 
• 1024 x 768或更佳圖形顯示解析度 
• USB  1.1或更佳連結埠以支援 USB藍牙無線介面卡 

1.4 患者隱私
關於載有個人身份識別的健康資訊的隱私和安全保護，可受州、聯邦、國際和 /或外國法規範和限制，例如如何使用、披露、儲存和傳輸這些資訊。在某些情況下，如未事先取得相關書面授權，您甚至可能被禁止讓任何單位或人員去獲取這些資訊。
您充分確定、理解和遵守所有的法律和其他規定、規範您經由此軟體如何儲存和傳輸任何載有電子個人身份識別的健康資訊，並負完全保護責任。如果您確定您無法遵守法律或規定您經由此軟體使用和披露（包括傳輸）載有個人身份識別的健康資訊，那麼您則不應該繼續保有這些資訊。在儲存任何資訊時，即表示您同意承擔所有使用、儲存和 /或傳輸此類資訊（包括音效檔、電子或其他資訊）相關的所有風險、責任和義務。
此程式無需輸入個人身份識別的健康資訊即可運行。所有紀錄可經由時間郵戳或任意指定的代號被儲存和找出檔案。如果您選擇輸入一個有意義的患者姓名或患者識別碼，即表示您同意承擔透過本軟體傳輸和儲存此類個人身份識別健康資訊所產生的所有風險與責任，包括此類可識別個人身份健康資訊的隱私和安全性風險。 
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2. 開始
2.1 安裝和註冊 3M™ Littmann® StethAssist™ 軟體

請按照以下步驟在您的電腦上安裝 3M™ Littmann® StethAssist™軟體： 
1. 轉至 www.Littmann.com/StethAssist
2. 在「Download StethAssist」（下載 StethAssist）連結上按一下
3. 在所示訊息方塊上的「Ru n」（運行）按鈕上按一下 
4. 遵循安裝說明進行操作
5. 完成線上註冊

注意： 若要離線完成註冊，請致電 1-800-228-3957或寄送電子郵件至 
littmannsoftwaresupport@mmm.com與 3M™ Littmann®客戶支援聯繫。

2.2 插入 USB 藍牙無線介面卡（硬體鎖）
若要安裝 USB藍牙無線介面卡，請將設備插入電腦上的 USB連結埠。 USB藍牙無線介面卡允許安裝此軟體的電腦與 3M™ Littmann®電子聽診器 3200型進行通信。US B藍牙無線介面卡透過普遍接受的 Bluetooth®短程無線連結標準來接收和傳輸資料。
若要連結到聽診器，啟動 3M™ Littmann® StethAssist™ 之前，必須將 USB 藍牙無線介面卡插入電腦。如果軟體未檢測到 USB藍牙無線介面卡，將顯示以下訊息。如果顯示此訊息，請插入 USB藍牙無線介面卡，然後關閉並重新啟動 StethAssist軟體。
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2.3 將聽診器與軟體配對和連結
以下螢幕將協助您將聽診器與軟體配對和 /或連結起來。

2.3.1 配對新聽診器
為了將 Littmann® 3200型聽診器首次連結到 3M™ Littmann® StethAssist™軟體，您必須首先將聽診器與軟體配對。若要配對新聽診器，請從下拉功能表中選取「Ad d New Stethoscope」（新增聽診器），然後按一下「P air」（配對）（或者從主螢幕上的「 Tools」（工具）功能表中選取「A dd New 
Stethoscope」（新增聽診器））。遵循螢幕上的指示操作。配對聽診器之後，軟體將自動與之連結。此後每次啟動軟體時，只需連結到聽診器即可。

2.3.2 連結聽診器
若要連結到以前配對的聽診器，請從下拉功能表中選取聽診器名稱，然後按一下「 Connect」（連結）。在聽診器上按兩次 (M)按鈕，以選取「 CONNECT」（連結）。每次嘗試將聽診器連結到軟體時，都將顯示下面的螢幕。
若要檢閱記錄，但不連結聽診器，請按一下「 Cancel」（取消）。 
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表示軟體要嘗試連結的聽診器。

如果聽診器已連結，則「S tethoscope Connection」（聽診器連結）按鈕將顯示一個綠色核取記號 。如果
未連結，則「S tethoscope Connection」（聽診器連結）按鈕將顯示一個紅色 X 。

注意： 遵照這些小技巧，可以預防無線連結失敗 
1. 在聽診病人時，盡可能靠近 USB無線介面卡的位置
2. 避免聽診器和 USB藍牙無線介面卡之間存在任何物體或人員
3. 避免將您的手覆蓋聽診器的整個聽頭（此處有聽診器 Bluetooth®天線）

注意：您可以將多個聽診器配對到 3M™ Littmann® StethAssist™軟體，但一次只能有效連結一個聽診器。 聽診器只能有效連結到一台電腦。
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3. 建立新記錄或從聽診器匯入記錄
記錄設定視窗

從下拉清單選取一

選取患者姿勢

個記錄位置，或者在藍色軀幹上按一下，以手動指定位置。 若要切換到不同的圖像，請按一下一個備用縮圖檢視。

選取記錄長度（5-60秒）

輸入患者資訊（可選） 

3.1 建立新記錄
3.1.1. 若要啟動新記錄，請在「Ne w Encounter」（新會話）按鈕上按一下。在記錄設定視窗中，輸入患者 ID和患者姓名（可選，請參閱第 1.4部分瞭解患者隱私資訊）。患者 ID可包含任何多達 20個字元長度的字母和數位組合。患者 ID僅允許使用以下字元： a-z、0-9、-和 _ 

3.1.2. 選取記錄長度、記錄位置和患者姿勢。然後按一下「OK 」（確定）。 
3.1.3. 在期望的患者位置獲得良好的音質，然後在聽診器上按 (M)按鈕以開始錄音。 

3.1.4. 若要重新開始錄音，在聽診器上按 (M)按鈕停止錄音，然後再按一次 (M)按鈕重新開始錄音。 

3.1.5. 錄音完成後，您可以按一下「Ad d Recording」（新增記錄）按鈕來為相同的患者進行另一次錄音。若要對不同的患者進行記錄，請選取「Ne w Encounter」（新患者）按鈕。 3M™ Littmann® StethAssist™軟體將自動詢問是否要儲存現有的錄音檔。 

3.1.6. 在摘要圖上按一下，輸入患者評註（可選）
注意：聽診器的音量水準不會影響記錄的音量水準。 此外，記錄可以採用所有三種過濾模式設定（鐘面、膜面、擴大收音頻率）進行播放，而無需考慮記錄期間使用的是哪種過濾模式設定。
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選取記錄長度（5-60秒）

輸入患者資訊（可選）



3.2 從聽診器記憶體匯入記錄
若要將儲存的記錄從 Littmann® 3200型聽診器的記憶體轉移到軟體，請在「 Import」（匯入）按鈕上按一下，或者從「Fi le」（檔案）功能表選取「 Import From Stethoscope」（從聽診器匯入）。遵循以下步驟進行操作：

1.選取要匯入的錄音
2.輸入患者資訊（可選）。 

3.在「Play」（播放）圖示上按一下，收聽錄音註釋（如果存在）。 注意：錄音註釋透過聽診器進行播放。

5.輸入患者姿勢（可選）。

4.輸入患者記錄位置（可選）。

6.為所有錄音輸入資訊之後，按一下「Im port
Selected」（匯入所選）。

收聽錄音（可選）

在聽診器記憶體中鎖定或解開鎖定錄音（可選）

從聽診器記憶體刪除錄音（可選） 
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收聽錄音（可選）

在聽診器記憶體中鎖定或解開鎖定錄音（可選）

從聽診器記憶體刪除錄音（可選）



4. 檢閱記錄
詳細檢視圖

拖曳 啟用使用滑鼠游標向左或向右拖曳聲音顯示

過濾模式選取

錄音評論

刪除記錄

再次記錄

增加註解
播放

開啟檔案
儲存檔案 啟動一個新會話 切換查看 從聽診器記憶體匯入記錄

半速播放錄音

透過電腦音訊插孔或揚聲器進行播放
全域縮放使所有記錄正常化

循環播放錄音

聽診器連結指示燈

聲音顯示心音圖 聲音顯示光譜圖 向左平移 向右平移

垂直縮放
水平縮放

新增記錄到現有會話 

4.1 信號平移與縮放
若要在聲音顯示中縮小或放大，請首先按一下並選取記錄，然後使用「Hori zontal Zoom」（水平縮放）或「Vertical Zoom」（垂直縮放）「 +」或「 -」按鈕。放大提供更多詳情。縮小提供更少詳情。垂直縮放還可以提 高或降低記錄音量，因為它可以影響記錄的圖像和聲音振幅。
如果水平放大，您可以使用「Pa n」（平移）按鈕流覽記錄。若要向左移動記錄，按一下「Pa n Left」（向左平移）按鈕即可。若要向右移動記錄，按一下「 Pan Right」（向右平移）按鈕即可。也可以使用工具列上的「Dr ag」
（拖曳） 按鈕向左平移或向右平移聲音顯示。您可以按一下此手形按鈕，將滑鼠游標放置在聲音顯示上，
向希望捲動的方向拖曳游標，即可向左平移或向右平移錄音。再次按一下「Dr ag」（拖曳） 按鈕即可停用此功能。 

4.2 光譜圖選項
光譜圖是一個時間 -頻率分佈圖，代表著一個隨著時間和頻率改變之二維彩色圖的聲音能量分佈圖。黑色代表最小能量，紅色代表最大能量。 X軸代表時間指數， Y軸代表 0 - 500 Hz的線性頻率。光譜圖提供了一個額外的角度去檢視錄製的聲音。如欲查看用光譜圖模式的聲音顯示圖，請點擊位於聲音顯示圖左
側的「S pectrogram」（光譜圖） 圖標。如欲返回標準模式的聲音顯示圖，請點擊位於顯示圖左側
的「Phonocardiogram」（心音圖） 圖標。 
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4.3 播放錄音內容
按一下「Pl ay」（播放）按鈕開始播放。一個紅色游標將隨記錄同步捲動跨越聲音顯示。按一下「St op」（停止）按鈕可結束播放。
預設狀況下，軟體將透過 Littmann® 3200型聽診器（如果已連結）播放錄音。若要透過電腦揚聲器、外接揚聲器或耳機播放錄音，請按一下「Pl ay to Headphones」（播放到耳機）核取方塊。
小心： 考慮到電腦音效卡、音效卡驅動器和/ 或耳機/ 揚聲器的頻率反應不同，透過電腦揚聲器或電腦耳機插孔播放的音質可能無法精確的呈現所錄製的生理聲音。 強烈建議將 3M™ Littmann®聽診器 

3200型來聽錄下的生理聲音。
注意： 初次錄音時，錄音的振幅或音量可能會小於聽到的聲音。 可以使用波形圖 Y軸或聽診器鍵盤上的「+」按鈕來提高音量。

4.4 「½ Speed」（半速）
「½ Speed」（半速）選項使您能夠半速播放記錄，並且信號的頻譜特性不會發生明顯變化。按一下「 ½ Speed」（半速）按鍵，然後按一下「 Play」（播放）按鈕，可半速播放錄音檔。一旦按一下，「 ½ Speed」（半速）按鍵將保持啟動，直到再次按一下為止。

小心： 「 ½ Speed」（半速）播放功能有助於分辨生理情況，但不應單獨使用於進行生理診斷。
4.5 播放錄音檔的特定部分

如欲播放錄音的特定部分，只需用滑鼠在要開始播放的聲音顯示區域上按一下，然後將滑鼠拖曳到右側，以醒目標示感興趣的區域。一旦標示好了，則點擊一下「 Play」（播放）按鍵即可聆聽特定部分。請注意，您必須選取一個至少一秒長的聲音片段，才能使此功能發揮作用。在聲音顯示區域的任何地方左鍵按一下可清除標示區域。 

4.6 循環播放
「Loop」（循環播放）按鍵顯示在螢幕頂部，使您能夠以循環播放（將持續到按一下「 Stop」（停止）按鈕時為止）的方式播放整段記錄或者記錄的特定部分。若要以循環播放模式播放完整的記錄，請按一下並選取對應的聲音顯示，按一下「 Loop」（循環播放）按鍵，然後按一下「 Play」（播放）按鍵。若要以循環播放模式播放記錄的特定部分，請使用游標在聲音顯示區域醒目標示感興趣的區域，按一下「 Loop」（循環播放）按鍵，然後按一下「 Play」（播放）按鍵。一旦按一下，「 Loop」（循環播放）按鍵將保持啟動，直到再次按一下為止。 

4.7 全域縮放
全域縮放功能可以將儲存在單一組錄音裡的所有錄音檔標準化。使用者因此能夠精確地比較多個錄音檔之間的振幅。 

4.8 列印功能
如欲列印一份「患者錄音報告」，可利用點擊「 Print」（列印）按鍵來列印。列印出的報告將顯示患者 ID、患者姓名（如果已輸入）以及用於錄音的聽診器 ID。該報告也將包含姿勢、聽診位置和錄音時間，以及輸入的所有對應使用者註釋。 

4.9 增加註釋到檔案中
在「Detailed View」（詳細檢視圖）時，您可以在患者身分識別碼 (ID)左側，利用點擊「註釋」選項以增加註解到錄音檔中。註釋按鈕上會有一個綠色打勾符號在此選項旁，表示錄音檔案中有增加註釋。 
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5. 儲存、開啟以及匯出記錄 

5.1 儲存記錄
在螢幕左上角按一下「Sa ve」（儲存）按鈕，或者從「 File」（檔案）功能表選取「 Save」（儲存）。如果啟動新記錄或者現有軟體程式，St ethAssist軟體將自動提示您是否儲存記錄。 

5.2 開啟以前記錄的錄音檔
在螢幕左上角按一下「Op en」（開啟）按鈕，或者從「 File」（檔案）功能表選取「 Open」（開啟）。在標題上按一下以按此欄位歸類。 

5.3 將記錄匯出為 .wav 檔案
若要以 .wav檔案格式匯出記錄，請從「 File」（檔案）功能表選取「 Export recording as .wav」（將記錄匯出為 
.wav）。 .wav檔案格式非常普遍，可以使用大多數電腦媒體播放機進行播放。請確認選取了應用於記錄的過濾模式，例如鐘面模式、膜面模式或全頻模式。 

6. 瀏覽功能選項
3M™ Littmann® StethAssist™軟體含以下功能表選項：檔案 工具 檢視圖 說明

6.1 檔案
檔案 >儲存儲存目前記錄集。
檔案 >開啟開啟一個以前的記錄集。
檔案 >關閉關閉目前記錄集。
檔案 >新會話開始一條新患者記錄。
檔案 >註釋開啟註釋視窗。
檔案 >從聽診器匯入從聽診器的記憶體匯入一條記錄。
檔案 >將儲存的記錄匯入到目前的目錄將以前儲存的記錄檔從電腦上的其它位置轉移到目前記錄目錄。將檔案移出目前的目錄將提高程式啟動速度，減少開啟以前儲存檔的時間。
檔案 >匯出儲存的記錄將以前儲存的記錄檔從目前記錄目錄轉移到電腦上的其它位置。將檔案移出目前的目錄將提高程式啟動速度，減少開啟以前儲存檔的時間。
檔案 >匯入 e4k檔案以 .e4k格式匯入檔案。 .e4k檔案格式用於以前的 3M™ Littmann®電子聽診器 4000型和 4100型。
檔案 >將記錄匯出為 .wav開啟「 File Export」（檔案匯出）視窗，以 .wav檔案格式儲存記錄。
檔案 >列印報告為指定記錄集列印患者錄音報告。
檔案 >最近查看過的開啟一個最近查看過的記錄集。
檔案 >結束結束 StethAssist應用程式。 
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6.2 工具
工具 >新增聽診器開啟「A dd New Stethoscope」（新增聽診器）視窗。 
工具 >聽診器設定 開啟「 Stethoscope Settings」（聽診器設定）視窗，您可以在該視窗中執行以下操作：  

•	 刪除一個已配對的聽診器。 
•	 更改聽診器名稱。 
•	 調整「提前期」長度或在聽診器上按 (M)按鈕後 StethAssist™軟體開始記錄之前的等待時間。提前期選項： 0、1、2或 4秒。 
•	 選取預設患者姿勢。 
•	 選取預設記錄長度。 
•	 選取預設值的畫面（摘要的或詳細的）。

工具 >選項 更改儲存記錄的預設目錄和 /或更改預設語言。  

6.3 檢視圖
選取詳細或摘要檢視圖 

6.4 說明
說明 >線上說明開啟一個網際網路瀏覽器並連結到 StethAssist網頁 www.littmann.com/StethAssist


說明 >使用者手冊 開啟軟體使用者手冊。 
說明 >瞭解 Littmann®產品開啟一個網際網路流覽器並連結到 Littmann.com


說明 >關於 查看產品版本號以及請求獲得更多資訊或進行服務查詢的電話號碼和地址。 
說明 >查看最新版本 查看 StethAssist的新版本。 
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7. 改善記錄音質
記錄的音質取決於環境、患者和使用者技術：
聲音環境：
在盡可能安靜的環境中執行聽診程序。仔細傾聽，找出背景聲音，例如透過開啟的窗戶傳入的交通噪音或者風扇與空調的噪音，盡可能消除這些噪音。確保沒有背景談話，並且在記錄時防止打斷。
患者：
如果可能，應對患者進行正確的聽診前準備，以便讓聽診器直接接觸患者的皮膚。要求患者在整個記錄過程中盡可能保持安靜。
聽診器的放置與操作：
使用 Littmann® 3200型聽診器時，以下幾項重要技巧，將可以有效改善您的聽診經驗。
聲音感應器 (採集所有聲音的地方) 十分小巧，其位於聽頭的正中央（如需展示，您可以剝離聽頭薄膜而看到白色標籤下的凹口處即為身音感應器）。聲音感測器周圍的區域與收音無關。因此，務必將聽頭的正中央對準患者的接觸點是很重要的。
使用 Littmann® 3200型聽診器只需輕輕持握。這也包括接觸病人時。對患者施加過大壓力可能導致人為噪音。
接觸患者必須保持穩定和一致，以確保有最佳聲音品質。移動聽頭會引起少量摩擦噪音。
以較低音量來開始進行您的聽診是最佳方式。如果您試圖收聽那些難以聽到的聲音，請調整放大音量。視需要使用音量放大功能將有助於降低檢查中的干擾噪音。
最後，很重要的是請務必瞭解非電子和電子聽診器之間握持技巧的不同。輕輕握住 Littmann® 3200型聽診器，輕輕接觸患者，對準聽頭中間的接觸點，再保持穩定，從而確保聽診的最佳音質。 
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問題
8. 疑難排解

無法連結聽診器
可能原因
未安裝 USB藍牙無線介面卡 /USB藍牙無線介面卡安裝不正確

解決方法
插入 USB藍牙無線介面卡。停用內部電腦藍牙無線電收發器。將藍牙驅動程式更新為 Generic 
Bluetooth Adaptor

聽診器未配對 配對聽診器。從主螢幕上的「 Tools」（工具）功能表中選取「 Add New Stethoscope」（新增聽診器）
每個獨一無二的聽診器 ID只能代表一個聽診器 如果您的辦事室擁有多個聽診器，確保您連結到正確的聽診器 ID。
不明原因 關閉聽診器，等待幾秒鐘，然後重新開啟聽診器並再次嘗試。

嘈雜的錄音訊號 過多的背景雜音 採取措施以降低聽診環境中的背景雜音。
在顯示圖中所示的信號被截斷 嘈雜的錄音 請參閱本使用者手冊第 7節，標題為「改善錄音音質」。
不良的收訊品質報告 過多的背景雜音 採取措施以降低聽診環境中的背景雜音。

聽診器過度移動 用手握穩聽診器，並在聽診時輕輕壓在患者皮膚上。
如果您有關於 3M™ Littmann® StethAssist™軟體或 Littmann® 3200型聽診器的問題或疑問，請聯繫我們的客戶服務熱線 1-800-228-3957，或者查找所在國家 /地區 3M™ Littmann® Stethoscope網站 
www.Littmann.com中的「F requently Asked Questions」（常見問題集）和「 Contact Us」（聯繫我們）頁。 

3M 醫療保健產品事業群 
Littmann®品牌產品 
3M Center, Building 275-4E-01 
2510 Conway Ave. 
St. Paul, MN 55144 
1-800-228-3957 
www.littmann.com 

3M, Littmann, and StethAssist are registered trademarks of 3M, used under license in Canada. 
Windows is a registered trademark of Microsoft. Bluetooth is a registered trademark of the Bluetooth SIG, Inc. 
Mac is a registered trademark of Apple Inc. 

© 2017 3M.保留所有權利。 
34-8721-7685-3 
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1. 일반 정보 

1.1 용도 
3M™ Littmann® StethAssist™ 심음 및 폐음 시각화 소프트웨어는 ™ Littmann® 전자 청진기 모델 3200 과함께  사용하여심 음및기타생 리학적  음향신호를녹 음하고표시할  수있습니다.   이장치는  진찰실  환경에서사 용해야합니다. 이장치는  진단도구로  사용할수없 습니다.   이제품은  임상학적결과또는분석을보 고하지  않습니다.   

1.2 안전 정보 

용도 문의 

이소프트웨어를사용하기전에  본지침에포 함된모 든안전정보를  읽고,   이해하고 , 준수해 주십시오.  이설명서를나 중에  참고할수있도록보 관하십시오.   

본사용설명서에사 용된주 의또는참고사 항은네 모  칸안에있으며다음과같 은중 요성을  지닙니다.   

주의: 소프트웨어가 사용자에게 부정확하거나 불완전한 정보를 나타낼 수 있는 상황을 나타냅니다.  

참고: 중요하므로 강조해야 한다고 생각되는 정보 . 

1.3 시스템 요구 사항 및 사양 
컴퓨터 요구 사항 : 

• Windows  7  32  비트, Windows  7  64  비트, Windows 8 32 비트, Windows 8 64 비트 , Windows 10 32 비트, 
Windows 10 64 비트. 

• Mac  OS  10.12  
• 1024MB  이상의 RAM 
• Intel Core 2 Duo 호환또는상위  버전  
• 1024 x 768 이상의 그래픽 디스플레이 해상도 
• USB  Bluetooth  무선어댑터를지원하는 USB 1.1 이상 포트 

1.4 환자 개인정보보호 
개인적으로  식별가능한  특정  건강  정보의  보호및보안은이러한  정보를  사용  ,  공개, 저장, 전송하는 방법을 규제 및 제한하는 주법 , 정부법 , 국제법 , 해외법에 의해 보호될 수 있습니다 . 일부 경우에서는 제 3자가사전  서면허가를  먼저  획득하지  않고  이러한  정보에  액세스하지못하도록  금지할수도있습니다  .  

이소프트웨어를사용하여  개인적으로  식별가능한  건강  정보를  전자형태로  저장하고  전송할  수있는  방법에  영향을주는모든법을  판별하고  이해하고  준수하는것은  전적으로  사용자의  책임입니다  .  이 소프트웨어를 통해 개인적으로 식별 가능한  개인  정보의  사용및공개  (전송 포함 )에적용되는  법이나  제한사항을  준수할  수없다고  판단되면  이러한  정보의  저장을 계속 진행하지 마십시오 . 정보를 계속 저장하면 , 사용자가  사운드파일을  포함하여  전자형태또는  그  외  다른  형태로 이러한 정보의 사용 , 저장 및 /또는전송과  관련된  모든위험  ,  책임 및 법적 책임을 지는 것으로 가정합니다 . 
이 프로그램을 작동하기 위해 개인적으로 식별 가능한 건강 정보를 입력할 필요는 없습니다 . 타임 스탬프나 임의로 할당된 식별자를 사용하여 기록을 저장하고 불러올 수 있습니다 . 의미가  있는  환자이름또는환자 ID 를입력하도록  선택하면 , 이소프트웨어를통해  이러한  개인적으로  식별가능한  건강  정보의  전송  및저장으로  인해  발생되는  모든위험및법적책임에  동의하는  것으로  간주되며  ,  여기에는  이러한  개인적으로  식별가능한  건강  정보의  보호및보안에  대한  위험이 포함됩니다 . 
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2. 시작
2.1 3M™ Littmann® StethAssist™ 소프트웨어 설치 및 등록

컴퓨터에 3M™ Littmann® StethAssist™소프트웨어를설치하려면다음단계를따르십시오.

1. www.Littmann.com/StethAssist로이동합니다.
2. Download StethAssist(StethAssist다운로드)링크를클릭합니다.
3. 표시되는메시지상자에서 Run(실행)을클릭합니다.
4. 설치지침을따릅니다.
5. 온라인등록을완료합니다.

참고: 등록을오프라인으로완료하려면, 1-800-228-3957또는
littmannsoftwaresupport@mmm.com으로연락하여 E703M™ Littmann®

고객지원센터로문의하십시오.

2.2 USB Bluetooth 무선 어댑터(동글) 삽입
USB Bluetooth무선어댑터를설치하려면장치를컴퓨터의 USB포트에삽입합니다. USB Bluetooth무선어댑터는이소프트웨어가설치된컴퓨터와 3M™ Littmann®전자청진기모델 3200간의통신을지원합니다. USB Bluetooth무선어댑터는일반적으로통용되는 Bluetooth®단거리무선연결표준을통해데이터를받고전송합니다.

청진기를연결하려면, 3M™ Littmann® StethAssist™ 소프트웨어를 실행하기 전에 USB Bluetooth 무선 어댑터를컴퓨터에 삽입해야 합니다.소프트웨어에서 USB Bluetooth무선어댑터를감지하지못할경우,다음과같은메시지가표시됩니다.이메시지가표시되면, USB Bluetooth무선어댑터를삽입한다음 StethAssist소프트웨어를닫고다시실행합니다.
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2.3 청진기를 소프트웨어에 페어링 및 연결하기 
청진기를 소프트웨어에 페어링 및 연결하는 과정을 지원하는 다음 화면이 표시됩니다 . 

2.3.1 새청진기  페어링  

Littmann® 모델 3200 청진기를 3M™ Littmann® StethAssist™ 소프트웨어에 처음 연결하려면,  먼저청진기를 소프트웨어에 페어링해야 합니다. 새청진기를페 어링하려면,   드롭다운 메뉴에서 “Add New 
Stethoscope”( 새청진기  추가) 를선택하고 P air( 페어링 )를클릭합니다( 또는 기본 화면의 Tools( 도구) 메뉴에서 
Add New Stethoscope( 새청진기  추가)   선택). 화면에 표시되는 지침을 따릅니다.  청진기가 페어링되면, 소프트웨어가 자동으로 청진기에 연결됩니다.  이후소프트웨어를실행할  때마다,   간편하게 청진기에 연결됩니다.  

2.3.2 청진기 연결 

이전에 페어링한 청진기를 연결하려면 , 드롭다운 메뉴에서 해당 청진기 이름을 선택하고 Connect( 연결)를클릭합니다 . 청진기에서 (M) 버튼을  두번누르고  “CONNECT”( 연결)를선택합니다  .  청진기를 소프트웨어에 연결하려고 할 때마다 아래 화면이 표시됩니다 . 
청진기를 연결하지 않고 녹음을 검토하려면 Cancel( 취소)을클릭합니다  .  
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어떤 청진기가소프트웨어에연결하려고하는지나타냅니다 . 

청진기에 연결되면,  Stethoscope Connection( 청진기 연결 ) 버튼에 초록색 확인 표시가 나타납니다 . 연결되지 

않으면,  Stethoscope Connection( 청진기 연결 ) 버튼에 빨간색 X 표시가 나타납니다 . 

참고: 무선 연결을 최적화하려면 아래 팁을 따르십시오 . 
1. USB 무선  어댑터와  최대한  가까운  거리에서환자를청진합니다.
2. 청진기와 USB Bluetooth 무선  어댑터  사이를  물체나  사람으로  가로막지  않도록  합니다.
3. 손으로 청진기의 전체 체스트피스 (청진기의 Bluetooth® 안테나가 있는 위치) 를가리지않도록 합니다 

참고:  3M™  Littmann® StethAssist™ 소프트웨어에  여러개의청진기를페 어링할  수있으나,   한번에청 진기한개만연결할수있 습니다.   청진기는  한대의컴퓨터에만연 결할수있 습니다.   
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3. 청진기에서 새 녹음 만들기 또는 녹음 가져오기
녹음 설정 창

환자자세선택

드롭다운 메뉴에서 녹음 위치를선택하거나파란색  상체를클릭하여수동으로 위치를 지정합니다 . 다른이미지로 전환하려면 , 다른 축소판 보기를 클릭합니다 . 

녹음 길이 선택 (5~60 초) 

환자정보입력  (선택 사항 ) 

3.1 새 녹음 만들기 
3.1.1. 새녹음을시작하려면,  New Encounter( 새로 입력)  버튼을 클릭합니다. R ecording Set-up( 녹음 설정) 창에서 Patient ID( 환자 ID) 및 Patient Name( 환자 이름 )을입력합니다.( 선택 사항이며 , 섹션 1.4 의환자  개인정보보호를 참조하십시오 .) 환자 ID 에는  모든문자와숫 자조합을포 함할  수있으며최대 20 자까지 입력 가능합니다.  환자 ID 에는 a~z, 0~9 및 _ 문자만 사용 가능합니다.  

3.1.2. 녹음 길이,  녹음위치및환 자자세를  선택합니다.   그런 다음 OK( 확인)를클릭합니다. 

3.1.3. 원하는 환자 위치에서 좋은 음질을 얻은 다음,  청진기의 (M) 버튼을 클릭하여 녹음을 시작합니다.  

3.1.4. 녹음을 재시작하려면 청진기의 (M) 버튼을 눌러 녹음을 중지한 다음, ( M)  버튼을 다시 눌러 녹음을 재시작합니다.  

3.1.5. 녹음이 완료되면, “ Add Recording”( 녹음 추가)  버튼을  클릭하여동 일한환 자에대 한또다 른녹음을생성할 수 있습니다.  다른환자에대 한녹 음을만들려면, “ New  Encounter”(  새로 입력)  버튼을 선택합니다.  
3M™ Littmann® StethAssist™ 소프트웨어가 현재 녹음 설정을 저장할지 자동으로 묻습니다.  

3.1.6. Summary view( 요약 보기 )를클릭하여환 자에대 한  설명을  입력합니다( 선택 사항 ). 

참고: 청진기의 볼륨은 녹음 볼륨 수준에 영향을 미치지 않습니다 . 또한 녹음 과정에서 어떠한 필터를 사용했는지에 상관없이 , 녹음결과물은  세가지  모든필터  설정  (Bell( 벨), Diaphragm( 다이어프램 ), 
Extended Range( 연장 거리 }에서 재생할 수 있습니다 . 
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드롭다운메뉴에서녹음위치를선택하거나파란색상체를클릭하여수동으로위치를지정합니다. 다른이미지로전환하려면,다른축소판보기를클릭합니다.

녹음길이선택(5~60초)

환자정보입력(선택사항)



3.2 청진기 메모리에서 녹음 가져오기 
Littmann® 모델 3200 청진기의 온보드 메모리에서 저장된 녹음을 소프트웨어로 전송하려면, I mport(  가져오기 )를클릭하거나 File( 파일) 메뉴에서 Import From Stethoscope( 청진기에서 가져오기 )를선택합니다.   아래단계를 따릅니다.  

1. 가져오려는 녹음된 트랙을 선택합니다.  2. 환자 정보를 입력합니다 
(선택 사항 ).3. Play( 재생) 아이콘을 클릭하여 트랙설명을 듣습니다 (트랙 설명이 있는 경우). 참고: 청진기이 어팁을통해트랙설명이재생됩니다. 4. 환자녹음위치를입력합니다.( 선택 사항 ) 

5. 환자 자세를 입력합니다 (선택 사항 ).

6. 녹음된 모든 트랙에 대한 정보를 입력한 후 , 
Import Selected( 선택 항목 가져오기 )를클릭합니다. 

녹음된 트랙을듣습니다 (선택사항). 

청진기 메모리에녹음된 트랙을잠금 또는 잠금해제합니다 (선택사항). 

청진기 메모리에서녹음된 트랙을삭제합니다 (선택사항). 
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녹음된트랙을듣습니다(선택사항).

청진기메모리에녹음된트랙을잠금또는잠금해제합니다(선택사항).

청진기메모리에서녹음된트랙을삭제합니다(선택사항).



4. 녹음 검토
Detailed View (상세 보기 ) 

끌어오기 .마우스 커서를사용하여 사운드디스플레이를왼쪽 또는오른쪽으로끌어올 수 있음 . 

필터 선택 

트랙 설명 

녹음 삭제 

다시 녹음 

설명 추가 

재생 

파일 열기 

파일 저장 새입력  시작 보기전환 

온보드메모리에서 녹음가져오기 

트랙을 ½속도로 재생 

컴퓨터 오디오 잭또는 스피커를 통해재생 
전역 조정으로 모든녹음 평균화 

트랙계속반복

청진기 연결표시기 

사운드 디스플레이의심음도 보기 
사운드 디스플레이의스펙트럼 보기 

왼쪽으로 이동 오른쪽으로 이동 

세로 확대 /축소 

가로 확대 /축소 

기존 입력에 녹음추가 

4.1 신호 이동 및 확대/축소 
사운드디스플레이내에서  확대하거나축소하려면  ,  우선사운드디스플레이에서  녹음을선택한  다음  가로확대  /축소또는 세로 확대 /축소의 “+” 또는 “-” 버튼을 사용합니다 . 확대하면 더욱 자세한 내용을 표시되고 , 축소하면 다소 간단한 내용이 표시됩니다 . 세로 확대 /축소는또한  녹음의  시각적  모양  및  가청  진폭에영향을  미치므로녹음  볼륨을  높이거나  줄일 수 있습니다 . 
가로로 확대하면 , Pan(  이동) 버튼을  사용하여  녹음내용을  스크롤할  수있습니다  .  녹음을 왼쪽으로 이동하려면 , 
Pan Left( 왼쪽으로 이동 ) 버튼을 클릭합니다 . 녹음을 오른쪽으로 이동하려면 , Pan  Right(  오른쪽으로 이동 ) 버튼을 

클릭합니다.  도구 모음에 있는 끌어오기 버튼을  사용하여사 운드디스플레이를  통해왼 쪽및오른쪽으로이동할  수도 있습니다.  이손모양의  버튼을  클릭할  경우,   사운드디스플레이에마우스  커서가놓 이게되 며그다 음  스크롤하려는
방향으로커 서를  끌어오면모 든녹음내용을  왼쪽또는오른쪽으로이동할  수있습니다.   끌어오기 버튼을다시한번클릭하면 이 기능이 비활성화됩니다.  

4.2 스펙트로그램 디스플레이 옵션
스펙트로그램은시간과주파수의추이에따라분포되는사운드에너지를 2차원색채도표로나타낸시간주파수분포도입니다.검정색은최소에너지를나타내고빨간색은최대에너지를나타냅니다. x축은시간지수를나타내고 y축은 0~500Hz범위의선형주파수를나타냅니다.스펙트로그램은녹음된사운드에대한추가적인정보를제공합니다.

스펙트로그램모드에서사운드디스플레이를보려면,사운드디스플레이의왼쪽에표시되는스펙트럼 버튼을
클릭합니다.기본사운드디스플레이보기인표준으로돌아가려면,사운드디스플레이의왼쪽에표시되는심음도버튼을클릭합니다.
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트랙설명

녹음삭제

다시녹음

설명추가
재생

사운드디스플레이의심음도보기 사운드디스플레이의스펙트럼보기 왼쪽으로이동 오른쪽으로이동

세로확대/축소
가로확대/축소



4.3 녹음 재생 
Play( 재생) 버튼을 눌러 재생을 시작합니다.  빨간색커 서가  녹음내 용과  동시에  움직이며사 운드디 스플레이에  스크롤됩니다.  재생을 끝내려면 Stop( 중지) 버튼을 클릭합니다.  
기본적으로 , 이 소프트웨어는 Littmann® 모델 3200 청진기를 통해 사운드 트랙을 재생합니다 (연결된 경우). 컴퓨터 스피커,  외장스피커  또는헤드폰을  통해사 운드트랙을  재생하려면 Play to Headphones( 헤드폰으로 재생 )확인란을 클릭합니다.  

주의:  PC  스피커 또는 PC 오디오 잭을 통해 재생된 오디오 음질이 PC 사운드 카드의 음향 성능,  사운드 카드 드라이버 및 /또는 헤드폰/ 스피커의  주파수  반응으로인해  실제  소리를  충실히  재생하지못하여,   잠재적으로 임상적으로 관련된 소리를 듣지 못하게 될 수 있습니다. 3 M™ Littmann® 청진기 모델 3200 를사용하여  녹음된  사운드를  듣을  것을강력히권장합니다.   

참고: 녹음된  사운드의  진폭또는볼륨은  최초녹음과정에서  들었던  것보다  작을  수있습니다  .  볼륨을 높이려면 파형 그래프의 세로 축 또는 청진기 키패드의 "+" 버튼을 사용합니다 . 

4.4 ½ 속도 
½ 속도옵션을  사용하면  신호의  스펙트럼  속성은  크게변동되지  않은  상태에서  녹음을절반  속도로  재생할  수있습니다  .녹음을 절반 속도로 재생하려면 ½ Speed(½ 속도) 확인란을 클릭한 다음 , Play(  재생) 버튼을 클릭합니다 .  ½  Speed(½  속도) 확인란을 클릭하면 , 다시클릭하기전까지  계속  활성화된상태를  유지합니다  .  

주의: ½  속도  옵션은  생리학적  현상의  파악을  지원하기  위해  제공되는  기능이지만  ,  생리학적 진단을 수행하는 과정에단독으로  사용할수  없습니다  .  

4.5 녹음의 특정 부분 재생 
녹음의 특정 부분을 재생하려면,  재생을 시작하려는 사운드 디스플레이의 영역을 마우스로 클릭한 다음 오른쪽으로마우스를  끌어와  관심있는영 역을강 조표시합니다.   이러한  방법을통해사 운드디스플레이의한영역을강 조표시한  후에는, P lay(  재생) 버튼을 클릭하여 특정 섹션을 듣습니다.  이 기능이 제대로 작동하게 하려면 최소한 1초간의 사운드 구역을 선택해야 합니다.  사운드디스플레이의아무곳이나마 우스  왼쪽버튼으로  클릭하여강 조표시한  영역을 해제합니다.  

4.6 반복되는 재생 
화면 상단에 표시되는 Loop( 반복) 확인란을 사용하면 , 전체  녹음  또는  녹음의  특정  부분을  반복적으로  재생하여 Stop( 중지) 버튼을 클릭할 때까지 지속되도록 할 수 있습니다 . 반복 모드에서 전체 녹음을 재생하려면 , 해당하는 사운드 디스플레이를 선택하고 Loop( 반복) 확인란을 클릭한 다음 , Play(  재생) 버튼을 클릭합니다 . 반복 모드에서 녹음의 특정 부분을 재생하려면 , 커서를  사용하여  사운드디스플레이에서  관심영역을  강조표시하고 Loop( 반복) 확인란을 클릭한 다음 , Play(  재생) 버튼을 클릭합니다 . Loop( 반복) 확인란을 클릭하면 , 다시클릭하기전까지  계속  활성화된  상태를 유지합니다 . 

4.7 전역 조정 
전역  조정기능은  하나의  녹음집합내에포함된  모든녹음을평균화합니다  .  사용자는 이 기능을 사용하여 여러 녹음의 진폭을정확하게  비교할수  있습니다  .  

4.8 인쇄 기능 
특정  녹음또는녹음집합에  대한 “환자 입력 보고서 ”의사본을  인쇄하려면  , Print(  인쇄) 버튼을 클릭합니다 . 결과인쇄물에는 환자 ID, 환자 이름 (입력한 경우 ), 녹음에 사용된 청진기의 ID 가표시됩니다  .  또한  이보고서에는자세  목록  ,청진 위치 , 문제의 녹음의 시간 길이가 입력된 해당 사용자 설명과 함께 표시됩니다 . 
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4.9 녹음에 설명 추가 
“Detailed View”( 상세 보기 )에서, Summary view(  요약 보기 )로전환하거나환 자 ID 의왼쪽에  있는 “Comments”( 설명) 버튼을  클릭하여사 운드파일에  대한설 명을추 가할  수있습니다. C omments(  설명) 버튼의 초록색 확인 표시는 녹음에대한설 명이있음을나 타냅니다.   

5. 녹음 저장, 열기 및 내보내기 

5.1 녹음 저장 
화면왼쪽상 단모서리의 “Save”( 저장) 버튼을 클릭하거나 File( 파일) 메뉴에서 “Save”( 저장)를선택합니다.   새 녹음을 시작하거나소프트웨어  프로그램을  종료할경우, S tethAssist  소프트웨어에서녹음을저장할것 인지여 부를  묻는창을  자동으로 표시합니다.  

5.2 이전에 녹음된 사운드 파일 열기 
화면왼쪽  상단모서리의 “Open”( 열기) 버튼을 클릭하거나 File( 파일) 메뉴에서 “Open”( 열기)을선택합니다  .  해당필드로정렬하려면머리글을  클릭합니다  .  

5.3 녹음을 .wav 파일로 내보내기 
녹음을 .wav 파일 형식으로 내보내려면 , File(  파일) 메뉴에서 Export recording as .wav( 녹음을 .wav 로내보내기  )를선택합니다  . .wav 파일은 매우 일반적인 형식므로 대부분의 컴퓨터 미디어 재생장치에서 재생할 수 있습니다 . 반드시 녹음에적용된  필터를선택해야  합니다  (예:  Bell(  벨), Diaphragm( 다이어프램 ) 또는 Extended( 연장)). 

6. 메뉴 탐색 

3M™ Littmann® StethAssist™ 소프트웨어에는 다음과 같은 메뉴 선택 사항이 포함되어 있습니다.  
File( 파일) Tools( 도구)  View(  보기)  Help(  도움말 ) 

6.1 파일 
File( 파일) >  Save(  저장)현재녹음집합을저 장합니다.   
File( 파일) >  Open(  열기)이전녹음집합을  엽니다  .  

File( 파일) >  Close(  닫기)현재녹음집합을닫 습니다.   
File( 파일) > New Encounter( 새로 입력) 새로운환 자녹음을시작합니다.   
File( 파일) >  Comments(  설명)설명 창을 엽니다.  
File( 파일) > Import From Stethoscope( 청진기에서 가져오기 )청진기의 온보드 메모리에서 녹음을 가져옵니다.  
File( 파일) > Import Saved Recording(s) to Current Directory( 저장된녹 음을현재디렉토리로가져오기) 이전에저 장된녹 음파일을컴 퓨터의  다른위치에서  현재녹음디렉토리로이동합니다.   현재디렉토리에서파일을옮 길경우 프로그램 시작 속도가 빨라질 뿐만 아니라 이전에 저장된 파일을 여는 데 걸리는 시간도 줄어듭니다.  
File( 파일) > Export Saved Recording(s)( 저장된 녹음 내보내기 )이전에저 장된녹 음파일을현 재녹음디렉토리에서컴 퓨터의  다른위치로  이동합니다.   현재디렉토리에서파일을옮 길경우 프로그램 시작 속도가 빨라질 뿐만 아니라 이전에 저장된 파일을 여는 데 걸리는 시간도 줄어듭니다.  
File( 파일) > Import e4k File(e4k 파일 가져오기)  
e4k 형식으로 파일을 가져옵니다. e 4k 파일은 이전의 3M™ Littmann® 전자 청진기 모델 4000 및4100 에서사용되던 형식입니다.  
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File( 파일) > Export recording as .wav( 녹음을 .wav 로내보내기)   
File Export( 파일 내보내기)  창을열고녹음을 .wav 파일 형식으로 저장합니다.  
File( 파일) > Print Report( 보고서 인쇄) 특정 녹음 집합에 대한 Patient Encounter Report( 환자 입력 보고서 )를인쇄합니다.   
File( 파일) > Recently  Viewed(  최근에 본 파일 )최근에본녹 음집합을엽 니다.   
File( 파일) >  Exit(  종료) 
StethAssist 애플리케이션을 종료합니다.  

6.2 도구 
Tools( 도구) > Add New Stethoscope( 새청진기  추가)   
“Add New Stethoscope”( 새청진기  추가)   창을 엽니다.  
Tools( 도구) > Stethoscope Settings( 청진기 설정 ) 
Stethoscope Settings( 청진기 설정 ) 창에서 다음 작업을 수행할 수 있습니다.  

• 페어링된 청진기를 삭제합니다.  
• 청진기 이름을 변경합니다.  
• 청진기의 (M) 버튼을 누른 후 StethAssist™ 소프트웨어가 녹음을 시작하기 전에, “ 소요 시간”  또는대기시간의  길이를 조정합니다.  소요 시간 옵션은 0, 1, 2  또는 4초입니다.  
• 기본 환자 자세를 선택합니다.  
• 기본 녹음 길이를 선택합니다.  
• 기본 보기 (요약또는상세) 를선택합니다.   

Tools( 도구) >  Options(  옵션)녹음이저장되는기 본  디렉토리를변 경하거나기본언 어를  변경합니다.   

6.3 보기 
Detailed View( 상세 보기 ) 또는 Summary View( 요약 보기 ) 중선택합니다  .  

6.4 도움말 
Help( 도움말 ) > Online Help( 온라인 도움말) 인터넷 브라우저를 열고 StethAssist 웹 페이지 (www.littmann.com/StethAssist)에연결합니다.   
Help( 도움말 ) > User  Manual(  사용 설명서) 소프트웨어 사용 설명서를 엽니다.  
Help( 도움말 ) > Learn About Littmann® Products(Littmann® 제품 정보) 인터넷 브라우저를 열고 Littmann.com에연 결합니다.   
Help( 도움말 ) >  About(  정보)제품  버전번호와  함께제공되는  추가정보  또는서비스문의를위한전화  번호및주소를  확인합니다  .  

Help( 도움말 ) > Check for Latest Version( 최신 버전 확인 ) 
StethAssist 의최신  버전을  확인합니다  .  
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7. 녹음 품질 개선 
녹음 품질은 해당 환경 , 환자, 사용자의 기술에 따라 달라집니다 . 

음향 환경: 
최대한 조용한 환경에서 청진 절차를 진행합니다 . 열린 창문을 통해 들어오는 자동차 소음이나 선풍기 , 에어컨으로 인해 발생하는  주변  소리를  주의깊게듣고  ,  이러한  소음을최대한  제거해  주시기바랍니다  .  옆에서  대화를  하지  않도록  해  주시고  녹음도중  방해가  되지않도록  하십시오  .  

환자: 
가능한 경우 , 환자가올바르게  준비된  상태여야  환자의  피부에청진기를  직접접촉할수있습니다  .  환자에게 녹음하는 동안 최대한 가만히 있도록 안내해야 합니다 . 

청진기 놓는 위치 및 조작법:  
Littmann® 모델 3200 청진기를 사용할 때에는,  청진경험을  대폭  향상시킬수있 는여 러가지  기법을  고려하는  것이 중요합니다.  
모든 소리를 획득하는 소리 센서는 크기가 매우 작으며 체스트피스 정중앙에 있습니다 .(시연을 위해 , 다이어프램을 벗겨내면흰색스티커  아래에  자국을  볼수있습니다  .) 소리  센서  주변  영역에서는  소리가  잡히지  않습니다  .  따라서 ,환자와  접촉점을  체스트피스  정중앙에  두는것이중요합니다  .  

Littmann® 모델 3200 청진기는 살짝만 접촉하면 됩니다.  이것은 청진기 취급과 환자 접촉 모두에 해당됩니다.  환자 몸에 세게누 르면인 공음이  들릴수있습니다.   
최적의 음질을 위해서는 환자와의 접촉이 안정적이고 일관되어야 합니다 . 체스트피스를 움직이면 마찰음이 발생합니다 . 
낮은  진폭수준에서  청진검사를  시작하는  것이가장  좋은방법입니다  .  그런 다음 , 듣기힘든  소리를들어야  할경우  진폭을 상향 조정합니다 . 필요에  따라진폭을  사용하면  검사  도중  방해  소음을줄이는  데도움이  됩니다  .  

마지막으로 , 비전자  청진기와전 자청진기  간의기 법차이를  인식하는것 이중요합니다. 3 M™ Littmann® 모델 
3200 청진기를가볍게잡 고환자몸에살 짝  댄후접촉점을  체스트피스  중앙에  맞추고안정상태를  유지하면  최고음질의 청진을 경험할 수 있습니다.  
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문제 해결
문제 잠재적 원인 해결책
청진기에연결할수없음 USB Bluetooth무선어댑터를설치할수없거나 USB

Bluetooth무선어댑터가제대로설치되지않음

USB Bluetooth무선어댑터를삽입합니다.내부컴퓨터 Bluetooth무선장치를사용하지않도록해제합니다.
Bluetooth드라이버를일반 Bluetooth어댑터로업데이트합니다.

청진기가페어링되지않음 청진기를페어링합니다.기본화면의 Tools(도구)메뉴에서 Add New Stethoscope(새청진기추가)를선택합니다.

각고유한청진기 ID는하나의청진기만나타낼수있음 사무실에여러개의청진기가있을경우올바른청진기
ID에연결하는지확인하십시오.

확인되지않음 청진기를끄고몇초기다린다음,청진기를켜고다시시도합니다.

녹음된신호에잡음이섞여있음 과도한주변소음 청진환경에서들리는주변소음을줄일수있는조치를취합니다.

디스플레이도표에표시된신호가잘려져있음
녹음에잡음이섞여있음 본사용설명서의섹션 7에서 “녹음품질개선”을참조하십시오.

품질이낮은데이터보고 과도한주변소음 청진환경에서들리는주변소음을줄일수있는조치를취합니다.

과도한청진기동작 안정된손으로청진기를잡고,녹음되는동안환자의피부를살짝누르면서청진합니다.

3M™ Littmann® StethAssist™소프트웨어또는 Littmann®모델 3200청진기에대한궁금증이나문의사항이있는경우,고객서비스핫라인(1-800-228-3957)으로연락하시거나해당지역의 3M™ Littmann®청진기웹사이트
(www.Littmann.com)에서 FAQ및문의처페이지를참조하시기바랍니다.

3M Health Care
Littmann®브랜드 제품
3M Center, Building 275-4E-01
2510 Conway Ave.
St. Paul, MN 55144
1-800-228-3957
www.littmann.com

3M, Littmann및 StethAssist는 3M의등록상표이며,캐나다라이선스에따라사용됩니다. Windows는 Microsoft의등록상표입니다. Bluetooth는 Bluetooth SIG, Inc의등록상표입니다. Mac은 Apple Ince의등록상표입니다.

© 2017 3M. All rights reserved.

34-8721-7685-3

PDF Scaled at 100.0%

http://www.littmann.com
http://www.littmann.com

	3M™ Littmann® StethAssist™ Heart and Lung Sound Visualization Software 
	TABLE OF CONTENTS 
	1. General Information 
	1.1 Intended Use 
	1.2 Safety Information 
	1.3 System Requirements and Specifications 
	1.4 Patient Privacy 
	2. Getting Started 
	2.1 Install and Register the 3M™ Littmann® StethAssist™ Software 
	2.2 Insert the USB Bluetooth Wireless Adaptor (Dongle) 
	2.3 Pair & Connect the Stethoscope with the Software 
	3.Create a New Recording or Import Recording(s) from the Stethoscope
	3.1 Create a New Recording 
	3.2 ImportRecording(s)from theStethoscope Memory
	4.Review Recordings
	4.1 Signal Pan & Zoom 
	4.2 Spectrogram Display Option 
	4.3 Playing a Recording 
	4.4 ½ Speed 
	4.5 Playing Back a Specific Portion of a Recording 
	4.6 Looped Playback 
	4.7 Global Scaling 
	4.8 Printing Feature 
	4.9 Adding Comments to a Recording 
	5. Save, Open, and Export Recordings 
	5.1 Save Recording 
	5.2 Open aPreviouslyRecorded Sound File 
	5.3 Export Recordings to .wav file 
	6. Navigating Menus 
	6.1 File 
	6.2 Tools 
	6.3 View 
	6.4 Help 
	7. Improving Recording Quality 
	The acoustic environment: 
	The patient: 
	The placement and handling of the stethoscope: 
	8. Troubleshooting 
	3M™ Littmann® StethAssist™ Logiciel de visualisation des bruits du cœur et des poumons 
	TABLE DES MATIERES 
	1. Informations générales 
	1.1 Utilisation prévue 
	1.2 Consignes de sécurité 
	1.3 Configuration et caractéristiques du système 
	1.4 Vie privée du patient 
	2. Mise en route 
	2.1 Installation et enregistrement du Logiciel StethAssist™ de 3M™ Littmann® 
	2.2 Insertion de l’adaptateur Bluetooth USB sans fil (dongle) 
	2.3 Couplage et connexion du stéthoscope au logiciel 
	3.Création d’un nouvel enregistrement ou importation d’enregistrement(s)depuis le stéthoscope
	3.1 Création d’un nouvel enregistrement 
	3.2 Importation des enregistrements à partir de la mémoire du stéthoscope 
	4. Étude des enregistrements 
	4.1 Zoom etdéfilementdu signal 
	4.2 Option d’affichage de spectrogramme 
	4.3 Lecture d’un enregistrement 
	4.4 ½ vitesse 
	4.5 Lecture d’une partie spécifique d’un enregistrement 
	4.6 Lecture en boucle 
	4.7 Maximisation de la mise à l’échelle 
	4.8 Fonction impression 
	4.9 Ajout de commentaires à un enregistrement 
	5. Sauvegarde, ouverture et export des enregistrements 
	5.1 Sauvegarde des enregistrements
	5.2 Ouverture d’un fichier sonore préalablement enregistré 
	5.3 Export desenregistrementsenformat .wav 
	6. Menus de navigation 
	6.1 Fichier 
	6.2 Outils 
	6.3 Affichage 
	6.4 Aide 
	7. Amélioration de la qualité d’enregistrement 
	L’environnement acoustique : 
	Le patient : 
	Positionnement et manipulation du stéthoscope : 
	8. Dépannage 
	3M™ Littmann® StethAssist™ Software zur Visualisierung von Herz-und Lungentnen 
	INHALTSVERZEICHNIS 
	1. Allgemeine Informationen 
	1.1 Bestimmungsgemäße Verwendung 
	1.2 Hinweise zur Sicherheit 
	1.3 Systemanforderungen und Spezifikationen 
	1.4 Patientendatenschutz 
	2. Erste Schritte 
	2.1 Installieren und Registrieren der 3M™ Littmann® StethAssist™ Software 
	2.2 Einstecken des USB Bluetooth Wireless Adapters (Dongle) 
	2.3 Paaren und Verbinden des Stethoskops mit der Software 
	3.ErstelleneinerNeuenAufzeichnung (New Recording) oderImportierenvonAufzeichnungen (Import Recording(s)) vom Stethoskop
	3.1 Erstellen SieeineneueAufzeichnung (New Recording)
	3.2 Aufzeichnungen aus dem Stethoskop‑Speicher importieren (Import Recording(s} 
	4.Auswerten der Aufzeichnungen
	4.1 Verschieben sowie Vergrßern/Verkleinern der Schalldarstellung 
	4.2 Anzeigeoptionen fr das Spektrogramm 
	4.3 Abspielen einer Aufzeichnung 
	4.4 Halbe Geschwindigkeit 
	4.5 Einen bestimmten Abschnitt der Aufzeichnung wiedergeben 
	4.6 Die Loop‑Funktion (Wiederholte Wiedergabe) 
	4.7 Global Scaling (Globale Skalierung) 
	4.8 Die Print‑Funktion (Drucken) 
	4.9 Hinzufgen von Kommentaren zu einer Aufzeichnung 
	5. Speichern, Öffnen und Exportieren von Aufzeichnungen 
	5.1 Speichern von Aufzeichnungen 
	5.2 Öffnen einer zuvor gespeicherten Ton‑Datei 
	5.3 Exportieren von Aufzeichnungen als .wav‑Dateien 
	6. Navigationsmens 
	6.1 Datei 
	6.2 Tools 
	6.3 Ansicht 
	Hilfe > Online-Hilfe Öffnet einen Intern-Browser mit der StethAssist-Webseite unter . 
	7. Verbessern der Aufzeichnungsqualität 
	Das akustische Umfeld: 
	Der Patient: 
	Platzierung und Handhabung des Stethoskops: 
	8. Problemsuche und ‑behebung 
	3M™ Littmann® StethAssist™ Software per la visualizzazione dei rumori cardiaci e polmonari 
	SOMMARIO 
	1. Dati generali 
	1.1 Indicazioni per l’uso 
	1.2 Informazioni sulla sicurezza 
	1.3 Specifiche e requisiti del sistema 
	1.4 Protezione dei dati personali del paziente 
	2. Guida introduttiva 
	2.1 Installazione e registrazione del software 3M™ Littmann® StethAssist™ 
	2.2 Inserimento dell’adattatore wireless Bluetooth USB (dongle) 
	2.3 Associazione e collegamento dello stetoscopio al software 
	3.Creazione di una nuova registrazione o importazione delle registrazionidallo stetoscopio
	3.1 Creazione di una nuova registrazione 
	3.2 Importazione di registrazioni dalla memoria dello stetoscopio 
	4.Revisione delle registrazioni
	4.1 Panoramica e zoom del segnale 
	4.2 Opzione di visualizzazione dello spettrogramma 
	4.3 Riproduzione di una registrazione 
	4.4 ½ Speed (Velocità dimezzata) 
	4.5 Riproduzione di una porzione specifica di una registrazione 
	4.6 Riproduzione ciclica 
	4.7 Ridimensionamento totale 
	4.8 Funzionalità di stampa 
	4.9 Aggiunta di commenti a una registrazione 
	5. Salvataggio, apertura ed esportazione delle registrazioni 
	52.1 Salvataggio delle registrazioni 
	5.2 Apertura di un file sonoro precedentemente registrato 
	5.3 Esportazione delle registrazioni in un file .wav 
	6. Esplorazione dei menu 
	6.1 File 
	6.2 Tools (Strumenti) 
	6.3 View (Visualizzazione) 
	6.4 Help (Guida) 
	7. Miglioramento della qualità della registrazione 
	Ambiente acustico 
	Paziente 
	Posizionamento e manipolazione dello stetoscopio 
	8. Risoluzione dei problemi 
	3M™ Littmann® StethAssist™ Software para la visualizaci de los sonidos del coraz y los pulmones 
	ÍNDICE 
	1. Informaci general 
	1.1 Modo de empleo 
	1.2 Informacin de seguridad 
	1.3 Requisitos del sistema y especificaciones 
	1.4 Privacidad del paciente 
	2. Primeros pasos 
	2.1 Instalacin y registro del software 3M™ Littmann® StethAssist™ 
	2.2 Inserte el Bluetooth USB (transceptor) 
	2.3 Vinculacin y conexin del estetoscopio con el software 
	3.Como crear una nueva grabaci o importar grabaci(es) del estetoscopio.
	3.1 Como crear una nueva grabacin 
	3.2 Importar grabaciones desde la memoria del estetoscopio 
	4.Revisin de grabaciones
	4.1 Ajuste y amplificacin de la sel 
	4.2 Opcin de pantalla de espectrograma 
	4.3 Como reproducir una grabacin 
	4.4 Reproducci a la mitad de la velocidad 
	4.5 Reproduccin de una parte específica de una grabacin 
	4.6 Reproduccin continua 
	4.7 Escalado uniforme 
	4.8 Funcin de impresin 
	4.9 Cmo adir comentarios a una grabacin 
	5. Como guardar, abrir y exportar grabaciones 
	5.1 Guardar grabaciones 
	5.2 Abra un archivo de sonido grabado previamente 
	5.3 Como exportar grabaciones a archivo .wav 
	6. Mens de navegacin 
	6.1 “File” (Fichero) 
	6.2 Herramientas 
	6.3 View (Vista) 
	6.4 Help (Ayuda) 
	7. Cmo mejorar la calidad de la grabacin 
	El entorno acstico: 
	El paciente: 
	Colocaci y manipulaci del estetoscopio: 
	8. Resoluci de problemas 
	3M™ Littmann® StethAssist™ Software voor de visualisatie van hart-en longgeluiden 
	INHOUDSOPGAVE 
	1. Algemene informatie 
	1.1 Beoogd gebruik 
	1.2 Veiligheidsinformatie 
	1.3 Systeemvereisten en ‑specificaties 
	1.4 Privacy patiënt 
	2. Aan de slag 
	2.1 Installeer en registreer de 3M™ Littmann® StethAssist™‑software 
	2.2 De draadloze USB‑adapter met Bluetooth aansluiten (Dongle) 
	2.3 De stethoscoop koppelen en met de software verbinden 
	3.Een nieuweopname maken of opname(s)van destethoscoopimporteren
	3.1 Een nieuwe opname maken 
	3.2 Opname(s) uit het stethoscoopgeheugen importeren 
	4.Opnames herbekijken
	4.1 Pan‑en zoomsignaal 
	4.2 De optie spectrogramweergave 
	4.3 Een opname afspelen 
	4.4 ½ snelheid 
	4.5 Een specifiek deel van een opname afspelen 
	4.6 Doorlopend afspelen 
	4.7 Algemeen aanpassen 
	4.8 Afdrukfunctie 
	4.9 Opmerkingen aan een opname toevoegen 
	5. Opnames opslaan, openen en exporteren 
	5.1 Opname opslaan 
	5.2 Een eerder opgenomen audiobestand openen 
	5.3 Opnames als .wav‑bestand exporteren 
	6. Navigatiemenu’s 
	6.1 Bestand 
	6.2 Extra 
	6.3 Weergave 
	6.4 Help 
	7. De opnamekwaliteit verbeteren 
	De akoestische omgeving: 
	De patiënt: 
	Plaatsing en hantering van de stethoscoop: 
	8. Problemen oplossen 
	StethAssist™ Littmann® da 3M™ Software de Visualização do Som do Coração e do Pulmão 
	ÍNDICE 
	1. Informação Geral 
	1.1 Uso previsto 
	1.2 Informaçs de segurança 
	1.3 Requisitos e especificaçes do sistema 
	1.4 Privacidade do Doente 
	2. Primeiros passos 
	2.1 Instale e registe o software StethAssist™ Littmann® da 3M™ 
	2.2 Introduza o adaptador Bluetooth USB (Dongle) 
	2.3 Emparelhamento e ligação do estetoscpio ao software 
	3.Crieuma “NovaGravação” ou faça“Importar Gravação(es)” doestetoscpio
	3.1 Crie uma “Nova Gravação” 
	3.2 Importar Gravação(es) da Memria do Estetoscpio 
	4. Revisão das Gravaçes 
	4.1 Vista panorâmica e zoom do sinal 
	4.2 Opção de visualização em Espectrograma 
	4.3 Reproduzir uma Gravação 
	4.4 ½ Velocidade 
	4.5 Reprodução de uma parte específica de uma gravação 
	4.6 Reprodução contínua 
	4.7 Escala Máxima 
	4.8 Função de Impressão 
	4.9 Adicionar Comentários a uma Gravação 
	5. Guardar, Abrir e Exportar Gravaçes 
	5.1 Guardar Gravaçs 
	5.2 Abrir um Ficheiro de Som previamente gravado 
	5.3 Exportar gravaçs para ficheiro .wav 
	6. Menus de Navegação 
	6.1 Ficheiro 
	6.2 Ferramentas 
	6.3 Vista 
	6.4 Ajuda 
	7. Melhorar a Qualidade da Gravação 
	O ambiente acstico: 
	O doente: 
	A colocação e manuseamento do estetoscpio: 
	8. Resolução de Problemas 
	3M™リットマン ® StethAssist™心音・肺音可視化ソフトウェア
	目次 
	1.一般情報 
	1.1用途 
	1.2安全に関する情報
	1.3システム要件および仕様 
	1.4患者のプライバシー
	2.スタートガイド
	2.13M™リットマン®StethAssist™ソフトウェアのインストールおよび登録
	2.2USB Bluetoothワイヤレスアダプタ（ドングル）の取り付け
	2.3聴診器とソフトウェアのペアリング( 認証）および接続
	3.新しい録音の作成／聴診器から録音をインポート
	3.1新しい録音の作成 
	3.2聴診器のメモリーから録音データをインポートする
	4.録音データの確認
	4.1信号データの移動およびズーム
	4.2スペクトログラムの表示オプション
	4.3録音データの再生
	4.4 1/2速度で再生
	4.5録音データの一部を再生する
	4.6連続再生
	4.7複数の縦軸スケールを統一する
	4.8印刷機能
	4.9録音データへのコメントの追加
	5.録音データを保存、開く、エクスポート
	5.1録音データの保存
	5.2以前に録音した音声ファイルを開く
	5.3録音データを.wavファイルにエクスポート
	6.ナビゲーションメニュー
	6.1ファイル（ File）
	6.2ツール（To ols）
	6.3表示
	6.4ヘルプ（ Help）
	7.録音品質の改善
	音響環境：
	患者：
	聴診器の取扱い
	8.トラブルシューティング
	3M™ Littmann® StethAssist™心肺音可视化软件
	目录 
	1.简介 
	1.1特定用途 
	1.2安全信息
	1.3系统要求和规格
	1.4患者隐私
	2.开始 
	2.1安装和注册 3M™ Littmann® StethAssist™软件
	2.2插入 USB蓝牙无线适配器（硬件保护装置）
	2.3将听诊器与软件配对和连接
	3.创建新记录或从听诊器导入记录
	3.1创建新记录
	3.2从听诊器存储器导入记录
	4.R查看记录
	4.1信号摇摄与缩放
	4.2声谱图显示选项
	4.3播放记录
	4.4 “½ Speed”（½速度） 
	4.5播放记录的特定部分
	4.6循环播放 
	4.7全局缩放
	4.8打印功能
	4.9为记录添加评论
	5.保存、打开以及导出记录
	5.1保存记录
	5.2打开以前记录的声音文件
	5.3将记录导出为 .wav文件
	6.导航菜单 
	6.1文件
	6.2工具
	6.3视图
	6.4帮助
	7.改善记录音质
	声音环境： 
	患者：
	听诊器的安放与处理：
	8.故障排除
	3M™ Littmann® StethAssist™心肺音視覺軟體
	目錄 
	1.概論 
	1.1特定用途 
	1.2安全資訊
	1.3系統要求和規格
	1.4患者隱私
	2.1安裝和註冊 3M™ Littmann® StethAssist™軟體
	2.3將聽診器與軟體配對和連結
	3.建立新記錄或從聽診器匯入記錄
	3.1建立新記錄
	3.2從聽診器記憶體匯入記錄
	4.檢閱記錄
	4.1信號平移與縮放
	4.2光譜圖選項
	4.3播放錄音內容
	4.4「½ Speed」（半速）
	4.5播放錄音檔的特定部分
	4.6循環播放
	4.7全域縮放
	4.8列印功能
	4.9增加註釋到檔案中
	5.儲存、開啟以及匯出記錄 
	5.1儲存記錄
	5.2開啟以前記錄的錄音檔
	5.3將記錄匯出為 .wav檔案
	6.瀏覽功能選項
	6.1檔案
	6.2工具
	6.3檢視圖
	6.4說明
	7.改善記錄音質
	聲音環境：
	聽診器的放置與操作：
	8.疑難排解
	3M™ Littmann® StethAssist™ 심음 및 폐음 시각화 소프트웨어 
	목차 
	1. 일반 정보 
	1.1 용도 
	1.2 안전 정보 
	1.3 시스템 요구 사항및사양 
	1.4 환자 개인정보보호 
	2.시작
	2.13M™ Littmann®StethAssist™소프트웨어설치및등록
	2.2USBBluetooth무선어댑터(동글)삽입
	2.3 청진기를 소프트웨어에 페어링 및 연결하기 
	3.청진기에서 새 녹음 만들기 또는 녹음 가져오기
	3.1 새 녹음 만들기 
	3.2 청진기 메모리에서 녹음 가져오기 
	4.녹음 검토
	4.1 신호 이동및 확대/축소 
	4.2스펙트로그램디스플레이옵션
	4.3 녹음 재생 
	4.4 ½ 속도 
	4.5 녹음의 특정 부분 재생 
	4.6 반복되는 재생 
	4.7 전역 조정 
	4.8 인쇄 기능 
	4.9 녹음에 설명 추가 
	5. 녹음 저장, 열기 및 내보내기 
	5.1 녹음 저장 
	5.2 이전에 녹음된 사운드 파일 열기 
	5.3 녹음을 .wav 파일로 내보내기 
	6. 메뉴 탐색 
	6.1 파일 
	6.2 도구 
	6.3 보기 
	6.4 도움말 
	7. 녹음 품질 개선 
	음향 환경: 
	환자: 
	청진기 놓는 위치 및 조작법:  
	문제해결



